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PLEASE READ THIS BEFORE USING THE SOFTWARE 

 

฀WARNING 

Do not look at the computer monitor for a long time. If you have looked at the monitor for an extended period of time, 

and experience discomfort in your eyes, shoulders, neck, arms, or any other parts of your body, stop use of the 

computer immediately, and rest until the feeling of discomfort goes away. Moreover, if the feeling of discomfort 

continues, consult a doctor immediately. 

 

฀NOTE 

1 Before using this software, carefully read and understand the Reference Manual provided. 

2 No part of this software may be copied or altered without consent from Ricoh Company, Ltd.. 

3 Discrepancies between the manual and product may arise if improvements are made to the product after its 

delivery. The contents of this manual are subject to change without notice. 

4 This manual was created with the utmost care. However, please contact us if any unclear sections, errors, or 

omissions are found. 

5 Please be aware that we are not responsible for any damage or profit loss incurred as a result of this software’s 

operation or errors or omissions in this manual. 

6 We are not responsible for any damage caused by conditions beyond our control such as modification or 

disassembly, abuse, and defective environment on the part of customers concerning our product, program, or 

software. 

7 Information on other conditions for using this software can be found in the End User Software License Agreement. 

Please read it thoroughly before operating this software. 
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About this Manual 

 

This Reference Manual includes the following chapters 

 

Chapter 1 TotalFlow Simply Prepress Operation 

This chapter describes an overview and the system configuration of TotalFlow Simply Prepress, and also how to install 

the client. 

 

Chapter 2 TotalFlow Simply Prepress Operation 

This chapter describes the TotalFlow Simply Prepress Client workflow and how to use various functions including the 

startup, job, and imposition scheme settings. 

 

Chapter 3 Job List Menu 

This chapter describes the Job List window that is displayed by clicking the JobList button in the shortcut area, and the 

series of operations used to create a job. 

 
Chapter 4 Jobs 

This chapter describes how to create jobs and specify various settings, as well as relevant operation procedures. 

 

Chapter 5 Imposition 

This chapter describes how to create and edit an imposition scheme. 

 

Chapter 6 Imposition Parts 

This chapter describes how to use the various editors provided for creating imposition data on TotalFlow Simply 

Prepress. 

 

Chapter 7 Ticket Editing 

This chapter describes how to create and edit tickets on TotalFlow Simply Prepress, as well as operation procedures in 

each setting window. 

 

Chapter 8 POD Link 

This chapter describes the settings required when performing POD output with TotalFlow Simply Prepress, as well as 

operation procedures in each setting window. 

 

Chapter 9 Main Window 

This chapter describes how to operate the progress window and recorder progress window on TotalFlow Simply 

Prepress. 

 

Chapter 10 MIS Link Function 

This chapter describes the connection between TotalFlow Simply Prepress and an MIS. 

 

Chapter 11 Color Management Parameter List 

This chapter describes the settings in the Color management window. 

 

Chapter 12 Profile and Recipe Registration 

This chapter describes how to register a new ICC profile, device link profile, or recipe file to the TotalFlow Simply 

Prepress system. 
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Notation 

 

The following icons are used throughout this manual. 

 Indicates warnings about equipment damage and time loss that may result from incorrect operation. 

 Indicates supplementary information and tips that are not included in the body of the manual. 

 Indicates where to look for related information or shared procedures. 

 Indicates operational procedures. The actual procedures for operating the system appear in bold and 

the results of the procedures are in plain text. 

 

 

Important 

Note 

Reference 

Operation 
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1. TotalFlow Simply Prepress Operation 

This chapter describes an overview and the features and configuration of the TotalFlow Simply Prepress system. 

 

 

TotalFlow Simply Prepress 

TotalFlow Simply Prepress is a universal workflow system that offers total control of CTP and POD (Print On Demand). 

A range of different devices can be operated from the TotalFlow Simply Prepress interface, supporting the use of 

diverse applications. 

TotalFlow Simply Prepress is also equipped with features to improve productivity for plate output and printing, 

including Adobe PDF Print Engine, color management linked to media, easy-to-use and highly flexible imposition, and 

scheduled automatic job execution. 

 

 

System features 

TotalFlow Simply Prepress offers the following features. 

 

● Managing a large scale job by dividing it into sections 

You can manage a job by dividing it into multiple parts called sections. 

You can set multiple different imposition schemes for each section and apply different output processing for each 

imposition scheme. 

It is possible to centrally manage a large scale job that is comprised of several parts including a cover, body text, 

advertising, and jacket band, and that uses different imposition schemes. 

 

● Promotion of automation 

TotalFlow Simply Prepress offers various functions for automation such as to switch the input ticket depending on the 

input file conditions, to perform automatic fitting of the input data depending on the page size of the section, to create 

a job based on the original file name, and to automatically register the file. These functions reduce the number of 

operator’s operations and thus prevent operation errors and the occurrence of mistakes. 
 

● Supporting easy operation 

The user interface is designed with an emphasis on operability and includes simple window layouts, button 

arrangements that help you easily understand procedures, and show and hide selection for complicated settings. Not 

only simple jobs but also jobs that require complicated settings can be processed with easy operations. 

 

● Various easy imposition scheme functions 

An imposition pattern is created automatically by making easy settings in accordance with the instructions in the 

operation screen. You can create not only a basic imposition pattern but also a complex imposition using the intuitive 

user interface and easy operations. As you can create an imposition and select a template in accordance with the 

printing settings, highly accurate operations are available. 

TotalFlow Simply Prepress also offers the functions, such as customizing a signature pattern (fold catalog) and laying 

out a different signature created in the same job on another sheet, to support a wide variety of impositions. 
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● Automatic imposition creation functions 

TotalFlow Simply Prepress has automatic functions to minimize imposition operations, such as a function to 

automatically adjust the imposition depending on the number and size of the pages, and an auto ganging function to 

automatically calculate the layout using the finished size and number of copies. With these functions, the imposition 

operation can be performed more efficiently without specific skills even though it previously required advanced 

knowledge. 

 

● User management and operation log for security 

TotalFlow Simply Prepress has user management and operation log functions to ensure system security. 

It is possible to limit the accessible functions by user or user group and, while, to keep an operation log that records 

who performed what operation. 

 

● JDF linking 

It is possible to retrieve imposition scheme setting information via a JDF file from the MIS system and to automatically 

apply the information to an imposition scheme included in the job. TotalFlow Simply Prepress operators can create an 

imposition scheme simply by checking the settings or adding required information. 
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System configuration 

TotalFlow Simply Prepress is composed of three software components: the TotalFlow Simply Prepress Client software, 

which provides the GUI for operation, TotalFlow Simply Prepress Server, which mainly manages the job and 

imposition and performs automatic processing, and device drives, which controls the execution of processing and 

devices. 

As the TotalFlow Simply Prepress Client software and the TotalFlow Simply Prepress Server software are run on 

different PCs, more than one operator can use TotalFlow Simply Prepress from the PCs on which TotalFlow Simply 

Prepress Server is not running. 

TotalFlow Simply Prepress supports TotalFlow Print Server R61/R61A and is equipped with Native connection mode 

which takes best advantage of the image quality performance of PDF RIP Enhanced by SCREEN Type S. 

 

 

TotalFlow Print Server R61/61A can be connected to the following production printers. 

RICOH Pro C9100 

RICOH Pro C9110 

RICOH Pro C7100S 

RICOH Pro C7110S 

RICOH Pro C7110 
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2. TotalFlow Simply Prepress Operation 

This chapter describes how to use TotalFlow Simply Prepress. 

 

 

TotalFlow Simply Prepress operation workflow 

The workflow from creating to outputting a job in TotalFlow Simply Prepress is shown below. 

 

 

2. Job creation 

If you copy a file to a hot folder to which a job template has been assigned, a job is automatically created 

and files are automatically registered to the job. A new job is created using the job template settings. You can 

also create a job manually by selecting a job template. During manual job creation, you can edit the settings. 

3. Registering files 

Register files to the job. You can register the files by dragging the files to the Job Detail window or by using the 

Register File button. When automatic page assignment is set, you can specify the page range to be assigned 

using the Register File window. 

4. Assigning pages 

Assign the pages included in the file registered to the job to the pages in the imposition scheme. Perform page 

assignment in the page list of the Job Details window and in the layout management view. You can also 

change the settings for blank pages and offset values. Note that this operation is not necessary when the Auto 

Page Assignment settings are enabled. 

5. Outputting 

You can output a plate for which page assignment is completed. Using the Output Process Ticket window, 

select a ticket and a plate to be output, and issue the ticket. Note that when auto process settings are enabled, 

this processing is executed automatically after page assignment or approval. 

1. Job template creation 

You can create and save a job template that is used as a job setting base. A job template can contain all job 

information other than input data including auto process settings, color conversion settings, and imposition 

scheme settings. Once a job template is assigned to a hot folder, job creation and file registration are 

automatically performed simply by copying a file to the hot folder. 
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Installing a TotalFlow Simply Prepress Client 

Follow the steps below to install a TotalFlow Simply Prepress Client. 

 
 

1. Launch your Web browser. 

 

2. Access the following URL. 

http://{TotalFlow Simply Prepress server host name}:50067/client/en/index .htm 

The window to download the TotalFlow Simply Prepress Client is displayed. 

 

3. Click the download link that matches the operating system version of the computer on which the 

TotalFlow Simply Prepress Client is to be installed. 

 

4. Follow the download instructions for Windows or Macintosh and download the program to your 

desktop. 

 

5. Double-click the TotalFlow Simply Prepress Client installation program (“clientupdater.exe” for 
Windows, “TotalFlow Client.zip” for Macintosh) to launch it. Then, install the program according to the 

instructions displayed on the screen. 

 

 

 

Operation 
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Starting up TotalFlow Simply Prepress 

This section describes how to start up TotalFlow Simply Prepress. 

 

How to start up TotalFlow Simply Prepress 

 
1. Double-click the TotalFlow Simply Prepress Client icon. 

The server selection window is displayed. 

 

 

2. Select the Server IP address in Server and click the Connect button. 

The login window is displayed. 

 

 

 You can change the language and units (mm, inch) used on the client in the area that is displayed by 

clicking the Option button. 

 

 

Note 

Operation 
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3. Enter a user name and a password in User Name and Password, select an option for Language as 

necessary, and then click the Login button. 

User authentication is performed using the user name and the password you entered and the main window is 

displayed. 
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Exiting TotalFlow Simply Prepress Client 

There are two ways to exit TotalFlow Simply Prepress Client, from the screen title bar and from the menu. The steps are 

described below. 

 

How to exit TotalFlow Simply Prepress Client using the screen title bar 

 
1. Click the x button in the screen title bar. 

TotalFlow Simply Prepress Client exits. 

 

How to exit TotalFlow Simply Prepress Client using the menu 

 
1. Select the Exit command from the File menu. 

TotalFlow Simply Prepress Client exits. 

 

 

Layout of the TotalFlow Simply Prepress window 

This section describes the parts and names of the TotalFlow Simply Prepress main window. 

 

Main window layout 

The main window is comprised of the menu bar, shortcut area, and main area. 

 

 

 

Menu bar Shows the menus. For more information, see “Menus bar”. 

Shortcut area Shows the icon buttons for changing the function of the main window. 

Main area Shows the window for operating the function selected in the shortcut area. 

 

 

Operation 

Operation 

Menu bar 

Shortcut Menu 

Main area 
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Menu bar 

The menu items displayed in the main window change according to the selected button in the shortcut area. 

 

File  

New/Job Creates a new job. 

New/Job Template Creates a new job template. 

Open Job Displays the detailed job information window. 

Save as Template Allows you to save the job as a template. 

Lock Release Releases the lock the selected job. 

Backup Creates a backup of the selected job. 

Restore Restores the selected job. 

Properties Displays the job properties. 

Properties (basic settings) Displays the job properties edit window. 

Exit Exits TotalFlow Simply Prepress Client. 

 

 When unlocking is specified, all the process jobs being processed are canceled.  

Also, if unlocking is specified while a job is being edited, the editing is disabled. 

 

Edit  

Copy Copies the job and the job template. 

Delete Deletes the job and the job template. 

Rename Allows you to change the job name and the job template name. 

Optimize Optimizes the selected job. 

Force Completed Changes the job status to Completed. 

 

Action  

Register File Displays the hot folder window. 

Enable HotFolder Starts (Enables) the hot folder of the selected job template. 

Disable HotFolder Stops (Disables) the hot folder of the selected job template. 

Output Runs preset output processing on the selected job. 

Cancel Cancels all processing being executed on the selected job. 

Approve/Approve Approves all files, pages, or signatures (surface) that are waiting approval for 

the selected job. 

Approve/Reject Rejects all files, pages, or signatures (surface) that are waiting approval for the 

selected job. 

Important 
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Export result record Exports the result record for the printer of the selected job in CSV format. 

• File: Set the output destination of the CSV file to be output. 

• Output item names: Select this check box to output the item names to the 

beginning of the CSV. 

 

View  

Job/Smart Folder View Displays the jobs/job templates that are filtered in accordance with the smart 

folder. 

Job/List View Displays the job list. 

Job/Group View Displays the jobs divided into groups. 

Job/Job Template View Displays the job template list. 

Job Simple Confirmation Displays the brief progress window. 

Open All Opens all the groups when the Group tab is selected. 

Close All Closes all the groups when the Group tab is selected. 

Set Group Key Allows you to specify the classification method for the Group tab view. 

Search Display the search dialog box. 

 

Window  

System Ticket Management/Input Displays the input ticket management window. 

System Ticket 

Management/Output 

Displays the output ticket management window. 

Output Setting Manager Opens the Output Setting Manager window. Allows you to import the output 

settings managed here to the job/job template action plan (including page 

proof) for use. 

Imposition Manager Displays the Imposition Manager window. 

Fold Catalog Manager Displays the Fold Catalog Manager window. 

Accessory Manager window Opens the Accessory Manager window. 

Accessory Preset Manager 

window 

Opens the Accessory Preset Manager window. 

Imposition Configuration Displays the Imposition Configuration window. 

Client Settings Displays the settings window of the client. 

 

Help  

Manual/TopPage Shows the online manual. 

Manual/Job Template Shows the online manual. 

Manual/Job Shows the online manual. 

Maintenance/Output Lock 

Information 

Saves the lock information to the server. 
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Maintenance/Output client log file Displays the log file saving dialog box of the client. 

Maintenance/Open work folder Displays the work folder used by the client. 

About Displays the version information for the client and the server as well as the 

connected host name. 

 

Shortcut area 

Shows the function buttons in the shortcut area at the top of each window. 

Click a button for an individual menu to select it. The setting window for that function is displayed in the main area. 

 

 

JobList Shows a window to list and manage the jobs and job templates. This window is 

the origin for operating jobs and also the main window for the TotalFlow Simply 

Prepress operations. 

Progress Allows you to check the progress of the ticket (ProcessJob) issued from a job. 

You can perform operations including change of processing order and 

cancellation of the ProcessJob. 

Log Allows you to check histories of processing, operation logs, and error logs. 

System Allows you to check the system status information including the disk size and 

license. 

Indicator The indicator icon flashes if an error or query occurs. Click the indicator icon to 

display the Event List window. 

  Flashes when an error has occurred in the TotalFlow 

Simply Prepress system. (Example: low disk capacity 

error, TotalFlow Simply Prepress service startup error, 

etc.) The indicator turns off automatically when the cause 

of the error is eliminated. 

  Flashes when an error has occurred during processing. 

(Example: input processing error, etc.) The indicator turns 

off when you click the Confirm button in the Event List 

Window. To turn off the indicator for a specific client, 

select This client only and then click the Confirm button. 

To turn off the indicators for all clients, select All clients 

and then click the Confirm button. 

  Appears when an inquiry error or operation request error 

occurs. Clicking the icon displays the Event List window. 

This indicator does not turn off unless you respond to an 

inquiry even if you close the window. When the inquiry is 

handled from a different client, the indicator 

automatically turns off. 
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3. Job List Menu 

This section describes job operations, from creating a new job through output. 

 

 

Job List 

The Job List shows a window to list and manage the jobs and job templates. This window is the origin for operating 

jobs and also the main window for the TotalFlow Simply Prepress operations. 

 

 

Toolbar 

If you select the JobList button from the shortcut area, icon buttons for working with jobs and job templates are 

displayed in the toolbar. 

 

 Creates a new job. 

 Creates a new job template. 

 Shows the detailed job information. 

 Allows you to save the job as a template. 

 Shows the job properties. 

 Displays the job properties (basic settings) edit window. 

 Copies the job and the job template. 

 Allows you to change the job name and the job template name. 

 Changes the job status to Completed. 

 Deletes the job and the job template. 

Toolbar 

List of jobs in progress 

List of finished jobs 
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 Creates a backup of the selected job. 

 Restores the backup job. 

 Optimizes the selected job. 

 Approves all files, pages, or signatures (surface) that are waiting approval for the selected 

job. 

 Rejects all files, pages, or signatures (surface) that are waiting approval for the selected job. 

 Runs preset output processing on the selected job. 

 Cancels all processing being executed on the selected job. 

 Displays the Job Simple Confirmation window. 

 Shows a list of events for the selected job. 

 Sets the event check status for the selected job to checked. 

 Deletes the job and the job template. 

 Displays the hot folder window. 

 Starts (Enables) the hot folder of the selected job template. 

 Stops (Disables) the hot folder of the selected job template. 

 Shows a list of messages sent from the MIS when a job is created using a JDF file from the 

MIS. 

 Shows the online manual. 

Export result record Exports the result record. 

 Filters the displayed list. 

 

Enter a search string in the entry field, and then click . 

 The Find dialog box is displayed. 

 

 

 The following functions can be applied to the jobs whose status has been changed to Completed 

using . 

• Job Automatic Deletion (When Initial Date For Reckoning has been set to Completed Date. 

 

Note 



3. Job List Menu 

14 

 • Approval and Reject will be applied to all files, pages, or signatures (plates) that are 

waiting for approval. It cannot be applied to a specific target. 

 

• The following functions cannot be used when multiple sections are set in a job. Perform 

the functions from the Job Details window. 

: Approval, : Reject, : Output command 

 

List 

The List tab shows the job overview list including the job names, processing status, and various settings. 

Click the List tab to show the job list in the main area. The tab is divided into the area that shows the list of jobs in 

progress (in progress job list area) and the area that shows the list of processed jobs (finished job list area). The jobs 

for which all output processing have been finished are shown in the finished job list area. 

 

 

Color Label Shows the color label. 

Event Shows an icon when a new error or warning occurs in a job. If you select a job 

and click , the Event List window is displayed. 

The icon disappears if you close the Event List window or click . 

Job Name Shows the job name. 

Job ID Shows the job ID. 

Priority Shows the priority of the job. 

Information Shows information using corresponding icons. 

: Indicates that Automatic Deletion is set for a job. 

: Shows the optimization status. 

: Indicates that the job was created using a JDF file (e.g., MIS). 

: Indicates that a command was issued from an MIS or other system. 

: Indicates that Use Target ICC is turned on. 

: Indicates that the Use Target ICC is turned off. 

Important 

In progress job list area 

Finished job list area 
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Status Shows the status of the processing being executed. The processing displayed is 

input processing and output processing. If more than one processing is being 

executed, the statuses are displayed in the reverse order of the executed order. In 

other words, the processing statuses are displayed in the order of output 

processing and then input processing. 

If no processing is being executed, the processing that completed most recently is 

displayed. 

When there is more than one signature/page waiting for approval in the job, 

 is displayed. When there is more than one signature/page that was rejected 

in the job,  is displayed. 

Job Progress Shows the progress of the job. The progress is indicated using five types of icons. 

A gray icon means that the job has not yet been processed, a green icon means 

that the job is being processed (partially completed), and a purple icon means 

that the job processing has been completed. 

: Indicates the setting status of the job. A gray icon means that no 

section has been set. A green icon means that the output processing has not been 

set for any section. A purple icon means that the output processing has been set 

for all sections. 

: Indicates the page assignment status. 

: Indicates the final output status. 

Progress Shows the icon and progress of processing that is being executed only when the 

number of sections in the job is one. 

Author Shows the name of the user who created the job. 

Customer Shows the customer name of the job. 

Due Date Shows the due date of the job. 

Created Date Shows the date and time when the job was created. 

Finished Date Shows the date and time when the processing was completed. 

Job Root Shows the job root name created for the job. 

Job Template Shows the job template name. 

Comments Shows the information that is entered in Comment. 

Last Output Date Shows the date and time the job was completed. 

Total File Number (Total Page 

Number) 

Shows the number of files and the total number of pages registered to the job. 

Input File Size Shows the disk size that can be reduced by clicking the  button. 

Keyword1 Shows the information entered into Keyword1 in the basic settings for the job. 

Keyword2 Shows the information entered into Keyword2 in the basic settings for the job. 
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Group 

The Group tab shows the jobs by classifying them into groups. The same information as in the List tab is displayed in 

this tab. Click the Group tab to display job information by group. 

 

 

Color Label Shows the color label. 

Event Shows an icon when a new error or warning occurs in a job. If you select a job 

and click , the Event List window is displayed.  

The icon disappears if you close the Event List window or click . 

Group and Job Name Shows the job names classified by group. 

Job ID Shows the MIS managing order code for the job created using a JDF file from an 

MIS, and the job ID for other jobs. 

Priority Shows the priority of the job. 

Information Shows information using corresponding icons. 

: Indicates that Automatic Deletion is set for a job. 

: Shows the optimization status. 

: Indicates that the job was created using a JDF file (e.g., MIS). 

: Indicates that a command was issued from an MIS or other system. 

: Indicates that Use Target ICC is turned on. 

: Indicates that the Use Target ICC is turned off. 

Status Shows the status of the processing being executed. The processing displayed is 

input processing and output processing. If more than one processing is being 

executed, the statuses are displayed in the reverse order of the executed order. In 

other words, the processing statuses are displayed in the order of output 

processing and then input processing. 

If no processing is being executed, the processing that completed most recently is 

displayed. 

When there is more than one signature/page waiting for approval in the job, 

 is displayed. When there is more than one signature/page that was rejected 

in the job,  is displayed. 
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Job Status Shows the progress of the job. The progress is indicated using five types of icons. 

A gray icon means that the job has not yet been processed, a green icon means 

that the job is being processed (partially completed), and a purple icon means 

that the job processing has been completed. 

: Indicates the setting status of the job. A gray icon means that no 

section has been set. A green icon means that the output processing has not been 

set for any section. A purple icon means that the output processing has been set 

for all sections. 

: Indicates the page assignment status. 

: Indicates the final output status. 

Size Shows the job size. 

Total File Number (Total Page 

Number) 

Shows the number of files and the total number of pages registered to the job. 

Input File Size Shows the disk size that can be reduced by clicking the  button. 

Progress Shows the icon and progress of processing that is being executed only when the 

number of sections in the job is one. 

Author Shows the name of the user who created the job. 

Customer Shows the customer name of the job. 

Due Date Shows the due date of the job. 

Created Date Shows the date and time when the job was created. 

Finished Date Shows the date and time when the processing was completed. 

Job Root Shows the job root name created for the job. 

Job Template Shows the job template name. 

Comments Shows the information that is entered in Comment. 

Last Output Date Shows the date and time the job was completed. 
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Job Template 

Shows information about the job template. 

Click the Job Template tab to show the job template list in the main area. 

 

 

Job Template Name Shows the job template name. 

HotFolder Shows the ON/OFF status of the hot folders. 

Information Shows the hot folder status. 

: Indicates that Automatic Deletion is set for a job. 

: Indicates that Use Target ICC is turned on. 

: Indicates that the Use Target ICC is turned off. 

Priority Shows the priority of the job template. 

Author Shows the name of the user who created the job template. 

Customer Shows the customer name. 

Created Date Shows the date and time when the job template was created. 

Comments Shows the information that is entered in Comment. 

Keyword1 Shows the information entered into Keyword1 in the basic settings for the job. 

Keyword2 Shows the information entered into Keyword2 in the basic settings for the job. 

 

 • When you click , displayed at the right end of the headings, the headings in the list are 

displayed and you can show or hide each column. By placing or removing a check mark, you 

can show or hide the column for the related heading in each area. You can also move the position 

of the column by dragging the related heading. 

• When you click any heading in the list, the display order changes based on the heading that is 

clicked. Each time you click the heading, the display order changes between ascending and 

descending order. 

 

Note 
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HotFolder 

Allows you to perform job creation and file registration at the same time using a job template in the Job List window 

(template list window). 

 

1. Select a job template from the job list (template list), and then click . 

The main area switches to HotFolder. 

 

 

Job Template Name Allows you to select a job template to be used. 

File Select Displays the Add window. Select a file from the Add window. 

Delete Deletes the files displayed in the register file panel. 

Register Registers the files displayed in the register file panel. 

Register all files in a single job. Select this check box to register all files added to the HotFolder panel in a 

single job. 

 

2. Click the File select button in the HotFolder panel. Select a file in the Add window, and click the 

Register button. You can register multiple files, one after another. When you are finished, click the 

Close button to close the Add window. The registered files are displayed in the HotFolder panel. 

 

 

  

Operation 
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3. Check that the job template to be used has been selected, and then click the Register button. 

 

 • It is also possible to display the HotFolder panel by dragging a file into the template list window. 

• You can register a file by dragging it into the HotFolder panel, in addition to using the File Select 

button. 

 

Job Simple Confirmation 

The Job Simple Confirmation window shows an overview of the job and the processing status of each workflow. This 

window is displayed only when a single job is selected. Click  to display this window. 

 

 

Page Assign The Page Assign view displays the page assignment status and the approval 

status when the approval command is set. 

Processing status in each section The processing, approval, and proofreading statuses of workflows set in each 

section are displayed. The proofreading status is included in the output 

processing workflow only. 

Progress The progress of each processing is indicated as a percentage. Each color has the 

meaning described below. 

  ■: Pages that have not been assigned 

■: Pages that have been assigned 

 Processing ■: Not processed yet 

■: Completion of processing assigned to each workflow 

  ■: Not processed yet 

■: Signatures/pages that were approved 

■: Signatures/pages that are waiting for approval 

■: Signatures/pages that were rejected 

  ■: Not processed yet (cancellation of proofreading) 

■: Signatures/pages that were proofread 

 

Note 
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Smart Folder 

The smart folder shows only the jobs and job templates that are filtered according to the specified conditions. 

You can save multiple conditions for filtering to a smart folder. The saved smart folders are listed on the left side of the 

window. The jobs and job templates that match the conditions saved for the selected smart folder are displayed on the 

right side of the window. 

There are two types of smart folders: system share smart folders that can be used on all clients and local smart folders 

that can be used only on a specific client. 

 

 

System share smart folder operation  
 

1. Select the Smart Folder tab in the job list, and then click the Edit button for smart folder. 

The display area for the system share smart folder changes to the edit mode. 

 

2. Display the right-click menu in the Smart Folder (System) area. 

 

Add Allows you to add the system share smart folder. 

Edit Allows you to edit the selected smart folder. 

Copy Allows you to copy the selected smart folder to the system. 

Copy to local Allows you to copy the selected smart folder to the client. 

Delete Allows you to delete the selected smart folder. 

 

3. After the operation is completed, click the Save button in the Smart Folder (System) area. 

 

  

Operation 
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Creating and editing smart folders 

A smart folder is created and set using the Smart Folder window. 

 

 

Name Allows you to specify the smart folder name. 

Target Allows you to select the search target for the smart folder. You can select jobs or 

job templates. 

Search Condition Allows you to set the search conditions. You can select All or any conditions for 

searching. 

Add Allows you to add a search condition. 

Delete Allows you to delete a search condition. 

 

Setting a local smart folder as a system share smart folder 
 

1. Select the smart folder to be shared by the systems in the Smart Folder (Local) area, and then click 

Copy to system in the right-click menu. 

 

Operation 
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User-defined items 

The job attributes can be added on each system. The attributes for the character string, value, list, and date type can 

be added freely. These added attributes are not only displayed in the job list, but can be used as filtering conditions 

for smart folders. 

 
 

1. Select the Window -> Client command from the TotalFlow Simply Prepress Client menu to display the 

Optional Items setting window. 

 

2. Click the Edit button, and then select the Use Optional Items check box. 

 

 

 Allows you to add or delete the defined item. 

 Allows you to change the display order of the defined items. The display order is 

the same as that for the Job Basic Setting window. 

Display Name Allows you to set the names of the defined items. The names are then used for the 

basic setting of the job, item names in the Smart Folder window, and the table 

header names in the job list. 

Type Allows you to select the type of the defined item. The handling during sorting and 

filtering differs. 

• Character String 

• List 

 

 

When List is selected, the input area for options is displayed. Enter the items for 

selection by delimiting them with a comma. 

• Date 

• Number 

Mandatory Allows you to select the mandatory of defined item. 

• Optional item 

• Mandatory item only for jobs 

• Mandatory item for both jobs and job template 

Operation 
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3. Make settings for the user-defined items, and then click the Save button. 

 

 

 User-defined items can be imported and exported. Click the Export button to export the settings, and 

then import them to another TotalFlow Simply Prepress system. The same job attributes can be used 

with multiple TotalFlow Simply Prepress systems. 

 

 

 

 

Note 
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Basic job operations 

This section describes the basic job operations in the main window. 

 

Creating a new job 

Create a new job. Click  on the toolbar or select the New -> Job command from the File menu. For more 

information about the operation, see “New job creation”. 
Input the job name, order code, and job template in the Job Basic Setting window, and then click the OK button. Set 

the job in the Action Plan window, which appears next. 

For more information about the Action Plan window, see “Job setting procedure”. 
 

Creating a job using a template 

Create a job based on a job template. Select a job template in the job template list, and then click  on the toolbar 

or select the New -> Job command from the File menu. 

The subsequent steps are the same as when creating a new job. Therefore, for more information, see “Job setting 
procedure”. 

 

Opening a job 

Select a job in the job list, and then click  on the toolbar or select the Job command from the File menu to display 

the Job Detail window. For more information about the Job Detail window operation, see “Job Details window”. 
 

Changing the job settings 

You can directly display the Job Action Plan window and change the job settings. Select a job in the job list, and then 

click  on the toolbar or select the Properties command from the File menu. For more information about the Action 

Plan window operation, see “Job setting procedure”. 

 

Saving a job as a template 

Save a job as a template. Select a job in the job list, and then click  on the toolbar or select the Save as Job 

Template command from the File menu. 

 

Changing a job name 

Change a job name. Select a job in the job list and then select the Change Name command from the Edit menu. 

It is also possible to change the order code. 

 

Copying a job 

Copy a job. Click  on the toolbar to show the Copy window. Enter a name for the copy in Copy Name and, if 

necessary, order number in Order Code, and then click the OK button to copy the job. When you select the Copy 

with the registered files check box, files that are registered to the job are also copied. 
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Deleting a job 

You can delete a registered job. Click  on the toolbar to show the Confirmation window. Click the OK button to 

delete the job. 

 

Optimizing a job 

Optimize a job. Click  on the toolbar or select the Edit -> Optimize command from the menu. Perform an 

optimization to reduce the amount of disk space used by data on the server. 

This operation deletes only the input data within a job. Once the data is optimized, it cannot be re-input. 

 

 

Creating a job backup 

Create a job backup. Click  on the toolbar or select the File -> Backup command from the menu. If necessary, set 

the backup data output destination folder using the System Setup Tool in advance. 
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Jobs to Be Backed Up Shows a list of jobs to be backed up. 

After creating a backup, an icon indicating the processing result for a job is 

displayed in the Processing Result column. 

: Shows that the processing has been completed successfully. 

: Shows that the processing has failed. 

If the processing has failed, the following message is displayed in the 

Processing Result column. 

 

Method of Creation Backup Data Allows you to select a method to create a backup. 

Optimize Select this check box to create a backup after 

optimizing the job. 

Enclosing Folder 

(Volume consideration, 

Verify: ON) 

Select this check box to create a backup after packing 

the job. 

Delete the job after 

backup 

Select this check box to delete the job after creating its 

backup. 

Back-up data output 

destination folder 

Specify a folder to which the backup data is to be 

output. 

 

Restoring a job 

Restore a job. Click  on the toolbar or select the File -> Restore command from the menu. If necessary, set the 

Restoration destination JOBRoot folder using the System Setup Tool in advance. 

 

 

Backup Jobs to Be Restored Shows a list of backup jobs to be restored. 

Click the Add button to specify the backup job to be restored. After it is restored, 

an icon indicating the processing result is displayed in the Processing Result 

column. 

: Shows that the processing has been completed successfully. 

: Shows that the processing has failed. 

If the processing has failed, the following message is displayed in the 

Processing Result column. 

 

 

 You can select multiple jobs to perform optimization, backup creation, and restoration. 

 

 

Note 
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Basic job template operations 

This section describes the basic job template operations in the main window. 

 

Creating a new job template 

Click Create a job template based on a job template. Select a job template in the job template list, and then click  

on the toolbar or select the New -> Job command from the File menu. 

Input the job name, order code, and job template in the Job template Basic Setting window, and then click the OK 

button. Set the job in the Action Plan window, which appears next. 

For more information about the Action Plan window, see “Job setting procedure”. 
 

Editing job template 

You can display the Action Plan window and change the job template settings. Select a job template in the job 

template list, and then  click on the toolbar or select the Properties command from the File menu. For more 

information 

about the Action Plan window operation, see “Job setting procedure”. 
 

Changing a job template name 

Change a job template name. Select a job template in the job template list and then select the Change Name 

command from the Edit menu. 

 

Copying a job template 

Copy a job template. Click  on the toolbar to show the Copy window. Enter a name for the copy in Copy Name 

and click the OK button to copy the job template. 

 

 

Deleting a job template 

You can delete a registered job template. Click  on the toolbar to show the Confirmation window. Click the OK 

button to delete the job template. 
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Creating a job template backup 

Create a job template backup. Click  on the toolbar or select the File -> Backup command from the menu. If 

necessary, set the backup data output destination folder using the System Setup Tool in advance. 

 

 

Selected Job template Shows a list of job templates to be backed up. 

After creating a backup, an icon indicating the processing result for a job 

template is displayed in the Processing Result column. 

: Shows that the processing has been completed successfully. 

: Shows that the processing has failed. 

If the processing has failed, the following message is displayed in the 

Processing Result column. 

 

Method of Creation Backup Data Allows you to select a method to create a backup. 

Enclosing Folder 

(Volume consideration, 

Verify: ON) 

Select this check box to create a backup after packing 

the job template. 

Back-up data output 

destination folder 

Specify a folder to which the backup data is to be 

output. 
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Restoring a job template 

Restore a job template. Click  on the toolbar or select the File -> Restore command from the menu. If necessary, 

set the Restoration destination JOBRoot folder using the System Setup Tool in advance. 

 

 

Restore Shows a list of backup jobs to be restored. 

Click the Add button to specify the backup job to be restored. After it is restored, 

an icon indicating the processing result is displayed in the Processing Result 

column. 

: Shows that the processing has been completed successfully. 

: Shows that the processing has failed. 

If the processing has failed, the following message is displayed in the 

Processing Result column. 

 

Restoration destination JOBRoot 

folder 

Allows you to specify the restore destination job root folder from the pull-down 

list. 

 

 You can select multiple job templates to perform optimization, backup creation, and restoration. 

 

Note 
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4. Jobs 

This section describes the Job Details window and procedures to perform detailed settings of the job. 

 

 

Job Details window 

This window is used for job operations. A separate window opens for the operations of each job. The window allows 

you to perform job setting, file registration, page assignment, and output processing. 

 

Job Details window layout 

The Job Details window is comprised of the following parts. 

 

 

 

 
 

Menu bar Shows the menus. For more information, see “Menus bar”. 

Tool bar Shows the icon buttons to manage jobs. For more information, see “Toolbar”. 

Shortcut area The shortcut area contains the main operation buttons for jobs and the icons to 

change the main area view. The main operation buttons are arranged in the order 

of operation. They are shortcut buttons used to instantly change the view and to 

show the windows required for the operation. 

  Action Plan Changes the view to the Action Plan editing mode. 

  Register File Changes the main area view to the registered file 

management view and shows the File Select window. 

Detailed information area Event and processing status area 

Shortcut area 

Main area 

Tool bar 

Menu bar 
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  Input Changes the main area view to the registered file 

management view and shows the Input Process Ticket 

window. 

  Page Assign Changes the main area view to the Activity board 

and shows the Assign window. 

  Output Changes the main area view to the Activity board 

and shows the Output Process Ticket window. 

  Changes the main area view to the Action Plan view. 

 
 Changes the main area view to the registered file management view. 

  Changes the main area view to the Activity Board view. 

  Changes the main area view to the imposition scheme management view. 

Main area Use the buttons in the shortcut area to change the view of the main area. You can 

use the registered file management view or the layout management view. 

Detailed information area Shows the detailed information of the job, and the detailed information of the 

page, file, section, signature, or flat that is selected in the main area. 

Event and processing status 

area 

Shows the progress of processing, event information including errors, operation 

logs, and processing results, allowing you to select the corresponding tab. 

 

Menu bar 

The menu bar in the Job Details window is comprised of the File, Edit, Action, Settings, View, and Help menus. 

 

File  

Register File Allows you to register a file to the job. Shows the File Select window and allows 

you to select a file to be registered. 

Action Plan Shows the action plan window. 

Close Closes the Job Details window. 

 

Edit  

Delete File Deletes the selected file from the job. 

 

Action  

Input Shows the Input Process Ticket window. 

Page Assign Shows the Page Assign window. 

Output Shows the Output Process Ticket window. 

Approve/Approve Approves the selected file, page, or signature (plate). 

Approve/Reject Rejects the selected file, page, or signature (plate). 
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Proof/OK Sets the proof OK status for the page or imposed surface. A page is set as the proof 

OK status if you have selected a page on the activity board, and a surface is set as 

the proof OK status if you have selected the final output surface in layout 

management view. 

Proof/Cancel Cancels the proof OK status for the page or imposed surface. 

 

Settings  

JDF/Audit Notifies the result to MIS. 

Set Folio Marks Sets folio marks to the pages in the imposition scheme. 

Proof Count Setting Allows you to set the number of editions for the selected page. You can set any 

value. 

Shift Pages Move the assigned page. 

Assign Blank Page Assigns a blank page to a page in the imposition scheme. 

Un-assign Page Cancels imposition of a page that is assigned to the imposition scheme. 

Adjust Offset Allows you to change the offset of a page that is assigned to the imposition 

scheme. 

Size Adjustment Allows you to change the enlargement/reduction ratio of a page that is assigned 

to the imposition scheme. 

 

View  

Zoom View Shows the zoom view of the selected signature (plate). 

End Editing Editing is considered to be in progress on pages that are being displayed as PDF so 

that operations such as having tickets issued for them cannot be performed while 

they are being displayed. Click this button to cancel the editing-in-progress status. 

Open All Opens all folders for the files and sections in the tree. 

Close All Closes all folders for the files and sections in the tree. 

Action Plan Changes the main area to the Action Plan view for setting a job workflow. 

Registered Files Changes the main area to the page list view for file management. 

Activity Board Changes the main area to the Activity Board view. 

Show Layout/Thumbnail Changes the main area to the thumbnail view for layout management. 

Show Layout/Icon Changes the main area to the icon view for layout management. 

Show Layout/Page List Changes the main area to the page list view for layout management. 

 

Help  

Manual Shows the online manual. 

About Shows the version information of the client and server, and the name of the 

connected host. 
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Toolbar 

 Deletes the selected file from the job. 

 Approves the selected file, page, or signature (plate). 

 Rejects the selected file, page, or signature (plate). 

 Sets the proof OK status for the page or imposed surface.  

 Cancels the proof OK status for the page or imposed surface. 

 Sets folio marks to the pages in the imposition scheme. 

 Allows you to shift the page. 

 Allows you to set the number of editions for the selected page. 

 Assigns a blank page to a page in the imposition scheme. 

 Cancels the page(s) assigned to the imposition scheme. 

 Allows you to change the offset of a page that is assigned to the imposition scheme. 

 Allows you to change the enlargement/reduction ratio of a page that is assigned to the 

imposition scheme. 

 Shows the zoom view of the selected signature (plate). 

 Shows the PDF file of the selected page. 

 Cancels the editing-in-progress status of the page. 

 Opens all folders for the files and sections in the tree. 

 Closes all folders for the files and sections in the tree. 

 Transmits Progresses or Results to MIS. 

 Shows the online manual. 

 Hides the pages that are not to be output in the free page sequence imposition. 

 Changes the main area to the page list view in the Show Layout window. 

 Changes the main area to the icon view in the Show Layout window. 

 Changes the main area to the thumbnail view in the Show Layout window. 

Switches between show and hide of the thumbnail view in the Activity Board window. 

 

Main area 

The main area is used to perform various operations while switching the Action Plan, Registered File Management, 

Activity Board, and Layout Management windows. The details of each window are described later. 
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Detailed display area 

This area shows detailed information about the job as well as detailed information about the item selected in the main 

area. You can switch between the job information and the information about the selected item using the tabs. 

The selected target information displayed in the main area is file or page information if Registered File Management is 

selected, and section or signature (side) information if Layout Management is selected. 

When Layout Management is selected in the main area, the output history information is also displayed. 

 

Job information view 

 

 

Page/File Information view 

 

 

Section/Signature Information view 

 

 

  



4. Jobs 

36 

Customer Information 

 

 

Output History 

This tab shows the history of the output processing performed in the selected workflow, section, or fold/signature. 

 

 

 You can perform the output processing using history information by selecting the history item and 

then clicking Output in the shortcut area. 

 

History display area 

Shows the progress of job processing and errors if they occurred. Select the Progress tab, Event/Message tab or 

Audit tab to change the display. 

 

Progress view 

 

 

Workflow Shows the workflow for the processing currently in progress. The icon for the 

processing currently in progress flashes, and the icons for processing that is finished 

are partially transparent. 

Progress Shows a progress bar indicating the status of the processing. 

Status Shows the status of the processing. 

Note 
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: Setting up 

: Standby 

: Processing 

: Held 

: Cancel 

: Aborted 

: Normal end 

: Approval waiting 

Process Target Shows the processing target, such as the file name, section name, or signature 

number. 

Start Date Shows the date and time when processing started. 

Finish Date Shows the date and time when the processing was finished. 

Process Job ID Shows the process job ID assigned to the processing. 

Host Shows the name of the host where the processing is being run. 

Comments Shows comments about the ticket. 

 

You can perform the following operations on each process shown in the progress view. 

 Cancels the processing in the selected workflow. 

 Approves processing that is waiting approval and continues to the next process. 

 Compiles the results of jobs that have been executed. 
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Event/Message view 

 

 

Level Shows the importance of the event that occurred. 

: Fatal error 

: Error 

: Query 

: Operation request 

: Warning 

: Information 

: Report 

Message Shows the event message. 

Occur Date Shows the date and time that the event occurred. 

Host Shows the host where the event that occurred. 

 

You can check the event details by double-clicking the event. 
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Operation 

Operational histories on the TotalFlow Simply Prepress Client and the printer are listed as follows. 

 

 

Operated Date Shows the date and time of processing execution. 

User Name Shows the name of the user who performed the operation. 

IP Shows the IP address of the client or printer that was used for the operation. 

Detail Shows the operation description. 

 

If you double-click an operation on the list, the Operation Detail window is displayed. 
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Audit 

The Audit tab lists the processing results of each job. 

 

 

Process Job ID Shows the job ID that is assigned to processing. 

Progress Result Shows the processing results. 

Printer Name Shows the name of the printing system that executed the output processing. 

Printer Type Show the name of the printer model that executed the output processing. 

Total Time Shows the time required for the processing. 

Ink Amount Shows the total ink volume used for printing of a selected job. 

Paper Amount Shows the total sheet volume used for printing of a selected job. 

Date Shows the start date and time of the selected job. 

 

Double-clicking Audit allows you to check the details of the processing results. 

 

 

Action Plan 

This window is used to set the automatic processing for a job. You can make settings including basic settings for the job, 

input/output ticket settings, and section/imposition scheme settings. For more information about the operation, see 

“Job setting procedure”. 
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Registered File Management 

In the Registered File Management, you can perform management tasks for the files registered to a job, such as 

registering files, running input processing, approving files or pages, and checking input processing results. 

 

 

File Shows the names and page numbers of registered files. 

Status Shows the current processing status of the job. 

Preflight Shows the preflight processing results. 

Font Shows whether or not font embedding was successful. 

Page Count Shows the number of pages included in the file. 

Color Shows color information. 

PDF Origin Shows the type of box that is used as a reference when the page is imported. 

Offset Origin Shows the amount of offset from the origin of the finished page in the signature 

template file to the origin of the finished page file to be input. 

Rotation Angle Shows the rotation angle specified during the input processing or when pages are 

assigned. 

Page Size Shows the page size. 

Registered Data Shows the date and time when the file was registered. 

Last Update Shows the date and time when the file was last updated. 
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Activity Board 

This window is used to perform operations such as page assignment and proofreading according to the pagination. 

As the progress of each page can be checked easily, this window is useful as a tool for sharing the progress 

information with sales, engineering, and other operation sections. Moreover, the section can be set checking the page 

order. 

Therefore, you can set easily the last-minute change and the complicated binding type. 

 

 

Page list area 

The status and information for each page are displayed in a table form. 

 

 

No. Shows the sequential number of the pagination. 

Section Shows the name of the section to which the page belongs. 

Folio Shows the folio marks. 

Binding Type Shows the binding method and binding direction. 
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Page Size Shows the name of the file being assigned. 

When the file has not been output since it was assigned, the file name is preceded 

by the 

New icon. 

File Name Shows the name of the file being assigned. 

Assignment Shows the page assignment status, such as spread page. 

Layout Origin Shows the layout origin for executing page assignment. 

Rotation Angle Shows the rotation angle specified for the assigned pages (input data). 

Scale (H x V) Shows the enlargement/reduction ratio set when pages are assigned. 

Additional Offset Shows the offset values specified with the offset adjustment function. 

Offset Shows the offset values that are calculated automatically when pages are assigned. 

Status Shows the page status. 

Color Shows the information for colors included in the page. 

Proof Status Shows the number of editions and the proofreading status. 

Registered Date Shows the date and time when the file including this page was registered. 

 

 Automatic page assignment is available by setting folio marks in signatures in the order they are 

listed. 

 

Preview area 

Pages are previewed in order of page number. You can check the spread page status, page assignment positions, 

and correct assignment of the contents. 

 

Layout Management 

In the Layout Management, you can perform tasks for output, such as managing sections, assigning pages, adjusting 

page positions, checking the imposition status, and running output processing. 

There are three types of displays in the Layout management, page list view, icon view and thumbnail view, and you 

can switch between the views using the View menu or by clicking the ,  or  button. No matter which 

view you are viewing, a list of signatures is shown on the left side of the window, and the content of what you selected 

in this list is displayed in the display area on the right. 

In the signature list, the icon that shows the signature status is displayed for each signature. 

 

 

 

Note 

Signature list 
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Page list view 

The page list view shows a list of pages that have been assigned. 

 

 

No. Shows the number. 

Section Name Shows the name of the section. 

Signature Shows the signature number. 

Sheet Shows the sheet number. 

Side Shows whether the side is the front or the back. 

Folio Shows the folio marks. 

Page Size Shows the page size. 

File Name Shows the name of the file being assigned. 

Status Shows the page status. 

Layout Origin Shows the layout origin. 

Rotation Angle Shows the rotation angle specified for the assigned pages (input data). 

Scale (H x V) Shows the enlargement/reduction ratio set when pages are assigned. 

Base Offset Shows the offset value that is calculated when the page is assigned. 

Color Shows the color information. 

Additional Offset Shows the offset value that is set at the Adjust Offset window. 

Spread Shows whether the page is a spread page or not, and the other spread page 

number. 
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Icon view 

Icon view allows you to check the information for all of the pages and the status of the signatures in imposed format. 

In the section list on the left, the icon that shows the status is displayed for each signature. 

 

 

Page icon list 

 Shows that the page is waiting for approval. 

 Shows that the page has been approved. 

 Shows that the page has been rejected. 

 Shows the status of the process colors used on the page. This is not displayed if no process 

colors are being used. 

 This is displayed if the page is monochrome. 

 This is displayed if spot colors are used on the page. The number on the right side of the icon 

shows the number of spot colors. 

 Automatically sets pages that are being displayed as PDF to editing-in-progress status. While 

editing is in progress, operations cannot be performed on those pages. To cancel, select 

cancel the editing-in-progress status, select cancel in the menu or click the cancel icon 

button. 

 

Signature icon list 

 Shows that the signature is waiting for approval. 

 Shows that the signature has been approved. 

 Shows that the signature has been rejected. 

 Shows that the output color settings for the signature are enabled. 

 Shows that the file with layer information is assigned to the signature and that versioning 

output is possible. 
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Signature status icon list 

Assignment Status 

 Shows that none of the pages in the signature are assigned. 

 Shows that some of the pages in the signature have been assigned. 

 Shows that all of the pages in the signature have been assigned. 

 

Output Processing Status 

 Shows that the signature output has not been performed. 

 Shows that the signature output has partially completed. 

 Shows that the signature output has completed. 

 

Thumbnail view 

Thumbnail view allows you to check thumbnails for all of the pages and the status of the signatures in imposed format. 
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Job setting procedure 

This section describes how to make job settings using the Action Plan window. 

 

 With a section auto-switching job, when a file is registered, only the sections that satisfy the required 

conditions will be displayed. 

 

Action Plan Window Layout 

The Action Plan window is composed of the following four major areas. The size of the displayed areas for setting 

each workflow can be changed with one touch of the button on the upper right of the window, and the operation 

window can be enlarged. 

 

 

 

Property setup area Shows the basic setting of the job. Click this button to show the Property window, 

allowing you to change the setting. 

: Click this button to display the operation logs. 

Input processing setup area Allows you to check and set the input workflow and input color. 

Output processing setup area Allows you to check and set the output workflow. 

 

Note 

Output processing setup 

area 

Property setup Output 

Input processing setup 

area 



4. Jobs 

48 

Property 

When you click the button on the left edge in the Property setup area of the Action Plan window, the Property window 

is displayed. Property window consists of four windows: Basic Setting, Page Import, Option Setting, and Optional 

Items. You can switch a window by selecting the setting item on the left. 

 

 

Basic Setting 

This window is used to make the basic information settings for the job, such as the customer name and due date. 

 

 

Job Name Shows the job name that was entered in the Basic Setting window. 

Job Root Shows the name of the folder to store the job that was selected in the Basic Setting 

window. 
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Priority Allows you to select a priority level for the job processing from pulldown list. 

• Top : 

Setting Top allows jobs to be processed ahead of those for which High or 

Normal is set. 

• High : 

Setting High allows jobs to be processed ahead of those for which Normal is set. 

However, these jobs must first wait until the processing of all Top priority jobs is 

finished. 

• Normal: 

Setting Normal causes jobs to wait until the processing of all Top or High priority 

jobs is finished. 

Color Label Allows you to select a color label from the pulldown list. 

• None 

• Red 

• Orange 

• Yellow 

• Green 

• Blue 

• Purple 

• Pink 

Copies Allows you to specify the number of copies printed for this job. The number of 

copies specified here is sent to the printer. 

Job Type Allows you to specify the type of print created with this job. Shows an icon in the 

job list according to the product type selected here. 

Customer Shows the customer name of the job. 

Due Date Shows the due date of the job. 

Keyword1 Shows the information entered into Keyword1 in the basic settings for the job. 

Keyword2 Shows the information entered into Keyword2 in the basic settings for the job. 

Comments Shows the information that is entered in Comment. 
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Page Import 

This window is used to make settings for automatic page assignment and target color space. 

 

 

Use Target ICC Allows you to specify the color space for conversion that is included in the input 

data. 

Select this check box when you use the offset simulation mode. The input data is 

converted to the target color space via the color space specified as the 

intermediate target color. For more information about the offset simulation mode, 

see “Input Color Setting”. 

For more information about the default ICC profiles, see “Input color space” in 
Chapter 11. Also, for information on how to register an ICC profile, see “12 
Registering profiles and recipes”. 

 Prior output 

intent: 

Select this check box to use the output intent ICC profile that 

belongs to the input PDF file instead of the ICC profile specified 

on the TotalFlow Simply Prepress Client. 

Auto Page Assign Select this check box when you wish to assign the registered data page to the 

section (imposition scheme) automatically. 

 Layout Origin: Allows you to select the reference point for page assignment. 

Specify the layout origin for the data page within the page on 

the imposition scheme. You can select from Lower Left, Center, 

and Upper Left. 

 Input Data Auto 

Scaling 

Allows you to enlarge or reduce the assignment pages of the 

target file so that the pages fit the page size of the assignment 

location. 

 Spread: When the size of the data page corresponds to 2 pages, 

selecting this check box spreads the data page to the left and 

right (top and bottom) pages on the imposition scheme 

automatically as a spread page. 

 Apply to cover 

pages: 

When you select this check box, the first and last pages on the 

imposition scheme are regarded as a spread page. This option is 

effective when the cover page has been created using spread 

data. 
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 Origin: Allows you to specify the reference point in spread pages that is 

used for page assignment. You can select from Below Left, 

Center, Below Right, and Below Justify. 

 

 Macros available for new job names 

The following macros are available. 

• %H.%h: Hot folder name 

• %L,%l: Date of creation (shortened form) 

• %N,%n: Input file name 

 

 For details of Input Data Auto Scaling, see “Assigning pages” below. 

 

Option Setting 

This window is used to make settings for the operations to be performed after the job processing has been completed. 

 

 

  

Note 

Note 
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Automatic backup or deletion 

Initial Date For Reckoning Allows you to set the reference day for automatic deletion or backup. Jobs are 

deleted or backed up when the number of days specified in Expiration Days has 

passed from the day specified here. You can select from Created Date, Due Date, 

Expiration Days, and Last Output Date. 

• Created Date: Means the date and time when the job is created. 

• Due Date: Means the date and time set to “Due Date” in the basic setting of 
properties. 

• Expiration Days: Means the first date and time when all output of all signatures 

are completed. 

• Last Output Date: Means the final time when the output processing is to be 

completed. This is updated every time the output processing is executed. 

• Immediately after the output is completed: Jobs are deleted or backed up 

immediately after all output processing is completed. 

Expiration Days Allows you to specify the number of days until automatic deletion or backup is 

executed. A number greater than 0 can be specified. When 0 is specified, the 

processing is executed within 1 hour after the expiration. If the limit expires while 

the system is stopped, the processing is executed within 1 hour after the system 

starts up. 

This item is not displayed when Immediately after the output is completed is 

selected for Initial Date For Reckoning. 

Auto-BackUP Select this check box to back up jobs after a specified period has passed. 

• Optimize: When you select this check box, input data is deleted first to reduce 

the job size and then backup is executed. 

• Enclosing Folder: When you select this check box, jobs are ZIP-compressed and 

backed up as one file. 

• Back-up data output destination folder: Allows you to specify a folder to which 

the job backup data is to be output. 

Enable Automatic Deletion Select this check box to delete jobs after a specified period has passed. When 

automatic backup is specified, the jobs are deleted after the backup processing. 

 

User-defined item option settings 

The window below allows you to make settings for the user-defined items that were set for the system in Client Setting. 

 

 

 The items defined in Client Setting are displayed as items in Optional Items. 

 

  

Note 
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[Input Processing] 

 

 

Publish a ticket Select this check box to issue an input ticket for processing an input data file that 

matches the conditions. If this check box is not selected, the ticket is not issued. 

 Import... Clicking this button allows you to select the existing input 

processing ticket. Since the selected ticket is copied into the job, 

you can edit the ticket without affecting the original one. 

 Ticket editing 

area 

Allows you to directly create and edit the ticket. 

 

Importing input conditions 

You can import the input conditions from other jobs/job templates. Clicking  on the upper section of the Input 

workflow/Page Proof setting area opens the Job/Job Template select window. All input conditions specified for the 

selected job/job template in this window are loaded. When the new input conditions are imported, the input 

conditions specified before the import will be lost. 

 

 

Modifying an input condition 

Clicking  for the input condition you wish to modify shows the Input Condition window. Edit the conditions as 

necessary, and then click the Save button. Clicking  the Input processing ticket icon allows you to edit the ticket 

and clicking the allows you to change the input color setting. 
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Input Color Setting 

Make the color conversion settings for input processing execution. The input color setting allows you to select whether 

to apply a unified setting for the whole job or use a different setting for each input condition (input processing ticket). 

The menu can be switched by using  (total setting) and (separate setting) on the upper section of the Input 

workflow/Page Proof setting area. In both cases, the setting details are the same. 

 

Input color setting 

The following describes the details of the Input Color Setting window. 

 

 
 

 The selectable items in the input color setting vary depending on the setting of Use importing file 

information in the input processing. 

• When the Use importing file information check box is not selected: 

You can change most items. Deselect the Use importing file information check box in the input 

processing if you want to change the input color setting. 

• When the Use importing file information check box is selected: 

As the color conversion is executed using the input file setting, only limited items (RGB input color 

space / Use Embedded profile / Option / conversion intent) can be changed when the Use 

Target Profile check box is selected in the basic settings. Other items are left as default, regardless 

of the setting contents. When the Use Target Profile check box is not selected, the recipe 

conversion option is not available. However all other settings can be changed. Select the Use 

importing file information check box in the input processing if you want to use the input file setting. 

 

 For more information about the settings for RGB, CMYK, Gray, and Lab, see “RGB settings”, 
“CMYK settings”, “Gray settings”, and “Lab color space settings” in this chapter. 

 

  

Note 

Reference 

RGB setting area 

CMYK setting area 

Gray 

Lab setting area 
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 ● Color management 

In the TotalFlow Simply Prepress Client, one default color conversion policy, which is applied to the 

entire job, is set for each job. 

The color conversion policy is the color conversion rule for the job. It is used for input color settings, 

intermediate target color settings, and output color settings. 

Note that the conversion policy can be changed using the Color Management option under Section 

Setting. 

The color conversion policy has the following two modes. 

• Offset simulation mode 

As the input data is converted to the target color space via the intermediate target color, the color 

space specified as the intermediate target color is first simulated and then the data is output to the 

final destination. This mode should be used, for example, when you print data that is output for 

offset printing using an output device specified in the output color setting and you want the color 

to be output as closely as possible to the output result of offset printing. 

• Wide gamut mode 

In this mode, color data is not converted via the intermediate target color for color matching. 

Instead, it is directly converted into the color space appropriate for the output device to maintain 

the color gamut of the input data as far as possible. This is typically effective when RGB data, 

which has a wider color gamut compared to the normal offset printing, is used for printing. 

 

  

Note 
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● RGB settings 

RGB settings allow you to set the input color space and conversion method that are applied to the image data and the 

text or illustration data created in RGB. Settings can be made for the image data, text data, and illustration data 

separately. 

 

 

 

 

 

Input color space Allows you to select an ICC profile that is set as the input color space from the 

pulldown list. 

For more information about the default ICC profiles, see “Input color space” in 
Chapter 11. Also, for information on how to register an ICC profile, see “12 
Registering profiles and recipes”. 

Use Embedded profile Select this check box to use the embedded ICC profile as the input color space if 

an ICC profile is embedded in an object, such as an image, text, or illustration, in 

the input file. 

Conversion method Allows you to select the conversion method of the input color space from the 

pulldown list. For image data, you can select the conversion method from ICC 

Conversion, Device Link Conversion, Recipe/ICC Conversion, and Recipe/Device 

Link. For text or illustration data, you can select the conversion method from ICC 

Conversion and Device Link Conversion. 

If you select ICC Conversion, the ICC conversion is executed using the specified 

conversion intent. 

If you select Device Link Conversion, the input color space is converted to the 

output color space using the device link profile. The output result data is regarded 

as a color space that is specified in the intermediate target profile. 

The Recipe/ICC Conversion and Recipe/Device Link options can be set for images 

only. When either option is set for an image, the recipe conversion is applied as a 

general rule. The ICC conversion or device link conversion is applied only to the 

images for which the recipe conversion option is not specified in Colorgenius 

LE/AC. 

Setting Allows you to make settings only when the Recipe/ICC Conversion or 

Recipe/Device Link option is selected in Conversion method. 

Click the Setting button to display the Select Image Conversion Recipe window. 

 

 

Input color space Conversion intent Conversion method 
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 • File: 

The recipe files appropriate for RGB images are displayed in the pulldown list. 

You can select an RGB conversion recipe. For more information about the default 

recipes, see “Default recipe files” in Chapter 11. 
• Modify the image resolution according to the output resolution: 

Select this check box to optimize the quality of images that are included in the 

input file. For more information, see “Image conversion setting” in Chapter 11. 
• Quality Level: 

Allows you to select a quality level from the pulldown list. For more information, 

see “Image conversion setting” in Chapter 10. 
• Correct the Sharpness parameter automatically when enlarging the image: 

Select this check box to apply the optimal sharpness correction automatically. For 

more information, see “Image conversion setting” in Chapter 11. 
• Output Resolution: 

Allows you to set the output resolution of the image after the recipe conversion. For 

more information, see “Image conversion setting” in Chapter 11. 

Conversion intent For image data, you can make settings only when the ICC Conversion or 

Recipe/ICC Conversion option is selected in Conversion method. For text or 

illustration data, you can make settings only when the ICC Conversion option is 

selected in Conversion method. 

Select a conversion intent from the pulldown list. The conversion intent options 

include Default, Perceptual, Saturation, Relative Colorimetric, and Absolute 

Colorimetric. In general, each conversion intent is defined as follows. 

Default converts colors with the intent specified in the document. If no intent is 

specified, conversion is made using relative matching. 

Perceptual converts colors as close as possible to their original colors without 

changing the lightness (L value) so that the visual perception of each color is 

maintained. If the color space for the output device is narrow, colors must be 

reproduced within the narrow color space, therefore all colors are replaced. 

Although this color matching method requires all colors to be replaced, it rarely 

causes tone jumps. For this reason, this method is suitable for the conversion of 

photo images that include many out-of-gamut colors. Saturation converts colors as 

close as possible to their original colors using enhanced lightness (L value) to 

maintain saturation of colors rather than to reproduce the colors accurately. This 

method is suitable for the conversion of data that requires bright color tones. It is 

typically used for charts and tables for business use. 

Relative Colorimetric maintains a relative color gamut of each color. The input 

profile color gamut and the output profile color gamut are compared and then the 

color conversion is performed according to the resulting difference ratios. When the 

colors are outside the color gamut of the output profile, these colors are converted 

to the possible proximate colors in the output profile. Absolute Colorimetric leaves 

the colors in the output profile color gamut unchanged. An out-of-gamut color is 

converted to a color that has the same color tone and is located on the outmost 

border of the color space. This method is useful when colors must be reproduced 

accurately. However, when the output profile color gamut is narrower than the 

input profile color gamut, the colors that are located outside the color gamut and 

have the same color tones are displayed as the same color. 
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Option For image data, you can make settings only when the ICC Conversion or 

Recipe/ICC Conversion option is selected in Conversion method. For text or 

illustration data, you can make settings only when the ICC Conversion option is 

selected in Conversion method. 

Select an option from the pulldown list. The option items include Keep paper color 

, Keep black 100% after conversion , and Keep pure black color . You 

can select multiple options. The icons for selected options are displayed as follows. 

 

For more information about the options, see “Options for ICC color conversion” in 
Chapter 11. Note that the option item functions after the ICC conversion. Therefore 

it cannot be used for the images for which the recipe conversion is executed with 

Recipe/ICC Conversion selected. 

Device link profile For image data, you can make settings only when the Device Link Conversion or 

Recipe/Device Link option is selected in Conversion method. For text or illustration 

data, you can make settings only when the Device Link Conversion option is 

selected in Conversion method. 

 

Select a device link profile from the pulldown list. For more information about the 

default device link profiles, see “Device link profiles” in Chapter 11. Also, for 
information on how to register a device link profile, see “12 Registering profiles 
and recipes”. 

 

● CMYK settings 

CMYK settings allow you to set the input color space and conversion method that are applied to the image data and 

the text or illustration data created in CMYK. Settings can be made for the image data, text data, and illustration data 

separately. 

 

 

 

 

 

Input color space Allows you to select an ICC profile that is set as the input color space from the 

pulldown list. 

For more information about the default ICC profiles, see “Input color space” in 
Chapter 11. Also, for information on how to register an ICC profile, see”12 
Registering profiles and recipes”. 

Use Embedded profile Select this check box to use the embedded ICC profile as the input color space if 

an ICC profile is embedded in an object, such as an image, text, or illustration, in 

the input file. 

Input color space Conversion intent Conversion method 
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Conversion method Allows you to select the conversion method of the input color space from the 

pulldown list. For image data, you can select the conversion method from Pass 

(Identify as the same color), ICC Conversion, Device Link Conversion, 

Recipe/Pass, Recipe/ICC Conversion, and Recipe/Device Link. 

For text or illustration data, you can select the conversion method from Pass 

(Identify as the same color), ICC Conversion, and Device Link Conversion. 

Select Pass (Identify as the same color) when the input color and the intermediate 

target color are recognized as an identical color. The data is not converted but 

treated as the intermediate target color 

If you select ICC Conversion, the ICC conversion is executed using the specified 

conversion intent. 

If you select Device Link Conversion, the input color space is converted to the 

output color space using the device link profile. The output result data is regarded 

as a color space that is specified in the intermediate target profile. 

The Recipe/Pass, Recipe/ICC Conversion, and Recipe/Device Link options can 

be set for images only. When any of these options is set for an image, the recipe 

conversion is applied as a general rule. 

The pass, ICC conversion, or device link conversion is applied only to the images 

for which the recipe conversion option is not specified in Colorgenius LE/AC. 

Setting Allows you to make settings only when the Recipe/Pass, Recipe/ICC Conversion 

or Recipe/Device Link option is selected in Conversion method. 

Click the Setting button to display the Select Image Conversion Recipe window. 

 

• File: 

The recipe files appropriate for CMYK images are displayed in the pulldown list. 

You can select a CMYK conversion recipe. For more information about the 

default recipes, see “Default recipe files” in Chapter 11. 
• Modify the image resolution according to the output resolution: 

Select this check box to optimize the quality of images that are included in the 

input file. For more information, see “Image conversion setting” in Chapter 11. 
• Quality Level: 

Allows you to select a quality level from the pulldown list. For more information, 

see “Image conversion setting” in Chapter 11. 

Correct the Sharpness parameter automatically when enlarging the image... 

Select this check box to apply the optimal sharpness correction automatically. For 

more information, see “Image conversion setting” in Chapter 11. 
• Output Resolution: 

Allows you to set the output resolution of the image after the recipe conversion. For 

more information, see “Image conversion setting” in Chapter 11. 
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Conversion intent For image data, you can make settings only when the ICC Conversion or 

Recipe/ICC Conversion option is selected in Conversion method. For text or 

illustration data, you can make settings only when the ICC Conversion option is 

selected in Conversion method. 

Select a conversion intent from the pulldown list. The conversion intent options 

include Default, Perceptual, Saturation, Relative Colorimetric, and Absolute 

Colorimetric. In general, each conversion intent is defined as follows. 

Default converts colors with the intent specified in the document. If no intent is 

specified, conversion is made using relative matching. 

Perceptual converts colors as close as possible to their original colors without 

changing the lightness (L value) so that the visual perception of each color is 

maintained. If the color space for the output device is narrow, colors must be 

reproduced within the narrow color space, therefore all colors are replaced. 

Although this color matching method requires all colors to be replaced, it rarely 

causes tone jumps. For this reason, this method is suitable for the conversion of 

photo images that include many out-of-gamut colors. Saturation converts colors as 

close as possible to their original colors using enhanced lightness (L value) to 

maintain saturation of colors rather than to reproduce the colors accurately. This 

method is suitable for the conversion of data that requires bright color tones. It is 

typically used for charts and tables for business use. 

Relative Colorimetric maintains a relative color gamut of each color. The input 

profile color gamut and the output profile color gamut are compared and then the 

color conversion is performed according to the resulting difference ratios. When the 

colors are outside the color gamut of the output profile, these colors are converted 

to the possible proximate colors in the output profile. Absolute Colorimetric leaves 

the colors in the output profile color gamut unchanged. An out-of-gamut color is 

converted to a color that has the same color tone and is located on the outmost 

border of the color space. This method is useful when colors must be reproduced 

accurately. However, when the output profile color gamut is narrower than the 

input profile color gamut, the colors that are located outside the color gamut and 

have the same color tones are displayed as the same color. 

Option For image data, you can make settings only when the ICC Conversion or 

Recipe/ICC Conversion option is selected in Conversion method. For text or 

illustration data, you can make settings only when the ICC Conversion option is 

selected in Conversion method. 

Select an option from the pulldown list. The option items include Keep paper color 

, Keep black plate , Keep black 100% after conversion , Keep pure 

black color . 

 

You can select multiple options. The icons for selected options are displayed as 

follows. 

 

For more information about the options, see “Options for ICC color conversion” in 

Chapter 11. Note that the option item functions after the ICC conversion. Therefore 

it cannot be used for the images for which the recipe conversion is executed with 

Recipe/ICC Conversion selected. 
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Device link profile For image data, you can make settings only when the Device Link Conversion or 

Recipe/Device Link option is selected in Conversion method. For text or illustration 

data, you can make settings only when the Device Link Conversion option is 

selected in Conversion method. 

 

Select a device link profile from the pulldown list. For more information about the 

default device link profiles, see “Device link profiles” in Chapter 11. Also, for 
information on how to register a device link profile, see “12 Registering profiles 
and recipes”. 

 

● Gray settings 

Gray settings allow you to set the input color space and conversion method that are applied to the image data and 

the text or illustration data created in Gray. Settings can be made for the image data, text data, and illustration data 

separately. 

 

 

 

 

 

Input color space Allows you to select an ICC profile that is set as the input color space from the 

pulldown list. 

For more information about the default ICC profiles, see “Input color space” in 
Chapter 11. Also, for information on how to register an ICC profile, see “12 
Registering profiles and recipes”. 

Use Embedded profile Select this check box to use the embedded ICC profile as the input color space if 

an ICC profile is embedded in an object, such as an image, text, or illustration, in 

the input file. 

Conversion method Allows you to select the conversion method of the input color space from the 

pulldown list. You can select the conversion method from Delete Profile, ICC 

Conversion, and Device Link Conversion. 

If you select Delete Profile, the embedded ICC profile is deleted. The target colors 

are not converted. 

If you select ICC Conversion, the ICC conversion is executed using the specified 

conversion intent. 

If you select Device Link Conversion, the input color space is converted to the 

output color space using the device link profile. The output result data is regarded 

as a color space that is specified in the intermediate target profile. 

Conversion intent For image data, you can make settings only when the ICC Conversion option is 

selected in Conversion method. 

Select a conversion intent from the pulldown list. The conversion intent options 

include Default, Perceptual, Saturation, Relative Colorimetric, and Absolute 

Colorimetric. In general, each conversion intent is defined as follows. 

Default converts colors with the intent specified in the document. If no intent is 

specified, conversion is made using relative matching. 

Input color space Conversion intent Conversion method 
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 Perceptual converts colors as close as possible to their original colors without 

changing the lightness (L value) so that the visual perception of each color is 

maintained. If the color space for the output device is narrow, colors must be 

reproduced within the narrow color space, therefore all colors are replaced. 

Although this color matching method requires all colors to be replaced, it rarely 

causes tone jumps. For this reason, this method is suitable for the conversion of 

photo images that include many out-of-gamut colors. 

Saturation converts colors as close as possible to their original colors using 

enhanced lightness (L value) to maintain saturation of colors rather than to 

reproduce the colors accurately. This method is suitable for the conversion of data 

that requires bright color tones. It is typically used for charts and tables for business 

use. 

Relative Colorimetric maintains a relative color gamut of each color. The input 

profile color gamut and the output profile color gamut are compared and then the 

color conversion is performed according to the resulting difference ratios. When the 

colors are outside the color gamut of the output profile, these colors are converted 

to the possible proximate colors in the output profile. 

Absolute Colorimetric leaves the colors in the output profile color gamut 

unchanged. An out-of-gamut color is converted to a color that has the same color 

tone and is located on the outmost border of the color space. This method is useful 

when colors must be reproduced accurately. However, when the output profile 

color gamut is narrower than the input profile color gamut, the colors that are 

located outside the color gamut and have the same color tones are displayed as 

the same color. 

Option Allows you to make settings only when the ICC Conversion option is selected in 

Conversion method. 

Select an option from the pulldown list. The option items include Keep paper color 

, Keep black 100% after conversion , Keep pure black color . You can 

select multiple options. The icons for selected options are displayed as follows. 

 

For more information about the options, see “Options for ICC color conversion” in 
Chapter 11. 

Device link profile Allows you to make settings only when the Device Link Conversion option is 

selected in Conversion method. 

 

Select a device link profile from the pulldown list. For more information about the 

default device link profiles, see “Device link profiles” in Chapter 11. Also, for 
information on how to register a device link profile, see “12 Registering profiles 
and recipes”. 

CMYK/Gray that has not 

adhered the profile is passed. 

You can only make settings under the following conditions. 

• When the Use importing file information check box is not selected in the input 

processing. 

 

Select this check box to send the CMYK or Gray object data with no ICC profile 

embedded to the output side without being converted with the specified conversion 

method. 

This function is applied to all CMYK and Gray data in a batch. 
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● Lab color space settings 

Clicking Detail setting on the left side of the Input Color Setting window displays the Lab setting fields. You can set the 

conversion method that is applied to the Lab color space for the image data and the text or illustration data. 

 

 

 

 

 

Conversion method Allows you to select the conversion method of the input color space from the 

pulldown list. You can select only ICC Conversion as a conversion method. 

If you select ICC Conversion, the ICC conversion is executed using the specified 

conversion intent. If no intent is specified, ICC conversion is made using perceptual 

matching. 

Conversion intent Select a conversion intent from the pulldown list. The conversion intent options 

include Default, Perceptual, Saturation, Relative Colorimetric, and Absolute 

Colorimetric. In general, each conversion intent is defined as follows. 

Default converts colors with the intent specified in the document. If no intent is 

specified, conversion is made using relative matching. 

Perceptual converts colors as close as possible to their original colors without 

changing the lightness (L value) so that the visual perception of each color is 

maintained. If the color space for the output device is narrow, colors must be 

reproduced within the narrow color space, therefore all colors are replaced. 

Although this color matching method requires all colors to be replaced, it rarely 

causes tone jumps. For this reason, this method is suitable for the conversion of 

photo images that include many out-of-gamut colors. 

Saturation converts colors as close as possible to their original colors using 

enhanced lightness (L value) to maintain saturation of colors rather than to 

reproduce the colors accurately. This method is suitable for the conversion of data 

that requires bright color tones. It is typically used for charts and tables for business 

use. 

Relative Colorimetric maintains a relative color gamut of each color. The input 

profile color gamut and the output profile color gamut are compared and then the 

color conversion is performed according to the resulting difference ratios. When the 

colors are outside the color gamut of the output profile, these colors are converted 

to the possible proximate colors in the output profile. 

Absolute Colorimetric leaves the colors in the output profile color gamut 

unchanged. An out-of-gamut color is converted to a color that has the same color 

tone and is located on the outmost border of the color space. This method is useful 

when colors must be reproduced accurately. However, when the output profile 

color gamut is narrower than the input profile color gamut, the colors that are 

located outside the color gamut and have the same color tones are displayed as 

the same color. 

Option Select an option from the pulldown list. The option items include Keep paper color 

 and Keep black 100% after conversion . You can select multiple options. 

The icons for selected options are displayed as follows. 

 

For more information about the options, see “Options for ICC color conversion” in 
Chapter 11. 

Conversion intent Conversion method 
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Section 

Make settings for the section. More than one section can be set for one job. You can set finish conditions for a section 

and the setting information is applied to the ticket or imposition scheme for the output workflow. 

 

Setting binding type between sections 

Clicking  on the upper section of the output workflow setting area opens the Total Binding Type Setting window. 

In the Total Binding Type Setting window, you can select whether to include the front cover and set the position 

between the sections (binding type). 

 

 

Perfect Bound Sets the perfect binding for binding between sections. 

Perfect Bound (wrapping 

cover) 

Sets the perfect binding (wrapping cover) for binding between sections. 

Saddle Stitch Sets the saddle stitching for binding between sections. 

 

 

 The binding type between sections cannot be set for a section auto-switching job (job template). 

 

Adding a section 

Clicking  on the upper section of the output workflow setting area opens the Section Setting window, to which 

you can add the section. The Section setting window consists of three windows: Section Setting, Plate, and Set Macro 

Values. You can switch a window by selecting the setting item on the left. 

 

Note 
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Section Setting 

Make the basic information settings in Section Setting. 

 

 

Section Name Specify a section name. 

Section Type Allows you to select a section type from the pull-down list. 

• Normal: An imposition scheme is created according to the page size and 

number of pages specified for the section. 

• Auto Ganging: An imposition scheme is created using an auto ganging function. 

• Section Layout: Signatures that are set for multiple sections are ganged. 

Page Order Allows you to select a pagination style from the pull-down list. 

• Normal: Page order in an imposition scheme is serially numbered from 1. 

• Free: Page order in an imposition scheme is discontinuous. 

Number of Pages Allows you to specify the number of pages for the section. 

Page Size Allows you to specify the finished page size. 

Mixed Size Select this check box when the section contains different page sizes. 

Binding Side Allows you to select a binding position. You can select from Right, Top, and Left. 

Binding Type Allows you to select a binding type. You can select from Perfect, Perfect Bound 

(wrapping cover), and Saddle Stitch. 
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Plate 

Make settings for the separations to be used for printing of the section in Plate. You can also set the output order for 

the separations. 

 

 

To Top Moves the selected separation to the top. 

To Upper Moves the selected separation one position up. 

To Lower Moves the selected separation one position down. 

To Bottom Moves the selected separation to the bottom. 

Add Allows you to add a separation. 

Detail Shows the simulated color value for the selected separation. 

Delete Deletes the selected separation from the separation list. 
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Set Macro Values 

Set spine mark character strings and simple accessory character strings. These character strings are used for 

replacement of macro characters that are set in Spine Mark Editor as well as in Register Mark and Simple Accessory 

Editor. 

 

 

Backbone Mark String Allows you to enter a character string to be output on the spine. 

Simple Accessory String Allows you to enter a simple accessory character string to be output. If you do not 

enter anything, it is left blank. 

 

Editing a section 

Clicking the section you wish to edit shows the Section Setting window. Edit the conditions as necessary, and then click 

the Save button. 

 

Deleting a section 

When you place the mouse cursor on a section, the Delete icon is displayed to the upper right. Clicking  deletes 

the corresponding section. 

 

Moving a section 

You can reorder the sections by dragging and dropping the target section. 
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Output Workflow 

You can register necessary settings, including imposition scheme, media, ticket, and color conversion settings, for 

purpose as output workflow. Up to 5 output workflows can be registered for one section and the output processing is 

executed using the output settings in order from the left in the setting area. To stop the processing, set Approval waiting 

or Stop between the output settings. When you have set Approval waiting, approving the processing will resume it 

using the next output setting. However, when you have set Stop, the processing can be resumed by issuing a ticket 

manually. 
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Adding an output workflow 

Follow the steps below to add an output workflow. 

 
 

1. Select the workflow type and output processing type. 

Clicking the Add icon on the lower right of the section opens the New Output Workflow window. Select the 

workflow type and output processing type. 

Next, perform the output-related setting. To create a new input setting, click the New button, and to import the 

output setting saved as template, click the Import button. 

 

 

2. Make the settings for the output. 

When creation of a new output setting is selected, the following output setting window opens. Perform settings 

such as printing conditions, output settings, color conversion, and printing processing ticket. For more information, 

see Output setting window below. 

 

 

Operation 
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3. Import the output settings. 

When importing of the output settings is selected, the following import window for output settings opens. Select the 

output settings to import, and click the Import button. 

 

 

4. Select or create an imposition scheme. 

You can set an imposition scheme by clicking the imposition scheme icon. Click the Link final output button to use 

the imposition scheme that is the same as the one set for the output processing. 

 

 

Type Allows you to select the type of imposition scheme to be set. 

 Normal : Output is performed with an imposition scheme set. 

 None : Output is performed without an imposition scheme set. 

 Booking : This option should be selected when an imposition 

scheme is to be set later. 

Edit Allows you to create a new imposition scheme or edit an existing imposition scheme. 

Simple Edit Allows you to edit only the plate, paper, and accessory preset. 

The dialog box displayed varies depending on the process to use. 

 

 

When a file output is selected, Plate and 

Paper are not displayed. 

Import Allows you to import an imposition template. 

Export Saves the imposition scheme set in the workflow as an imposition scheme template. 

Auto Ganging Starts the auto ganging wizard. 

 

 When using the fold catalog assignment function and auto ganging function, select Booking for 

Type and then save the setting. 
Note 
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Saving and reusing an output setting 

The output settings created in the output workflow are saved as a template to be used for other output work flows. To 

save the created output settings as a template, click the  button that is displayed in the lower right when you place 

the mouse cursor on an output workflow box. To import the output settings from the template, click the  button 

displayed in the lower right. When the new output settings are imported, the details of the output settings that were 

edited previously will be deleted. 

 

 

Importing an output workflow from other sections 

You can import all the output workflows specified for other sections. You can import the output workflows from not only 

the sections in the job being edited, but from other jobs and the sections of the job templates. Note that all of the old 

settings will be deleted when the new output workflow is imported. 

 
 

1. Click  in the upper right of the section. 

 

 

2. Select the original section for importing 

The Import Output Workflow window is displayed. Select the original section for loading from the Original section 

pull-down list, and click the Import button. 

When the original section for importing is in another job or template, select the job or job template using the radio 

button. After selecting the target job/job template from the Job/Job Template Name pull-down list, select the 

original section for importing. 

 

 

3. The loaded output workflow is displayed in the output workflow window. 

 

  

Operation 
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Editing an output workflow 

You can change the output workflow setting by clicking an icon on the output workflow box. The functions of each 

icon button are shown below. 

 

 

Output setting Opens the Output setting window and allows you to edit the output setting. For 

more information, see “Output setting window” below. 

Imposition scheme Allows you to edit an imposition scheme or import an imposition template. 

Change output processing type Changes the output processing type. The output workflow setting window opens 

next, as in the output workflow creation, so select the output processing type. When 

the output processing type is changed, the output settings are reset in accordance 

with the new output processing. 

Save output setting Saves the current output settings as a template. 

Import output setting Imports the output settings from the saved template. The current output settings will 

be deleted. 

Detailed information Shows the output workflow settings in a popup window. 

Delete Deletes the selected output workflow. 

 

  

Delete 

Change output processing type 

Save output setting 

Import output setting 

Output setting 

Imposition scheme 

Detailed information 
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Managing the output settings 

You can save the output settings to be reused. You can import the saved output settings during the output workflow 

setting. 

 

The Output Setting Manager window can be displayed from the Window menu of the main window. This window 

allows you to manage the operations such as creating a new output setting, editing, deleting, and copying the output 

setting. 

 

 

 

 Allows you to edit an output setting. Clicking this icon opens the window for editing the 

selected output setting. 

 Allows you to copy an output setting. Clicking this icon copies the selected output setting. 

 Allows you to delete an output setting. Clicking this icon deletes the selected output setting. 

 Allows you to change an output setting name. Clicking this icon opens the window for setting 

the name of the selected output setting. 

 

For details of the output setting editing, see Output setting window below. 

 

Setting area 

Select setting 

item area 
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Output setting window 

The configuration and settings of the output setting window differ depending on the processing type of the output 

target. This section describes the output setting window for each processing type. 

The configuration of the output setting window is shown below. 

 

 

Select the setting item in the Select setting item area on the left side of the window, and make settings for each item in 

the Setting area on the right side of the window. 

 



Job setting procedure 

75 

File output 

The output setting window for file output consists of four windows that are used for output settings, color conversion 

settings, processing order and output process ticket. 

 

[Output Settings] 

 

 

Plate Shows the list of output separations. The output separations that have been set in 

the relevant section are listed automatically. 

Process Allows you to specify whether or not to output each separation. 
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[Color Conversion] 

 

 

MediaDB Link Select ON to use dot gain file, ICC profile and device link profile linked in the 

media database. For information on how to confirm the settings in the media 

database, see ”Media Admin Tool Reference Manual”. If you select OFF, you can 
specify a dot gain file or an ICC profile individually. 

DotGain Allows you to select a dot gain file when the media database is not linked. For 

more information about the default dot gain file, see “Media Admin Tool Readme”. 
Also, for information on how to register an dot gain file, see ”Media Admin Tool 
Reference Manual”. 

Gray Select this check box to perform grayscale conversion. 

Conversion Method Allows you to select “ICC Conversion” or “Device Link” or “Doesn't Conversion” 
when the media database is not linked. 

Profile Allows you to make settings only when the media database is not linked and the 

ICC Conversion or Device Link option is selected in Conversion Method. 

Select a profile from the pulldown list. 

For more information about the default profile, see “Media Admin Tool Readme”. 
Also, for information on how to register an profile, see ”Media Admin Tool 
Reference Manual”. 

Conversion Intent Allows you to make settings only when the ICC Conversion option is selected in 

Conversion Method. Select a conversion intent from the pulldown list. The 

conversion intent options include Default, Perceptual, Saturation, Relative 

Colorimetric, and Absolute Colorimetric. In general, each conversion intent is 

defined as follows. 

Default converts colors with the intent specified in the document. If no intent is 

specified, conversion is made using relative matching. 

Perceptual converts colors as close as possible to their original colors without 

changing the lightness (L value) so that the visual perception of each color is 

maintained. If the color space for the output device is narrow, colors must be 

reproduced within the narrow color space, therefore all colors are replaced. 

Although this color matching method requires all colors to be replaced, it rarely 

causes tone jumps. For this reason, this method is suitable for the conversion of 

photo images that include many out-of-gamut colors. 
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 Saturation converts colors as close as possible to their original colors using 

enhanced lightness (L value) to maintain saturation of colors rather than to 

reproduce the colors accurately. This method is suitable for the conversion of data 

that requires bright color tones. It is typically used for charts and tables for business 

use. 

Relative Colorimetric maintains a relative color gamut of each color. The input 

profile color gamut and the output profile color gamut are compared and then the 

color conversion is performed according to the resulting difference ratios. When the 

colors are outside the color gamut of the output profile, these colors are converted 

to the possible proximate colors in the output profile. 

Absolute Colorimetric leaves the colors in the output profile color gamut 

unchanged. An out-of-gamut color is converted to a color that has the same color 

tone and is located on the outmost border of the color space. This method is useful 

when colors must be reproduced accurately. However, when the output profile 

color gamut is narrower than the input profile color gamut, the colors that are 

located outside the color gamut and have the same color tones are displayed as 

the same color. 

Option Allows you to make settings only when the ICC Conversion or Device Link option is 

selected in Conversion Method. Select an option from the pulldown list. The option 

items include Keep paper color, Keep primary color, Keep black 100% after 

conversion, and Keep pure black color (You can select only Keep paper color, 

Keep black 100% after conversion when you select Device Link or conversion to 

gray.). You can select multiple options. For more information about the options, see 

“Options for ICC color conversion” in Chapter 12. 

Quality Priority This check box becomes effective during ICC profile conversion. Select this to 

perform processing with priority given to the accuracy of conversion using the ICC 

profile for output color. Note, however, the processing time is longer. 

Conversion Area Allows you to set the application range of color conversion. 

Select the application range, either All Area or Finished Area. 
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[Processing Order] 

 

 

Processing Order Select the processing order of signature/page from the pull-down list. 

 

[Processing Ticket] 

The ticket editing window opens. The necessary processing is automatically set, so normally no editing is required. The 

ticket is edited when you want to add a processing to the flow or change the detailed parameters. 

 

 

Import Imports the saved output ticket. The ticket editing window is displayed. 

Ticket editing area Allows you to directly create and edit the ticket. For more information, see “Ticket 
Editing” in Chapter 7. 
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Operation using a job 

This section describes operations for a job. 

 

Registering files 

Automatic page assignment setting 

In the Register File window, the page assignment position can be specified using a page number or folio mark. You 

can select a page assignment method from the pull-down list at the upper right. 

 

Page number 

 

 

 

Section Name Allows you to select a section to which the file is assigned. The page numbers are 

assigned within the selected section. If the number of pages exceeds the page 

range for the specified section, the extra pages are assigned to the next section. 

When you select All section, page numbers are assigned throughout the entire job. 

Start Allows you to specify the page number to start the page assignment. 

End Allows you to specify the page number to end the page assignment. 

File Allows you to specify the file to be registered. 

Start Page Allows you to specify the page in the registered file from which the page 

assignment starts. To start the page assignment from the first page, specify “1”. 

Continuation Page Assignment When you register multiple files that all contain the same number of pages, specify 

the number of pages here. This makes page assignment settings for all files at the 

same time. 
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Folio mark 

 

 

Section Name Allows you to select a section to which the file is assigned. 

Head Shows the folio mark for the first page of the page assignment. The folio mark is 

searched from the input data and displayed. 

Page Count Allows you to specify the number of pages for the page assignment. The folio 

marks are assigned throughout the specified number of pages beginning from the 

folio mark specified in Head. 

File Allows you to specify the file to be registered. 

Continuation Page Assignment Allows you to assign pages continuously. 

 
 

1. Click the Register File button in the shortcut area. 

The main area switches to Registered File Management, and the Register File window is displayed. 

 

2. Register a file to the Register File window. 

You can register a file to the Register File window by dragging the file to the window or by clicking the Add 

button to select file from the File Select window. 

 

 

3. Make the page assignment setting in the Register File window if automatic assignment has been set. 

 

 • If the main area is Registered File Management, you can also drag file icons to the main area to 

register them. 

• You can also register multiple files by dragging them to the main area together. 

 

Note 

Operation 
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Input processing 

You can run input processing for the selected files. If you run input processing on files on which it has already been run, 

the previous processing results are temporarily lost. However, the content of the page assignment settings from the time 

of registration is preserved, so after re-input processing is finished, page assignment is run again automatically 

according to the settings at the time of registration. 

 

 If you run re-input processing on files on which page assignment has already been run, the 

following window is displayed. 

The Un-assign Pages check box should be selected to discard the page assignment information for 

the corresponding PDF or cleared to preserve it when the page assignment is run. 

 

 

 
 

1. Click the Input button in the shortcut area. 

The main area switches to Registered File Management, and the Input Process Ticket window is displayed. 

 

 

Note 

Operation 
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2. Select the ticket to be issued from the Input Process Ticket window, select the files to be processed from 

the registered file list in the main area, and click the Execute button. 

A confirmation window asking you to confirm the files to be processed is displayed. 

 

 

3. Check the files to be processed, and click the OK button. 

The input processing ticket is issued according to the selected settings. The progress of the ticket is displayed in the 

progress view area on the bottom right. 

 

4. After you have finished issuing tickets, click the Close button to close the window. 

 

Assigning pages 

You can assign pages in a file to pages in an Activity Board. 

 
 

1. Click the Page Assign button in the shortcut area. 

The main area switches to Activity Board, and the area to select files and pages to assign is displayed at the 

bottom of the window. 

 

You can assign pages in a file to pages in an imposition scheme. 

 

 The page data already assigned is preserved even after the imposition scheme is replaced with 

another one. 

The preserved page data can be used again when the number of pages in the imposition scheme is 

increased. 

 
 

1. Click the Page Assign button in the shortcut area. 

The settings for specifying the page range for the pages you want to assign is displayed at the bottom of the 

window. 

 

[List display] 

 

 

  

Note 

Operation 

Operation 
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[Thumbnail display] 

 

 

Page Range Allows you to enter a page range for the pages you want to assign. 

 Switches between the list display and the thumbnail display for files in the Page 

Assign window. 

 Switches the thumbnail display. You can switch between small thumbnail display, 

large thumbnail display, and thumbnail with information display. 

 

2. To rotate the file in advance, set the rotation angle to 0°, Right 90 deg., 180°, or Left 90° deg., and 

then click the Rotate Page button. 

 

3. To change the page assignment settings, click the Setting button. 

The Page Assign Setting window is displayed. 

 

4. Make settings for Layout Origin, Spread and Offset, and then click the OK button. 

 

Layout Origin Allows you to select from Lower Left, Center and Upper Left for the layout origin. 

Input Data Auto Scaling Select this check box to assign pages so that the page size of the assignment file is 

enlarged or reduced to fit the page size of the assignment location. For the scaling 

condition, select Automatic, H, or V. 

Spread If you selected Center, Lower Left or Upper Left in Layout Origin, select this check 

box to set the spread conditions. 

Offset Allows you to set the amount of offset from the position specified in Layout Origin. 

 

5. In the Page Assign window, select the file to be assigned and enter the range of pages in the Page 

Range text boxes. 

If you want to assign files in batch, select the files, and if you want to assign each page individually, select the 

pages. You can select multiple pages at the same time. 
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6. Select the assignment locations for pages from Activity Board in the main area, and click the Assign 

button. 

If you selected a file or multiple pages in the Page Assign window, the pages for the assignment location are 

assigned in order starting from the first page selected. 

 

 You can also assign pages by dragging files or pages from the Page Assign window to the 

assignment location pages in the main area. 

 

7. After you have finished page assignment tasks, click the End button to close the Page Assign window. 

 

Input Data Auto Scaling 

This function enlarges or reduces the size of pages to be assigned based on the page size of the assignment file and 

the page size of the assignment location (imposition scheme).Automatic, H, or V can be selected as a reference 

position. The page size is enlarged or reduced depending on the reference position selected, as described below. 

 

Datum Line: Automatic 

Page size is enlarged or reduced so that no margin is left with respect to the page size of the auto assignment location. 

 

 

Datum Line: H 

Page size is enlarged or reduced so that the width of the page to be assigned becomes the same as the page width of 

the assignment location. If this option is selected when the binding position is left or right, the spread page setting will 

be disabled. 

 

Datum Line: V 

Page size is enlarged or reduced so that the height of the page to be assigned becomes the same as the page height 

of the assignment location. If this option is selected when the binding position is top, the spread page setting will be 

disabled. 

 

  

Note 

Page size of 

assignment source 

(file) 

 

Page size of  

assignment location  

(imposition scheme) 

Assignment result 
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Page assignment extending across sections 

If you specify the page range and the page number exceeds the number of pages in the section to be assigned, the 

pages are assigned across sections. 

 

Example 

 

 

 

 

Setting blank pages 

You can set blank pages to pages in an imposition scheme. 

 
 

1. Switch the main area to Activity Board, and select the page for which to set a blank page. 

 

2. Click  on the toolbar. 

A blank page is set for the selected page in the imposition scheme. 

 

Moving the assigned pages 

You can select multiple, sequential pages and move them to another assignment destination. 

 

 
 

1. Select the target pages to move in the Activity Board and then click  on the toolbar. 

 

2. In the Shift Pages window, specify the assignment destination or the amount to move the pages. 

 

 

Page Assign dialog box 
The remaining 4 pages 

are carried over 

Select 8 pages and assign them to the 5th 

page in Section A 

Operation 

Operation 
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 Adjusting page offsets 

You can adjust the offset for selected pages in an imposition scheme. 

 
 

1. Switch the main area to Activity Board or Show Layout, select the pages in an imposition scheme, and 

then click  on the toolbar. 

The Adjust Offset Dialog Box window is displayed. 

 

 

Layout Origin Shows the layout origin. 

Offset Shows the current offset values for the selected page. If you select more than one 

page, the offset values are displayed as described below. 

If the same offset values are assigned to all of the pages: Common page offset 

values are displayed. 

If the same offset values are not assigned to all of the pages: Offset values are 

displayed as “---”. Even if “---” is displayed, the adjusted offset values that were 
input are reflected in the offset values for the pages. 

Selected Page Applies the values entered in Adjust Value for the selected pages. 

Page Range Allows you to enter a range of pages for which to adjust the offset. In Target, you 

can set how you want the offset adjustment to be applied to the range of pages 

that you entered. See the following for more information. 

• Yes to All: Applies the offset value to all of the pages in the specified range. 

• Odd: Applies the offset value to all of the odd-numbered pages in the specified 

range. 

• Even: Applies the offset value to all of the even-numbered pages in the specified 

range. 

Adjust Value Allows you to enter X and Y offset values. 

 

  

Operation 
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Size Adjustment 

You can adjust the size of the assignment pages with respect to the page in the selected imposition scheme. 

 
 

1. Switch the main area to Activity Board or Show Layout, select the pages in an imposition  

scheme, and then click  on the toolbar. 

The Size Adjustment window is displayed. 

 

Selected page Applies the entered values to the selected page numbers. 

Page Range Allows you to enter a range of pages for which to adjust the size. 

Auto Fit Performs automatic adjustment for the specified pages. 

Automatic, H, or V can be selected as a reference position. 

Specify Individually Allows you to set the enlargement/reduction ratio of an individual page size. 

When you enter “100”, the page size is not enlarged or reduced. For pages that 

have already been enlarged or reduced, the existing setting is reset (scaling ratio is 

returned to 100%) and then the page is enlarged (reduced) by the specified ratio. 

• H: Enter the enlargement/reduction ratio in the horizontal direction of the page. 

• H: Enter the enlargement/reduction ratio in the vertical direction of the page. 

Assigned Data Size Shows the information about the page size of assignment source and the page size 

to which the enlargement/reduction ratio specified at Specify Individually has 

been applied. 

 

 

Operation 
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Setting folio marks 

You can set folio marks for output for selected pages in an imposition scheme. 

 
 

1. Switch the main area to Layout Management, select the pages in an imposition scheme, and then click 

 on the toolbar. 

The Setup Folio Mark window is displayed. 

 

 

Specified Range Allows you to select the page range for which to set folio marks. 

Page Layout Select this if you want to output the page numbers of individual pages as folio 

marks. Set Prefix Character Strings, Suf.Strings, or Start Number as necessary. 

• Character Strings : Allows you to enter prefix characters. 

• Suf.Strings : Allows you to enter suffix characters. 

• Start Number : Allows you to enter a start number. 

Only Character Strings Select this if you want to output the same folio marks on all of the pages. Set the 

character string to be output as folio marks. 

 

 Macros that can be set using a prefix character string, suffix character string, or character string 

only. 

The following macros are available. 

• %N.%n: Registered file name 

• %P,%p: Page number of the registered file 

• %L,%l: Date and time of file registration 

 

Note 

Operation 
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Proofreading OK’d 

You can set proofreading for a page and each signature of the imposition for final output. When you set proofreading 

for pages, you cannot modify the pages. However, when you set proofreading for a signature, the pages on the 

signature are OK’d for proofreading. In addition, operations such as editing imposition schemes and changing section 

settings are prohibited. 

 

Proofreading for page 

 
 

1. Select a target page for proofreading in the Activity Board and then click  on the toolbar. 

 

Proofreading for signature 

 
 

1. Select a target signature for proofreading in the Layout Management window and then click  on 

the toolbar. 

 

 You cannot set proofreading when the target page or signature is in the approval waiting 

or rejected status, or the PDF for the page selected in the Layout Management window is 

open. 

 

Output processing 

You can issue an output processing ticket for the selected signature (side).  

It is also possible to perform output processing using a ticket that was executed before. 

 

 

 

Workflow Used to perform processing using the workflow specified for the selected signature. 

History Used to perform processing using the ticket issued for the output processing. 

Output Setting Template Used to perform processing using the output setting saved on the system. 

 

Important 

Operation 

Operation 
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1. Click the Output button in the shortcut area. 

The main area switches to Layout Management, and the Output Process Ticket window is displayed. Change the 

output workflow for the signature to be output using the pull-down list at the top of the signature list, if necessary. 

 

 

 

2. When you do not change the output setting. 

Select the signatures to be processed from the main area, and then click the Re-Execute button. 

 

3. When you edit the output setting before output. 

Select the signatures to be processed from the main area. Enable Use selected Output Workflow, and then click 

the Temporarily Edit and Execute button. Check the signatures to be processed, and click the OK button. The 

output setting window is displayed. After editing, click the Re-Execute button. 

 

Operation 
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4. When you output using history. 

Select the History tab in the lower section in the main area. Select a history ticket for use from the window shown 

below, and then click the Temporarily Edit and Execute button. 

The output setting window is displayed. After editing, click the Re-Execute button. 

 

 

Display history of the selected 

surface 

Select this check box to display only the output history of the selected folds. 

Start Date Shows the date and time when the ticket was issued. 

Process Target Shows the sections and signatures that were processed using this ticket. 

Workflow Type Shows the workflow (layout) that was processed using this ticket. 

Workflow Shows the workflow. 

Comments Shows the comment. 

 

5. When you output using output setting. 

Select the Output Setting Template tab in the lower section in the main area. Select a history ticket for use from the 

window shown below, and then click the Temporarily Edit and Execute button. The output setting window is 

displayed. After editing click the Re-Execute button. 
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5. Imposition 

This chapter describes the imposition scheme. 

 

 

Managing imposition schemes 

You can select imposition scheme templates. Click the Import button in the imposition setting window of the Action Plan 

window to display the Imposition Manager window. 

 

 

 

 

Toolbar The following icons are displayed in the toolbar. 

  Allows you to create a new imposition scheme. 

  Allows you to edit an imposition scheme. 

  Copies an imposition scheme. 

  Deletes an imposition scheme. 

  Changes the name of an imposition scheme. 

Imposition list Shows the registered imposition scheme templates. 

• Imposition Name: Shows the imposition scheme name. 

• Type: Shows the type of imposition scheme. 

• Binding Side: Shows the binding position. 

• Binding Type: Shows the binding type 

• Last Update: Shows the date and time when the imposition scheme template was 

last updated. 

• Comments: Shows comments. 

• Page Sequence: Shows the page sequence. 

• Number of Pages: Shows the number of pages. 

• Page Size: Shows the page size. 

• Jog Side: Shows the jog side. 

• Printing Method: Shows the printing method. 

• Printing Style: Shows the printing style. 

Tool bar 

Imposition scheme list 

History 
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• Sheet Size: Shows the sheet size. 

History Shows the history of the imposition schemes that were set for the job in the past. 

• Imposition Name: Shows the imposition scheme name. 

• Type: Shows the type of imposition scheme. 

• Binding Side: Shows the binding position. 

• Binding Type: Shows the binding type. 

• Replaced Date: Shows the date and time of imposition scheme processing. 

• Section: Shows the section or sections that have been set. 

OK Applies the selected imposition scheme to the section or sections and closes the 

Imposition Manager window. 

Cancel Closes the Imposition Manager window without applying the selected imposition 

scheme to the section or sections. 

 

Creating a new imposition scheme 

You can create a new imposition scheme template. Click  on the toolbar to display the Imposition Editor window. 

 

 For information about how to use the Imposition Editor window, see “Creating an editing imposition 
scheme templates”. 

 

 • When creating an imposition scheme from a job, the list is filtered depending on the settings for 

the section. 

When Mixed Size is not checked: 

When left binding is selected, the imposition scheme templates for left binding and right binding 

are displayed in the list. 

When right binding is selected, the imposition scheme templates for left binding and right binding 

are displayed in the list. 

When top binding is selected, the imposition scheme templates for top binding are displayed in 

the list. 

 

Editing an imposition scheme 

You can edit an imposition scheme template. Select the imposition scheme template from the imposition scheme list 

and click  on the toolbar to display the Imposition Editor window. Editing operations are the same as for creating 

a new imposition scheme. 

 

Copying an imposition scheme 

You can copy an imposition scheme template and register it. Select the imposition scheme template from the imposition 

list and click  on the toolbar to display the Copy window. Enter a name in Copying Name and click the <OK> 

button to copy the imposition scheme using the name you specified. 

 

 

Reference 

Note 
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Changing the name of an imposition scheme 

You can change the name of an imposition scheme template. Select the imposition scheme template from the 

imposition scheme list and click  Rename button on the toolbar to display the Rename window. Enter a name in 

Name and click the OK button to change the name to the one you specified. 

 

 

 

Creating and Editing a imposition scheme 

Operation procedure 

You can create an imposition scheme and add signatures as easily as you use the wizard feature following the easy 

step-by-step setting instructions. Even after you complete the wizard, you can still change the setting easily, since you 

can see the each setting instruction in the wizard directly from the Imposition Edit window. 

 

 Note that the setting window varies depending on the section type (Normal, Section 

Layout, and Auto Ganging). 

 

Follow the steps below to create an imposition scheme. 

 
 

1. Create a new imposition scheme from the Imposition Manager window or the Action Plan window. 

 

2. Select the type of imposition scheme. 

 

3. Use imposition scheme wizard and set the imposition scheme Basic Setting and the first signature 

setting. 

You can create the imposition scheme with only wizard when the imposition scheme has one kind of print surface. 

 

4. Check the imposition scheme created in Imposition Edit window. Add or edit the signature, change the 

setting for each page, or change the free page arrangement settings when necessary. 

 

Follow the steps below to edit the existing imposition scheme. 

 
 

1. Edit the imposition scheme from the Imposition Manager window or the Job property window. 

 

2. Edit the imposition scheme to add/delete signature, change the setting of the signature or change the 

setting for each page in Imposition Edit window. 

 

 

Important 

Operation 

Operation 
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Imposition scheme wizard 

If you create a new imposition scheme from the Imposition Manager window or the Job property window, the New 

Imposition Wizard window is displayed. 

The new imposition wizard allows you to make basic settings that are applied to the entire imposition scheme, such as 

the number of pages and the page size. It also allows you to make print settings, layout settings, and accessory 

settings for the imposition scheme. 

 

For Normal layout 

 

 

Shortcut area Display of the shortcut area for the Normal layout and Section layout are different. 

Shows icons that allow you to switch the setting window that is displayed in the 

main area. The bright icon shows the current setting window in main are, then you 

can check the progress of setting. 

   Basic setting: Shows Basic settings window. For more information, see 

“Basic setting”. 

   Print setting: Shows Print settings window. For more information, see 

“Print settings layout”. 

   Layout: Shows the layout editing window. 

For more information, see “Layout settings”. 

   Accessory Setting: Shows Accessory window. For more information, see 

“Accessory settings”. 

Main area Shows the setting window and preview. 

Next Shows the next setting window in main area. 

Rev Shows the previous setting window in main area. 

Apply Current settings are applied to the imposition scheme. 

OK Create the imposition scheme with the current settings. 

Cancel Quit creating the imposition scheme and go back the previous window. 

Main area 

Shortcut area 
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Save as defaults Saves the settings as default wizard operation values from the next time the 

program starts up. 

Save as defaults allows you to save perfect bound and saddle-stitching settings 

separately. Note that the Basic setting options are the same for perfect bound and 

saddle-stitching. 

Help Shows the on-line manual. 

 

New Auto Ganging wizard 

A New Auto Ganging Wizard window is displayed by clicking the Auto Ganging button from the window by clicked 

in action plan window. 

Even when the section is saved checking at the check box of Mixed Size in section tab, you can layout of auto 

ganging. 

 

 

Shortcut area Shows icons that allow you to switch the setting window that is displayed in the 

main area. The bright icon shows the current setting window in main are, then you 

can check the progress of setting. 

   Basic setting: Shows Basic settings window. For more information, 

see “Basic setting” 

   Print setting: Shows Print settings window. For more information, 

see “Print settings layout”. 

   Division Setting: Shows the Division Setting window. For more 

information, see. “Division Setting window”. 

   Layout Setting: Shows the layout window for Auto Ganging. For 

more information, see “Layout settings”. 

   Accessory Setting: Shows Accessory window. For more information, 

see “Accessory settings”. 

Main area Shows the setting window and preview. 

Next Shows the next setting window in main area. 

Rev Shows the previous setting window in main area. 

Apply Current settings are applied to the imposition scheme. 

OK Create the imposition scheme with the current settings. 

Shortcut area 

Main area 
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Cancel Quit creating the imposition scheme and go back the previous window. 

Help Shows the on-line manual. 

 

 For each setting window of the wizard, see their respective descriptions. 

 

 

Basic settings  

Set the basic settings of imposition scheme such as number of pages, page size, binding type. 

For Normal layout 

 

 

For Section Layout 

 

 

  

Reference 

Shortcut area 

Main area 

Shortcut area 

Main area 
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For Auto Ganging layout 

 

 

Imposition Name Allows you to enter a name for the imposition scheme to be created. 

Comments Allows you to enter comments regarding the imposition scheme. 

The comments entered here are displayed in the imposition information field of the 

Job Property window. 

Execute Auto Ganging Process 

on divided area of paper 

This is displayed only for the Auto Ganging layout. 

If you select this check box, the layout is divided and ganging is performed for 

each divided area. 

Number of pages Allows you to enter the total number of pages for the section. 

This is displayed only Normal Layout is selected. 

Page Sequence Allows you to select the page order. 

Normal: Sets the serial page order in an imposition scheme. 

Free: Allows you to set the page order freely. 

Page Sequence is not displayed for the Auto Ganging layout. 

Page Size Allows you to select a size from the pull-down list. 

This is displayed only when Normal is selected. 

Mixed Size If you select this check box, the Page Size pull-down list will be invalid. 

Use this check box to lay out signatures for different page sizes. 

The Mixed Size check box is not displayed when Auto Ganging is selected 

Binding Side Allows you to select a binding position from the pull-down list. You can select Left, 

Right or Top, for the binding position. This is displayed only Normal Layout is 

selected. 

Binding Type is not displayed when Auto Ganging is selected. 

Binding Type Allows you to select a binding type from the pull-down list. You can select, Perfect 

Bound, Perfect Bound (wrapping cover) or Saddle Stitch for the binding type. 

This is displayed only when Normal is selected. 

Jog Side is not displayed when Auto Ganging is selected. 

Jog Side Allows you to select a Jog side from the pull-down list. For the Jog Side, you can 

select Head or Foot when the binding position is Left or Right, and Left or Right 

when the binding position is Top. 

This is displayed only Normal is selected. 

Shortcut area 

Main area 
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Creep setting Select the Creep setting check box to run creep processing to compensate for the 

thickness of the paper when the signatures are bound. 

If you fill in each creep value text box, the value entered is reflected in the preview. 

 

• Setting 

Bind Side Only: Runs creep processing in the spine/face direction. 

Bind Side And Jog Edge: Runs creep processing in both the spine/face direction 

and jog side direction. 

Creep processing in the jog side direction is effective only when Paper Thickness 

Automatically is selected for Creep Amount. 

• Direction: Allows you to select a direction from the pull-down list. You can select 

Spine or Face for the direction. 

• Creep Amount 

Select Paper Thickness Automatically or Specify Value. 

When Paper Thickness Automatically is selected, the values for Initial creep and 

Total distance are automatically calculated from the paper thickness. 

• Initial creep: Shows the position to which the pages in that signature are shifted, 

including the amount of shift from the first signature (outside). 

• Initial position: Allows you to set a value for adjusting the offset from the start 

position with respect to the initial creep. 

• Total distance: Allows you to set a value for the amount of shift up to the last 

signature (inside) from the first signature (outside) with a start position. 

• Method 

Select Shift Position or Size Magnification. When you set a scaling percentage or 

correct page positioning, jaggies will be reduced in the images laid out using 

both the left and right sides of the spread page. 

This is displayed only when Normal is selected. 

Use Tumble pages and Both 

side front pages setting 

Select Set tumble pages and both side front pages check box to create both side 

front pages setting. 

• Divide page: Allows you to specify a divide position (top page of the second half 

to be divided). 

• Reverse the page order since divide page: Allows you to reverse the order of 

pages from the divide page to the end page. 

If you select this check box, the preview is displayed as shown below. 

 

• Tumble pages since divide page: Allows you to tumble pages from the divide 

page to the end page 

If you select this check box, the preview is displayed as shown below. 
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This is displayed only when Normal is selected. 

 

Print setting  

Set the print setting such as plate size, sheet size, printing style. 

 

 

Print 

Printing Method Allows you to select the printing method from the two options in the pull-down list 

(POD, and Do not specify a device). 

The setting items vary depending on the selected printing method. 

The Do not specify a device option cannot be set for Section Layout. 

When the imposition scheme has been created from a job/job template, the 

printing method is fixed in accordance with the target device, and it is not changed. 

Printing Style When you select the POD option from the printing method pull-down list, you can 

select Single Side, Turn, or Tumble. 

When you select the Do not specify a device option, you can select Single Side or 

Both Side. 

When the imposition scheme has been created from a job/job template, the 

options are automatically filtered in accordance with the device 
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Media 

Sheet Set for a sheet. You can select the registered sheet information from the Sheet 

Information pull-down menu. 

• Size: Allows you to select the preset size from the pull-down list. Select Vertical or 

Horizontal using the button. 

• Width: Set the width of the sheet. 

• Height: Set the height of the sheet. 

• Gripper Width: Set the gripper width. 

• Sheet Grain Direction: Allows you to select a sheet grain direction, Vertical or 

Horizontal. 

When the imposition scheme has been created from a job, the items displayed and 

items for which the inputs are restricted are automatically switched for the target 

device accordingly. 

  Click this button to display the Sheet Information window. 

 

You can enter each setting value to create new sheet 

information. 

The sheet information created here is added as an option in 

the pulldown list. 

  Deletes the selected sheet information from the pull-down list. 

Fold Layout Area Bleed(s) Allows you to set the width of the bleed for the fold layout area. 

You can make separate bleed settings in Left, Right, Top, and Bottom. 

The bleed value set here is added as an option in the pull-down list. 

Margin(s) Allows you to set the prepress margins. 

You can make separate prepress margin settings in Left, Right, Top, and Bottom. 

The prepress margin set here is added as an option in the pull-down list. 

The area set here will be used as an output area when outputting on the film. 

 

 

Layout Ref.Pt 

Allocate Reference Allows you to set the layout origin for printing. 

Allows you to select from Finished, Finished+PageMargin for the layout origin. 

This is not displayed if Do not specify a device is selected for Printing Method. 

Layout Origin You can select Center, Bottom Center, Upper Left, or Lower Left in the pull-down 

list. Note that Upper Left and Lower Left can be selected only when the Section 

Layout imposition scheme is created. 

This is not displayed if Do not specify a device is selected for Printing Method. 

Offset Allows you to set the offset value from Sheet Layout Base Point. 

This is not displayed if Do not specify a device is selected for Printing Method. 
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 If you change the layout origin after saving the imposition scheme, click  to release the lock. 

After the change, all folds are relocated according to the new Sheet Layout Base Point. 

 

Division Setting window 

The division setting is performed only when the Execute Auto Ganging Process on divided area of paper check box is 

selected. In this window, you can make settings for dividing the paper into specific pieces and performing ganging of 

each divided area. 

 

 

Divide Line Shows the divide position(s) on the paper. 

  Click this button to display the Divide Line Setting dialog box. 

 

Set the divide direction, divide position, and divide line width 

(the area in which a signature cannot be positioned), and 

then click the OK button. 

  Allows you to edit the divide line that has already been set. 

  Deletes the selected divide line. 

Note 
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Divide Area Shows the information about the areas divided by the divide line. 

  Sets the selected area as a reference area. Ganging is 

performed in order from the reference area. 

  Allows you to change the divide area name. 

 

Layout settings  

The layout pane is used to set up an imposition layout. 

It is also possible to create layouts of the pages with different sizes or different orientations. 

 

 • The pane does not support the arrangement of multiple impositions, such as stickers, or 

impositions used for paper packages. 

• The pane also does not support the arrangement of any signature with angles other 

than 0, 90, 180, and 270 degrees. 

 

For Normal Layout 

Click the Layout button to display the list of the fold catalogs. 

Drag and drop a page cell in the work area to specify the cell arrangement. This filters the fold catalogs and lists only 

the available ones on the left. Double-click a fold catalog from the list to open the corresponding signature in the work 

area. 

It is also possible to open a signature in the work area by dragging the selected fold catalog directly from the list. 

 

 The signature is properly rotated in the preview area in accordance with the grain direction. 

 

 

Important 

Note 
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Page Size Allows you to select a size from the pull-down list. 

• Horizontal: Allows you to set the page width. 

• Vertical: Allows you to set the page height. 

 

 Click this button to display the page setting window. Set the page 

margin and bleed values in this window as necessary. 

Clipping the overlap area of 

folds 

Allows you to clip the bleeds and page margins when signatures are arranged with 

their bleeds and page margins overlapped. 

• When this check box is selected: Clips the page margins. 

• When this check box is deselected: Does not clip the page margins. 

 

 

 

 

 

Use this check box when you create a step and repeat imposition for single cut. 

Show Allows you to select the filtering condition for the signature list from the pull-down 

list. 

• All: The fold catalogs in the list are not filtered and all normal section signatures 

are displayed. 

• the History: Shows the history of fold catalogs that have been used. 

• the Filtering: Shows a list of fold catalogs with the number of page arrangements 

specified in Horizontal and Vertical. 

Fold Catalog List Shows the list of the fold catalog. 

The first page is allocated on 

the front 

Select this check box to lay out the surface containing the first page as the front 

side. 

Fold Line Positions the signature by setting all the spine and face settings of the signature to 

“0”. 

Gap Setting Allows you to select a setting method for the gap from the pull-down list. The gap 

setting options are Width and Center Distance. The gap setting options are Width 

and Center Distance. The gap setting is available only when the automatic layout 

mode is selected. 

 

 

Pages arranged with a 0 

mm gap between them 
Display and output result Bleed and page margin 
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Fold Catalog Manager 

Allows you to manage Fold Catalog, such as listing the existing catalogs, creating, editing, coping, deleting. There 

are three kinds (JDF defined, Built-in, Custom) of Fold Catalog. They are shown separately in the list. Fold Catalog 

Editor is started up to create new one and edit the existing one. 

 

 

Tool Bar The following icons are displayed in the toolbar. 

  Starts Fold Catalog Editor, and allows you to create a new fold catalog. 

For more information, see “Fold Catalog Editor”. 

  Allows you to edit a fold catalog. 

  Deletes a fold catalog. 

  Copies a fold catalog. The fold catalogs in the JDF defined and Built-in lists 

are copied into the Custom list. 

  Allows you to change the name of a fold catalog. 

Fold catalog view Shows JDF-defined, Built-in and Custom (user-created) fold catalog. JDF-defined 

and build-in catalog can not be edited and deleted 

• Fold Catalog Name: Shows the fold catalog name. 

• Fold Type: Shows the fold catalog type. There are three kinds (Sheet fed and 

Web, Sheet fed, Web) of Fold Catalog. 

• Page Number Up: Shows Page Number Up. 

• Total page numbers: Show the total page numbers including both front and back. 

• Modified date: Shows modified date. 

• Comment: Allows you to change the name of a fold catalog. 

Close Close Fold Catalog Manager Window. 

Help Shows the on-line manual. 

Fold Catalog Shows a description of the fold catalogs defined by CIP4 as well those included as 

standard. 
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Editing layouts 

You can edit layouts using the icons on the toolbar for the layout display area in the layout setting window. 

 

 
 

 Switches to the mode that arranges the signature. 

If you select a signature in the list and then drag and drop the signature, the signature is arranged. 

 Shortcut Windows : [Ctrl] + D 

 Macintosh : [Control] + D 

 Moves the selected signature. A signature can be moved by dragging it to a specific location or 

by entering the position values (coordinates) via the modeless dialog box. 

 Shortcut Windows : [Ctrl] + M 

 Macintosh : [Control] + M 

 Rotates the selected signature 90 degrees counterclockwise. 

If you click this icon four times, the rotation angle returns to the original. 

 Shortcut Windows : [Ctrl] + L 

 Macintosh : [Control] + L 

 Rotates the selected signature 180 degrees. 

• Shortcut Windows : [Ctrl] + T 

 Macintosh : [Control] + T 

 Rotates the selected signature 90 degrees clockwise. 

If you click this icon four times, the rotation angle returns to the original. 

 • Shortcut Windows : [Ctrl] + R 

 Macintosh : [Control] + R 

 Switches front and back of the selected signature. 

 • Shortcut Windows : [Ctrl] + F 

 Macintosh : [Control] + F 
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 Copies the selected signature. 

When arranging the signature between sections, simply copy it in position. 

When arranging a fold catalog, you can copy it and set the page number. 

 • Shortcut Windows : [Ctrl] + S 

 Macintosh : [Control] + S 

 Allows you to set the gap between the selected signatures. 

 • Shortcut Windows : [Ctrl] + G 

 Macintosh : [Control] + G 

 Allows you to change the signature number of the selected signature. 

 Allows you to set “0” for all the spin and face settings of the selected signature. 

 Allows you to create page settings for the selected signature. 

When arranging a signature between sections, you can set PageMargin & Bleed(s), Page 

Margin(s), Milling width, and Over fold. 

When arranging a fold catalog, you can set Page Size, PageMargin & Bleed(s), Page Margin(s), 

Milling width, and Over fold. 

 • Shortcut Windows : [Ctrl] + P 

 Macintosh : [Control] + P 

 Deletes the selected signature from the layout display area. 

 • Shortcut Delete 

 Undoes the edits. 

 • Shortcut Windows : [Ctrl] + Z 

 Macintosh : [Control] + Z 

 Redoes the edits (Undo). 

 • Shortcut Windows : [Ctrl] + Y 

 Macintosh : [Control] + Y 

   Switches the mode. 

When auto mode is ON, the button is displayed.  

When auto mode is OFF, the button is displayed.  

Clicking this button does not adjust the layout. Positioning is adjusted automatically when this 

button is ON. 

• Automatic positioning is not executed while the button is OFF. 

 • Shortcut Windows : [Ctrl] + W 

 Macintosh : [Control] + W 
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Work Area 

For Normal layout 

 

 
 

Signature preview area Shows a preview of the signature laid out based on the fold catalog. You can 

perform the following operations in the signature preview area. 

Preview selection Switches the preview mode. 

  The preview window is split into left and right panes, 

showing the front and back sides in each pane. 

  The preview window is split into top and bottom panes, 

showing the front and back sides in each pane. 

  The preview window shows the front side only. 

  The preview window shows the back side only. 

Preview display operation  You can select to display or hide the rulers in the preview 

area by clicking it. 

  You can select to display or hide the Dimension in the 

preview area by clicking it. 

  You can select to display or hide the page cells in the 

preview area by clicking it. 

  The distance between two points that are clicked using a 

mouse is displayed in the preview area. 

  Allows you to set the page dragged with the mouse as the 

page for which to make property settings. 

  Updates the display area created by dragging the mouse. 

  Redisplays the current display at 110%, from a center point 

clicked with the mouse. 
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  Redisplays the current display at 90%, from a center point 

clicked with the mouse. 

  Click the pull-down list to select a display magnification for 

the signature preview area from the displayed list. 

  Automatically adjusts the display magnification so the 

preview can fit in the window. 

 

Layout mode 

When the automatic layout mode is selected, a finished layout of all signatures or a virtual bounding rectangle of the 

signature layout including page margins is automatically aligned to the offset position from the layout origin. 

For example, when Bottom Center is selected for Allocate Reference under Layout Origin in the Print setting window, if 

a signature is added as shown on the left below, the bottom center of the virtual bounding rectangle is automatically 

aligned to the offset position from the Bottom Center layout origin as shown on the right below. 

 

 

                

 

 

 

Snapping 

When a signature is inserted or moved, it is automatically aligned to the signatures that have already been positioned. 

The signature is snapped to the reference lines as follows. 

 

● When you drag the mouse while holding down the Ctrl key: 

The lines that run along each side (top, bottom, left, right), each corner, and each center of the finished signature 

layout 

 

 

 

Virtual bounding 

rectangle 

Additional signature 

Positioned data 

The blue dotted lines represent the reference 

lines for snapping 
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● When you drag the mouse: 

The lines that run along each side (top, bottom, left, right), each corner, and each center of the signature layout 

including page margins 

 

 

 

Ruler tool 

The distance between two points that are clicked using a mouse is displayed in the preview area. The layout of the 

dimension display can be printed. It is displayed in all imposition scheme layout types (Normal and Section Layout). 

 

● Click the measurement start point, and then move the mouse to the end point. A blue arrow is 

displayed until the end point is set. Normally, the start and end points snap to the signature 

and accessory that are arranged. Clicking the end point displays the measurement section and 

its distance. 

 

 

 

 The measured dimension display is deleted when the tool is switched to another tool such 

as the enlarged display tool. 

 

Important 

The blue dotted lines represent the 

reference lines for snapping 
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 • In the measurement mode, the distance between two points can be measured sequentially. 

• By using the following keys, the measurement point can be deleted or the snap to position can be 

switched. 

Esc + right-click: Cancels the start point that is being measured. 

Ctrl + mouse movement: Snaps to the finish frame of the signature. 

Shift + mouse movement: The snap to point moves laterally and vertically only. 

Alt + mouse movement: Snaps to the reference points (9 points) of the signature and accessory. 

 

Auto Ganging layout window  

Make settings for the automatic layout. In the Ganging layout window, a simple layout rule can be set for leaves, such 

as fliers, whose sizes and numbers of copies are not uniform. With the ganging layout, it is possible to create an 

imposition automatically based on the sheet type, number of sheets, or cutting of sheets. 

It is also possible to divide the area for ganging, change the list of signatures to be positioned on the layout and the 

layout rule, and position the signatures while checking the layout result in the window. 

 

 

Fold List Shows a list of signatures to be positioned in the layout. 

When the contents have already been input, all input pages are listed. 

 Import Allows you to import the list of signatures from a CSV file. 

Clicking this button displays the File Select window, and 

imports the selected CSV file as a list of signatures. 

  Click this button to show the new layout window allowing 

you to add new signatures to be positioned in the layout. 

  Allows you to select the divide area to which the selected 

signature is to be positioned. 

  Select a signature in the layout from the list and click this 

button to edit the selected signature. 

  Select a signature in the layout from the list and click this 

button to delete the selected signature from the list. 

  Shows the information about signatures positioned in the 

layout. 

Note 
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Ganging Rule Pages (Folds) 

arrangement 

according to grain 

direction 

Positions signatures in accordance with the grain direction. 

 Current Grain 

Direction 

Show the grain direction using icons. 

 Arrangement Style Allows you to select Optimum Arrangement, Same Page 

(Fold) Arrangement Individually, Same Page (Fold) 

Arrangement Horizontally, or Same Page (Fold) 

Arrangement Vertically. 

 Gap Mode Allows you to select the gap between signatures in the layout 

from the pull-down list. 

 Layer Allows you to select Finished or Finished + Margin for the 

layout standard. When selecting Finished + Margin, set the 

margin sizes. 

 Division 

Arrangement 

Allows you to set the number into which a signature is 

divided for layout. 

Ganging Fold Information Shows the information set for the signatures or pages to be positioned in the layout. 

When ganging is performed using input data, a thumbnail of the input data is 

displayed. 

 

 When ganging is performed using the contents that have already been input, the contents are listed 

in pager order of the contents displayed in the file management window. The order in the list can be 

changed by arranging the page order in the file management window in advance. 

 

  

Note 
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Work Area 

Signature preview area Shows a preview of the signature laid out based on the fold catalog. You can 

perform the following operations in the signature preview area. 

Preview selection Switches the preview mode. 

  The preview window is split into left and right panes, 

showing the front and back sides in each pane. 

  The preview window is split into top and bottom panes, 

showing the front and back sides in each pane. 

  The preview window shows the front side only. 

  The preview window shows the back side only. 

Preview display operation  You can select to display or hide the rulers in the preview 

area by clicking it. 

  You can select to display or hide the Dimension in the 

preview area by clicking it. 

  Updates the display area created by dragging the mouse. 

  Redisplays the current display at 110%, from a center point 

clicked with the mouse. 

  Redisplays the current display at 90%, from a center point 

clicked with the mouse. 

  Click the pull-down list to select a display magnification for 

the signature preview area from the displayed list. 

  Automatically adjusts the display magnification so the 

preview can fit in the window. 

 

Add Fold 

When you select Ganging Fold List in the new Auto Ganging wizard window and then click the  or  icon, 

the signature editing window is displayed. 

Click the Repeat Registration button, the signature will be a added to the list of signatures continuously. 

In the Add Fold window, you can select the Page, Fold catalog, or Print tab and make settings in each tab window. 

The signatures edited in the Add Fold window will be added to the list of signatures. 
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Page setting 

 

 

Page Size Allows you to select a page size from the pull-down list. 

The selected page size values are displayed in Width and Height. 

For a custom size, enter values in Width and Height. 

Page Margin & Bleed (s) • History: Shows a pull-down list of the page margin and bleed values that have 

already been used. 

• Bleed(s): Allows you to set bleed values. You can make separate bleed settings in 

Spine, Face, Top, and Bottom. 

• Page Margin(s): Allows you to set page margin values. You can make separate 

page margin settings in Spine, Face, Top, and Bottom. 

Other • Milling width: Allows you to specify the milling width. The milling width is the 

margin. 

• Over fold: Allows you to select a position from the pull-down list and enter a 

width. 

Folio Number Allows you to enter a prefix value for folio marks. If the value is not specified, the 

number is automatically assigned using the number shown in the list of signatures to 

be positioned in the layout. 
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Fold catalog 

 

 

Show Allows you to select the filtering condition for the signature list from the pull-down 

list. 

• [All]: The signatures in the list are not filtered and all fold catalogs are displayed. 

• [the History]: Shows the history of fold catalogs that have been used. 

• [the Filtering]: Shows a list of filtered fold catalogs with the number of page 

arrangements specified in Horizontal and Vertical. 

Fold Catalog List Shows the fold catalog list. 
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Print 

 

 

Print Circulation Allows you to enter the number of copies for final printing. 

 

Accessory settings  

The following describes the accessory settings for the signature (fold), fold layout area and sheet. 

The accessory settings include the accessory setting mode and the accessory editing mode, which can be switched 

using the menu. 

 

In the accessory setting mode, you can set the operation by selecting or deselecting the target check box (Fold, Fold 

Layout Area or Sheet). 

It is also possible to make settings by selecting one of the accessory presets that have been registered in advance. 

In the accessory editing mode, you can delete the register marks and accessories separately as well as change the 

order for positioning the accessories. 

It is also possible to add spine marks or a register mark to a signature. 

 

 An accessory preset refers to the accessory setting information for the signature (fold), fold layout 

area or sheet. Once you have registered accessory presets for each printer or each work, you can 

position all the necessary accessories at the same time simply by selecting a target accessory preset. 

 

 You cannot set accessories separately in the layout window when Auto Ganging is 

selected. 

To edit accessories separately, complete editing in the Auto Ganging wizard, access the 

accessory setting window in the Normal layout mode, and then edit the accessories 

separately. 

 

Note 

Important 
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Accessory settings 

Accessory settings window 

For Fold 
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For Fold Layout Area 

 

 

For Sheet 

 

 

Apply Accessory Preset Click this button to change to the show preset display window. For more 

information, see “Show preset display window”. 

Save Accessory Preset Click this button to save the settings you made in the Accessory setting window as 

an accessory preset. 

Apply to All Folds Select this check box to apply the settings to all arranged signatures. 

Deselect this check box to apply the settings to the selected signature only. If no 

signature is selected, nothing is applied. 
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Register Mark Select this check box to place register marks. 

You can switch whether or not each type of register mark is placed by selecting the 

check boxes. 

The Register Mark setting is available in both the For Fold and For Fold Layout Area 

panes. The register marks that can be set in each pane are as follows. 

 

• In the For Fold pane 

Corner 

Fold Center 

Spread/Spine 

Spread/Face 

Page Center 

Cross 

 

• In the For Fold Layout Area pane. 

Corner 

Spread/Spine 

Cross 

Center 

 Type Shows the register mark type. 

 Line Width Shows the register mark line weight. 

 Width Show the register mark width. 

 Height Show the register mark height. 

 File Name Shows the register mark file name. 

 When you select a register mark on the list, the Property window is displayed. 

 

 File Name Shows the register mark file name. Click the Browse button to 

show the Register Mark Manager window, allowing you to 

modify the register mark file. 

 Width Allows you to specify the register mark width. 

 Height Allows you to specify the register mark height. 

 Line Width Allows you to specify the register mark line width. 

Spine Mark Select this check box to place spine marks. 

You can switch whether or not each type of spine mark is placed by selecting the 

check boxes. 

By default, the spine mark check boxes are selected for perfect binding and not 

selected for saddle-stitching. 

The Spine Mark setting is available in the For Fold pane only. This setting is 

available only for Normal. 

 Type Show the spine mark type. 
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 File Name Show the spine mark file name or search file name. 

 When you select a spine mark on the list, the Property window is displayed. 

 

Folio Mark Select this check box to place folio marks. 

The Folio Mark setting is available in the For Fold pane only. 

This setting is available only for Normal. 

 Rotation Angle Allows you to select a rotation angle for the folio mark from 

the pull-down list. 

 Ref.Point Allows you to set the position for the folio mark. 

 

 Offset Allows you to set the offset value for the folio mark. 

 Area Setting Allows you to specify the size of the area for folio mark 

output. 

 White Cushion Select this check box to make a white cushion under the folio 

mark. 

 Font Name Allows you to select the font name for the folio mark from the 

pull-down list. 

 Size Allows you to select the font size for the folio mark from the 

pull-down list. 

 Color Allows you to specify a color for the folio mark. You can 

select [ALL] or [CMYK]. When [ALL] is selected, you can 

specify the concentration value for all colors. [CMYK] is for 

individual colors. 

Information Mark Select this check box to place the registered information mark. The Information 

Mark setting is available in all reference panes. 

  Click this button to show the Information Mark window, 

allowing you to set the information mark to be output. 

  Select a color bar and click this button to delete the color bar 

from the list. 

Object 

Folio mark image 
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 When you select an information mark on the list, the Property window is displayed. 

 

 File Name Shows the information mark file name. When you click the 

Browse button, the Information Mark Manager window is 

displayed, allowing you to modify the information mark file. 

 Preview Shows the preview of the information mark file selected in 

File Name. 

 Information Shows the settings and size of the information mark file 

selected in File Name. 

 Ref. Point Allows you to specify a position to place the information 

mark. 

 Rotation Angle Allows you to select a rotation angle for the information mark 

from the pull-down list. 

 Side and Alignment Allows you to specify the side to place the information mark. 

Front only: Places the information mark. only on the front side 

of the signature. 

Back only: Places the information mark. only on the back 

side of the signature. 

Two Sided Independent: Places the information mark. on 

both the front and back sides of the signature so that the 

amount of offset from the bottom left is the same on both 

sides. 

Two Sided Back To Back: Places the information mark. on 

both the front and back sides of the signature so that the 

color bar on one side is an exact opposite of the other side. 

 Offset Allows you to specify the amount of offset from the position to 

place the information mark. 

 Output condition Allows you to specify the sheet for which the information 

marks are output from the set sheets. Select the menu from All 

Sheet, Start Sheet, End Sheet, Except for Start Sheet and 

Except for End Sheet. This setting is only available for the 

plate and the sheet. 

 Clipping Area Allows you to specify the clipping width (top, bottom, left, 

and right) of the information mark. 

Other Accessory Select this check box to place the registered other accessory. The Other Accessory 

setting is available in all reference panes. 
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  Click this button to show the Other Accessory Manager 

window, allowing you to add another accessory file. 

  Select one of the other accessories and click this button to 

delete the selected other accessory from the list. 

 When you select any other accessory on the list, the Property window is displayed. 

 

 File Name Shows another accessory file name. Click the Browse button 

to show the Other Accessory Manager window, allowing 

you to modify the other accessory file. 

- Allows you to specify a spine mark file (*.smd). 

- Width: Allows you to specify the width. 

- Height: Allows you to specify the height. 

The spine marks can be set only when Sheet is selected as a 

reference layer. 

 Preview Shows the preview of the other accessory file selected in File 

Name. 

 Information Shows the size of the other accessory file selected in File 

Name. 

 Ref. Point Allows you to specify a position to place the other accessory. 

 

 Rotation Angle Allows you to select a rotation angle for the other accessory 

from the pull-down list. 

Other accessory image 

Positioning reference image 
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 Side and Alignment Allows you to specify the side to place the other accessory. 

• Front only: Places the other accessory only on the front side 

of the signature. 

• Back only: Places the other accessory only on the back 

side of the signature. 

• Two Sided Independent: Places the other accessory on 

both the front and back sides of the signature so that the 

amount of offset from the bottom left is the same on both 

sides. 

• Two Sided Back To Back: Places the other accessory on 

both the front and back sides of the signature so that the 

color bar on one side is an exact opposite of the other 

side. 

 Offset Allows you to specify the amount of offset from the position to 

place the information mark. 

 Output condition Allows you to specify the sheet for which the information 

marks are output from the set sheets. Select the menu from All 

Sheet, Start Sheet, End Sheet, Except for Start Sheet and 

Except for End Sheet. This setting is only available for the 

plate and the sheet. 

 Clipping Area Allows you to specify the clipping width (top, bottom, left, 

and right) of the information mark. 

 

 If you change the page size for pages on which spine marks were already set in the imposition 

scheme, the spine mark size is automatically changed to match the page size. 

 

  

Note 
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Display of accessory preview 

You can preview the selected accessories in the windows for managing accessories: the Register Mark Manager 

window, Color Bar Manager window, Information Mark Manager window, and Other Accessory Manager window. 

 

 

About Accessory Manager 

 

 

New Allow you to create a new accessory file (register mark, spine mark, information 

mark or simple accessory). 

The accessory file is not able to create on the Macintosh client. 

Edit Allow you to edit an accessory file (register mark, spine mark, information mark or 

simple accessory). 

The built-in file can not be edited. 

The accessory file is not able to edit on the Macintosh client. 

Copy Allow you to copy an accessory file. 

The built-in file is reproduced by the custom folder. 

The accessory file is not able to edit on the Macintosh client. 

Delete Allow you to delete an accessory file. 

The built-in file can not be deleted. 

Rename Allow you to rename an accessory file. 

The built-in file can not be renamed. 

Import Allow you to import an color bar file or EPS/PDF accessory file. 

The EPS color bar file is not able to import on the Macintosh client. 
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 For PDF color bars or accessories, you can import only a single page color bar. 

Note that you cannot import multi-page PDFs or separation PDFs. 

 

 The function to replace output separations that is available with EPS color bars is not available with 

PDF color bars. 

 

Apply Accessory Preset 

 

 

Apply to layout Applies the selected accessory preset in the layout and then shows the Accessory 

setting window. 

Cancel Cancels the selected accessory preset display and then shows the Accessory setting 

window. 

Accessory Preset Shows a list of accessory presets registered to the system. When an accessory 

preset is selected from the list, the settings are displayed as preset data. 

  Click this button to show the Accessory Preset Manager 

window. You can create and add an accessory preset in this 

manager window. For more information about the Accessory 

Preset Manager window, see “Accessory Preset Manager 
window”. 

Preset data Shows the settings of the accessory preset selected in the list. Note that the settings 

cannot be edited. 

The contents of the display are the same as thee accessory settings. 

 

Note 

Note 
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Accessory Preset Manager window 

This window is used for managing accessory presets. You can list the registered accessory presets as well as create, 

edit, copy, delete, and rename an accessory preset in this window. 

 

 

Toolbar The following icons are displayed in the toolbar. 

  Allows you to create a new accessory preset file. Clicking this 

button starts the accessory preset editor. For more information, 

see “Accessory Preset Editor”. 

  Allows you to edit an accessory preset file. For more information, 

see “Accessory Preset Editor”. 

  Allows you to copy an accessory preset file. 

  Allows you to delete an accessory preset file. 

  Allows you to rename an accessory preset file. 

  Shows a list of accessory presets that include the input character 

string. 

Preset List Shows a list of registered accessory presets. 

Close Closes the Accessory Preset Manager window. 
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Editing an accessory preset 

Click the Accessory Setting icon to open the accessory setting window, and select Accessory Edit. 

The accessory editing window is displayed. 

The window shows the accessory list by default. 

 

 

Accessory positioning window 

Clicking the Add Accessory button in the accessory editing window displays the accessory positioning window. 

This window allows you to position accessories for each file. 

 

Register Mark Shows a list of register marks. When you drag and drop a register mark from the list, it 

is placed at the selected position. 

If the register mark is dropped near an attachment point of register marks, it is placed 

on the attachment point. 

The attachment points of register marks are located in positions where register marks 

such as the signature corner, spread/spine, cross, page center, and fold center are 

placed. 

Spine Mark Shows a list of spine marks. When you drag and drop a spine mark from the list, it is 

placed at the selected position. 

If a spine mark is dropped on a signature, it is placed on a spin or jog side position for 

the signature. 

Information Mark Shows a list of information marks. When you drag and drop an information mark from 

the list, it is placed at the selected position. 

Accessory Shows a list of accessories. When you drag and drop an accessory from the list, it is 

placed at the selected position. 

Simple Accessory Shows a list of simple accessories. When you drag and drop a simple accessory from 

the list, it is placed at the selected position. 
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Accessory list window 

This window shows a list of accessories that are placed. 

 

 Clicking the Add Accessory button when the accessory positioning window is displayed opens the 

accessory list window. 

 

 

 

Type Shows the accessory type. 

File Name Shows the accessory file name. 

Layers Shows the positioning layer. 

Ref Anchor Pt Shows a layout origin. 

Fold Number Shows the number of the signature for which accessories have been set. 

Side and Alignment Shows a side to place the accessories. 

 

Note 
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Editing accessories 

You can edit accessories by selecting an icon from the toolbar at the top of the accessory editing window. 

 

 

 

 Allows you to change the linking for front and back printing and positioning of the 

accessories selected in the preview area. 

The operation is performed in a Property window that is the same as the one displayed 

when the accessories are set. 

 Moves the accessories selected in the preview area. 

 Rotates the accessories selected in the preview area 90 degrees counterclockwise. 

 Rotates the accessories selected in the preview area 180 degrees. 

 Rotates the accessories selected in the preview area 90 degrees clockwise. 

 Deletes the accessories selected in the preview area. 

 Allows you to set the order to position the accessories placed on the signature. The 

positioning order is set in the Accessory Order Setting window. 

 Moves the spine mark selected in the preview area. 

Move Spine Mark This command is valid only for the spine marks placed in signatures. 

 

  Moves the spine mark to the next adjacent left 

spread/spine or jog side position. 

  Moves the spine mark to the next adjacent right 

spread/spine or jog side position. 

  Moves the spine mark to the next adjacent upper 

spread/spine or jog side position. 

  Moves the spine mark to the next adjacent lower 

spread/spine or jog side position. 

  Moves the spine mark to the other side. 

  Undoes the edits. 

  Allows you to perform editing again. 
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Changing positioning order 

 

 

Toolbar The following icons are displayed in the toolbar. 

  Moves the accessory selected in the list for the lower signature to 

the top of the list for the upper signature. 

  Moves the accessory selected in the list for the upper signature to 

the top of the list for the lower signature. 

  Moves the accessory selected in the list to the top of the 

corresponding signature layer. 

  Moves the selected accessory up one higher in the list. 

  Moves the selected accessory down one lower in the list. 

  Moves the accessory selected in the list to the bottom of the 

corresponding signature layer. 

Display upper layer list Shows a list of accessories placed in the upper signature. 

Display lower layer list Shows a list of accessories placed in the lower signature. 

Default Returns the accessory order setting to the default. 

OK Saves the accessory order setting and closes the window. 

Cancel Cancels the settings and closes the window. 
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Imposition Editor 

The Imposition Editor window is displayed after you have finished setting up a new imposition using the imposition 

scheme wizard or after you have edited an existing imposition scheme. The Imposition Editor window has two modes, 

Imposition Editor mode and Signature order mode. 

In Imposition Editor mode, you can manage signatures by adding, deleting, and copying them as well as edit 

signatures while viewing a preview. 

In Signature order mode, you can view a preview of all of the signatures with page numbers and check whether or not 

the imposition scheme was created correctly. 

 

 

 

 

 

 

Shortcut area Shows the buttons for making imposition scheme settings. 

 
 

Basic Setting: Opens the Basic Settings window for the imposition 

scheme. The settings are the same as in the Basic 

Settings window in the new imposition scheme 

wizard. 

  Signature setting: Shows Print, Layout, Accessory Setting, and 

Accessory Edit in a pull-down list, and allows you to 

open the selected setting window. The settings are 

the same as in the Basic Settings window in the new 

imposition scheme wizard. This setting is available 

only when Normal is selected. 

  Page Property: Opens the Page Property setting window for setting 

individual page properties. For more information, 

see “Page Property settings”. This setting is 
available for all imposition scheme layout types 

(Normal, Section Layout). 

 
 

Free Page 

Sequence 

Shows the Free page sequence setting dialog box. 

For more information, see “Free page sequence 

setting”. 

  Switches to Imposition Editor mode. 

Detailed information area Error message area 

Signature preview area 

Signature order area 

Shortcut area 
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  Switches to Signature order mode. 

You cannot edit an imposition scheme in this mode. 

You cannot select this if other setting windows are open, so close all of the 

setting windows, and then use this mode. 

Signature order area For Normal layout 

• No: Shows the numbers that were assigned, in the order in which they were set. 

• Fold catalog: Shows the fold catalog name that was set. 

• Set: Shows the number of duplicate signatures. You can click this to change the 

number of duplicate signatures. 

Use the icon buttons at the top of the signature order area to change the signature 

order. 

 

For Section Layout 

• No: Shows the numbers that were assigned, in the order in which they were set. 

• Sheet name: Shows the sheet name of the print surface. 

  Adds a new signature. Click this to display the New Sheet Wizard. 

This setting is available for all imposition scheme layout types 

(Normal, Fold Catalog Layout, and Section Layout). 

  Copies the signature selected in the signature order area. The 

copied signature is displayed at the bottom of the signature order 

area. This operation is available only when Normal Layout is 

selected. 

  Deletes the signature selected in the signature order area. This 

setting is available for all imposition scheme layout types (Normal, 

and Section Layout). 

  Increases and decreases the number of signatures selected in the 

signature order area automatically. This setting is available only 

when Normal is selected. 

  Cancels the setting that automatically increases and decreases the 

number of signatures. This setting is available only when Normal is 

selected. 

  Moves the display order of the signature selected in the signature 

area up one. This operation is available only when Normal Layout 

is selected. 

  Moves the display order of the signature selected in the signature 

area down one. This operation is available only when Normal 

Layout is selected. 

 Shows the status of the imposition schemes in a list using four types of icons. This 

setting is available for all imposition scheme layout types (Normal and Section 

Layout). 
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  Indicates that the signature cannot be saved as an imposition 

scheme. This setting is available for all imposition scheme layout 

types (Normal, and Section Layout). 

  Indicates that the signature can be saved as an imposition scheme, 

but that there is a problem with the layout. This setting is available 

for all imposition scheme layout types (Normal, Layout, and 

Section Layout). 

  Indicates that there is a signature being edited using Imposition 

Editor mode. This setting is available for all imposition scheme 

layout types (Normal Layout). 

  Indicates that the setting to increase and decrease the number of 

signatures automatically is set. This setting is available only when 

Normal is selected. 

Signature preview area Shows a preview of the signature selected in the signature order area. You can 

perform the following operations in the signature preview area. 

  Shows the previous signature when there is a double fold. This 

setting is available only when Normal is selected. 

  Moves to the selected signature. 

  Shows the next signature when there is a double fold. This setting is 

available only when Normal is selected. 

  Allows you to set the page dragged with the mouse as the page 

for which to make property settings. This setting is available for all 

imposition scheme layout types (Normal and Section Layout). 

  Updates the display area created by dragging the mouse. This 

setting is available for all imposition scheme layout types (Normal 

and Section Layout). 

  Redisplays the current display at 110%, from a center point 

clicked with the mouse. This setting is available for all imposition 

scheme layout types (Normal and Section Layout). 

  Redisplays the current display at 90%, from a center point clicked 

with the mouse. This setting is available for all imposition scheme 

layout types (Normal and Section Layout). 

  Click the pull-down list to select a display magnification for the 

signature preview area from the displayed list. This setting is 

available for all imposition scheme layout types (Normal and 

Section Layout). 

  Click this button to show dimensions in the preview window. 

  Click this button to show dimensions in the preview window. 

Preview selection Switches the preview mode. 

This is displayed for all of the Normal and Section Layout types. 

  The preview window is split into left and right panes, showing the 

front and back sides in each pane. 

  The preview window is split into top and bottom panes, showing 

the front and back sides in each pane. 
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  The preview window shows the front side only. 

  The preview window shows the back side only. 

Detailed display area Shows the settings that have been made for the imposition scheme. 

Error message area [Error / Warning Information] 

Shows errors and warnings generated while editing an imposition scheme. 

 

Signature order mode 

You can switch to Signature order mode by clicking the  mode switch button. 

This view allows you to display a simple preview that includes the page numbers in the imposition scheme (preview of 

the orientation of the sheet, and the pages as well as their relative positions) and whether or not the imposition scheme 

settings were made correctly. 

 

 

No. Shows the sequential number of the imposition scheme. 

Fold catalog Shows the fold catalog name set in the imposition scheme. 

Front Shows a simple preview of the front sheet (sheet and page layout). 

Back Shows a simple preview of the back sheet (sheet and page layout). 

Setting Information Shows the plate size and the paper size. 

Print Signature Order The content of the imposition scheme progress is printed on the printer. 

 

 Note that you cannot edit the imposition scheme when you are in this mode. 

 

Important 
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Page Property settings 

Click  to display the Page Property window. In the Page Property window, you can individually change the 

settings made for the page selected in the signature preview area. When you confirm a setting by moving to the input 

area of another setting or clicking the mouse in another part of the window, it is applied to the preview. 

 

 

Basic Allows you to change the basic settings for the page. 

• Page No: Shows the number of the page on the sheet. 

• Page No in Signature: Allows you to set the page numbers within the fold catalog that 

was positioned on the sheet. You can set the same page number for multiple pages, but 

you cannot make changes that omit page numbers. Page numbers start on page 1 for 

each fold catalog. 

• Width: Allows you to set the page width. 

• Height: Allows you to set the page height. 

• Angel: You can select 0 (0 deg.) or 180 (180 deg). 

Page Margin(s) Allows you to set the margins around the page. The page margin includes the bleed. You 

can make separate margin settings in Spine, Face, Top, and Bottom. 

Bleed Allows you to set the bleed surrounding the page. You can make separate bleed settings in 

Spine, Face, Top, and Bottom. 

Other • Milling width: Allows you to specify the milling width. The milling width is the margin 

added to the spine area between the pages in addition to the bleed and page margin. 

• Over fold: Allows you to set the over fold width. 

 

 The Basic setting options cannot be set for Section Layout. 

 

 • If the number of duplicate signatures is set in the signature order list, the page property 

settings are applied to all of the pages in the same positions in the duplicate signatures. 

• When the Normal Layout is selected, if you apply the page property settings to one of 

the copied signatures in the layout, the page property settings will be applied to all of 

the copied signatures. 

 

Note 

Important 
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Affected area for page property changes 

For the convenience of stacking and folding, there are times when the settings for other related pages also change 

due to page property changes. The relationships between settings and affected pages are shown below. 

 

Setting Related Page 

Page width Width of pages positioned vertically on the changed pages 

Page height Height of pages positioned horizontally on the changed pages 

Bleed/page margin Top and Bottom values Settings for pages positioned horizontally on the changed pages 

Bleed/page margin Face and Spine values Settings for pages positioned vertically on the changed pages 

Milling width Milling width for pages positioned vertically on the changed pages 

Over fold width Over fold width of pages positioned vertically on the changed pages 

 

Dimension display 

If you click  in the signature preview area of the Imposition Editor window, the dimensions for the signature 

displayed in the preview area are displayed. 

 

 

Print Signature order 

When you switch to the imposition scheme list view, the Print Signature order button becomes active and you can print 

the imposition scheme list. 

 

Print Signature order Layout 

When you switch to the signature view, the Print Signature order Layout button becomes active and you can print the 

signatures that are displayed, or all signatures. 
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Free page sequence 

Click  to display the Free Page Sequence window. In the Free Page Sequence window, you can change the 

signature selected in the work area as well as the page number setting. Click the Apply button to apply the value set. 

 

 

Change page progress Select this check box to enable the change of the pagination style. 

 Set same page number for all 

pages 

Assigns a specified number to all selected pages. 

 Rise and fall all page numbers Adds a specified value to the page numbers of all 

selected pages. If a negative value is specified, the 

specified value is subtracted. 

 Set sequential page number in 

specified direction 

Assigns consecutive page numbers based on the start 

page number and page assignment order. 

 Set each page numbers Allows you to specify the changed page number for 

each selected page number. 

Change page directions Allows you to change the page orientation. 

Apply Applies the settings to the selected pages/signatures. 
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6. Imposition Parts 

This chapter describes the objects to be laid out in imposition schemes and how to create and edit each object. 

 

 

Accessory Preset Editor 

Accessory Preset Editor allows you to create and edit an accessory preset that preserves only the accessory 

arrangement setting information for the signature (fold), fold layout area, or sheet. 

 

 Since an accessory preset does not contain information about the size and fold catalog type for the 

signature (fold), fold layout area or sheet, it is not necessary to register an individual accessory 

preset for each size or fold catalog. 

Therefore, once you have registered the necessary accessories for each printer or job as an 

accessory preset, you can perform a plate surface layout when creating an imposition scheme 

simply by selecting the target accessory preset. 

 

Accessory Preset Editor window layout 

Accessory Preset Editor is comprised of multiple panes. 

These panes are separated by split bars. You can change the size of each pane by moving the split bars. 

 

 

 

 

 The split bar is the frame that separates the window into several panes. You can change the 

proportions of the different panes by moving the split bars. 

 

Note 

Note 

Setting panel Preview area 
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Accessory Preset Name Shows the name of the accessory preset to be created. 

Comments Allows you to enter comments regarding the accessory preset. 

The comments entered here are displayed in the comment field in the Accessory 

Preset Editor window. 

Printing Style Allows you to select Single Side, Turn, or Tumble. 

Setting panel Allows you to make an accessory arrangement setting for the signature (fold), fold 

layout area and sheet. For more information, see “Setting panel”. 

Preview area Shows a simulation layout of the set accessories. 

OK Saves the edits and closes the Accessory Preset Editor window. 

Cancel Cancels the edits and closes the Accessory Preset Editor window. 

 

Setting panel  

Simulation layout Select an imposition scheme layout to be simulated when the accessory 

arrangement setting is applied from the list and click the Simulate button. The 

preview area shows the simulation result of accessory arrangement using the 

selected imposition scheme layout. 

 Sim_Normal_000 Layout in which one signature is positioned 

 

 Sim_Normal_090 Layout in which one signature is positioned after 

being rotated 90 degrees 

 

 Sim_Normal_180 Layout in which one signature is positioned after 

being rotated 180 degrees 
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 Sim_Normal_270 Layout in which one signature is positioned after 

being rotated 270 degrees 

 

 Sim_Layout_2x1_1 Layout in which two signatures are positioned 

 

 Sim_Layout_2x1_2 Layout in which two signatures are positioned after 

being rotated 90 degrees 

 

 Sim_Layout_2x2_1 Layout in which four signatures are positioned 

 

 Sim_Layout_2x2_2 Layout in which four signatures are positioned after 

being rotated 90 degrees 

 

 Sim_StepandRepeat_1 Step and repeat arrangement of a positioned 

signature with a finish interval of 0 mm 
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 Sim_StepandRepeat_2 Step and repeat arrangement of a positioned 

signature rotated 90 degrees with a finish interval 

of 0 mm 

 

 Sim_StepandRepeat_3 Step and repeat arrangement of a positioned 

signature with a bleed interval of 0 mm 

 

 Sim_StepandRepeat_4 Step and repeat arrangement of a positioned 

signature with a bleed interval of 0 mm 

 

 Sim_Ganging_1 Step and repeat arrangement of a positioned 

signature rotated 90 degrees with a bleed interval 

of 0 mm 

 

 Sim_Ganging_2 Layout of signatures for different page sizes 

 

Register Mark Select this check box to place register marks. 

For more information, see “Accessory settings”. 

Spine Mark Select this check box to place spine marks. 

For more information, see “Accessory settings”. 

Folio Mark Select this check box to place folio marks. 

For more information, see “Accessory settings”. 

Information Mark Select this check box to place the registered information mark. 

For more information, see “Accessory settings”. 

Other Accessory Select this check box to place the registered other accessory. 

For more information, see “Accessory settings”. 
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Preview area 

Preview selection Preview selection 

 The preview window is split into left and right panes, showing the front and back 

sides in each pane. 

 The preview window is split into top and bottom panes, showing the front and back 

sides in each pane. 

 The preview window shows the front side only. 

 The preview window shows the back side only. 

 Allows you to show/hide the rulers in the preview area. 

 Displays the position and size of accessories. 

 Selects the accessory clicked with the mouse. 

 Updates the display area of the page in accordance with the mouse drag. 

 
Redisplays the current display at 110%, from a center point clicked with the mouse. 

 Redisplays the current display at 90%, from a center point clicked with the mouse. 

 Click on the pull-down list to select from the displayed list a display magnification 

for the preview area. 

 Automatically adjusts the display magnification so the preview can fit in the 

window. 

 

Starting up Accessory Preset Editor 

Start up Accessory Preset Editor using the TotalFlow Simply Prepress Client application. You can create a new 

accessory preset and edit it by using Accessory Preset Editor. However, an accessory preset cannot be edited from 

multiple clients at the same time. Therefore, if you open an accessory preset that is already being edited, the accessory 

preset is displayed in a view only mode. 
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Creating a new accessory preset 

Follow the steps below to create a new accessory preset. 

 
 

1. Click  in the Accessory Preset Manager window to create an imposition scheme in the TotalFlow 

Simply Prepress Client. 

 

2. When the window to enter a new accessory preset name is displayed, enter the name of the accessory 

preset to be created and click the OK button. 

 

 

3. Accessory Preset Editor starts. 

 

Editing an accessory preset 

Follow the steps below to edit an accessory preset. 

 
 

1. Click  in the Accessory Preset Manager window to create an imposition scheme in the TotalFlow 

Simply Prepress Client to start up Accessory Preset Editor. 

 

2. Accessory Preset Editor starts. 

 

Creating an accessory preset 

Follow the steps below to create an accessory preset. 

This section describes how to create an accessory preset depending on the printer. 

 
 

1. Enter your comment and set the printing style. 

 

2. Select the Sheet tab and set the accessory to be arranged for a sheet. 

 

3. Select the imposition scheme layout to be simulated in the simulation layout and click the Simulate 

button. 

 

4. Check the simulation result and edit the accessory arrangement setting if any problem is found. 

 

5. Save the accessory preset. 

 

 

Operation 

Operation 

Operation 
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Fold Catalog Editor 

A fold catalog indicates the folding method when sheets of paper are folded using a stacker/folder. This catalog only 

includes a folding method and does not include information for a binding type, binding direction, and finish size. 

Therefore, there is no need to register a catalog each time a different finish size and binding direction are used. When 

determining an imposition scheme, specify the information for a finish size, binding type, and total number of pages 

and add this catalog. 

The page layout and the page order are created automatically from the fold catalog. 

 

About Fold Catalog Editor 

Select a fold catalog that is fit for a pattern the customer’s stacker/folder can fold and create an imposition scheme. 
However, a stacker/folder may not always support folding patterns that are already registered. When no existing 

patterns are supported by the stacker/folder, a new fold catalog should be created. In this case, use Fold Catalog 

Editor to create and edit a new fold catalog. 

 

Fold catalog type 

Fold catalog are grouped into the following three types for management. 

● CIP4-defined fold catalogs 

CIP4*1 defines approximately 90 types of fold catalogs in the JDF specification. You cannot edit this type of fold 

catalogs. 

● TotalFlow Simply Prepress standard fold catalogs 

This type of fold catalogs is registered when TotalFlow Simply Prepress is installed. 

● User-defined fold catalogs 

This type of fold catalogs is created by a customer. The fold catalog created using Fold Catalog Editor are 

categorized as this type. 

 

 
*1: CIP4 stands for The International Cooperation for the Integration of Processes in Prepress, Press 

and Postpress Organization. This organization is responsible for the definition of the JDF format. 

The specifications related to JDF can be downloaded from the URL below. 

http://www.cip4.org/documents/jdf_specifications/intro.php 

<Reference specifications> 

• JDF Specification Version 1.3 

• Pagination Catalog (using the JDF Fold Catalog) 

 

 

 

Note 
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Starting up Fold Catalog Editor 

Start up Fold Catalog Editor using the TotalFlow Simply Prepress Client application. You can create a new fold 

catalogs and edit it by using Fold Catalog Editor. However, a fold catalog cannot be edited from multiple clients at 

the same time. Therefore, if you open a fold catalog that is already being edited, the fold catalog is displayed in a 

view only mode. 

 

Creating a new fold catalog 

Follow the steps below to create a new fold catalog. 

 
 

1. Click  in the Fold Catalog Manager window to create an imposition scheme in the TotalFlow 

Simply Prepress Client to start up Fold Catalog Manager. 

 

2. Enter a Fold Catalog Name to be created and click the OK button in the New Fold Catalog window 

that is displayed. 

 

 

3. Fold Catalog Editor starts up. 

 

Editing a fold catalog 

Follow the steps below to edit a fold catalog. 

 
 

1. Click  in the Fold Catalog Manager window to create an imposition scheme in the TotalFlow 

Simply Prepress Client to start up Fold Catalog Editor. 

 

2. Fold Catalog Editor starts up. 

 

 

Operation 

Operation 
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Operating a Fold Catalog Editor 

The following window is displayed when Fold Catalog Editor is started up for creating a new fold catalog. It is also 

displayed in the edit mode. 

 

 

 

Setting Items Allows you to change the Setting Area display. 

 

Basic setting Allows you to make basic settings for a fold catalog. 

  Allows you to select a type of printing method. 

Common: Used for both sheet-fed printing and 

web printing 

Sheet: Sheet-fed printing 

Web: Web printing 

  Allows you to specify a number of sheets to be 

double-folded. 

 

 

Allows you to specify a number of pages to be 

positioned vertically and horizontally on a sheet. 

Click the Apply button to confirm the basic 

information. 

Two up Binding Head to Head (Foot to Foot) Allows you to specify Head to Head (Foot to Foot) 

for a folding method. 

When Head to Head (Foot to Foot) is specified, a 

sheet is folded as follows. 

 

Preview 

Setting Items 

Setting Area 
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 Head to Foot When Head to Foot is specified, a sheet is folded 

as follows. 

 

Fold after cutting Allows you to set the signature status after cutting. 

 One signature with continuous 

page number 

Applies a single signature number to spine marks 

for signatures after sheet cutting. 

 Two signatures (1Sig, 2Sig) with 

continuous page number 

Applies consecutive signature numbers to spine 

marks for signatures after sheet cutting. 

 Double signatures with the same 

page number 

Makes two signatures with the same signature 

number after sheet cutting. 

Prohibit Saddle Stitch Select this to prohibit the saddle-stitching setting of signatures. 

Fold Setting Allows you to specify mountain fold, valley fold, cut, and rotation settings for the 

unfolded sheet. 

 

  Rotates the sheet by 90 degrees. 

  Folds the sheet using a mountain fold. 

  Folds the sheet using a valley fold. 

  Cuts the sheet. 

 Apply Restores the previous state. 

Stacking Position Allows you to specify the position when stacking sheets. 

 

  Moves the sheet to the left. 

  Moves the sheet to the right. 

  Flips the sheet. 
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Page Size Adjustment Allows you to fine-adjust each page size. 

For tri-folding, you can adjust the size of the page that is folded first so it is a little 

smaller. 

       

Note: When this setting is not specified, all the page sizes are recognized as being 

the same. 

 

 

Select the Page Size Adjustment from Setting Items. 

  Allows you to specify the adjustment width of the 

page by ratio. 

  Allows you to specify the adjustment width of the 

page by difference compared to the actual size. 

Free progress 

 

Allows you to set the page orientation and 

front-back link freely. 

Division Setting 

 

Allows you to set the dividing line used during the 

Divided Imposition output. 

It is possible to set one dividing line each in the 

horizontal and vertical directions. 

Folding Procedure 

 

Shows the figure that illustrates the procedure of 

folding, rotation or cutting the sheet. 

  Indicates that the sheet is rotated by 90 degrees. 

  Indicates that the sheet is folded using a mountain 

fold or a valley fold. 

 
 

Indicates that the sheet is cut. 

 
 

Indicates that the cut sheet is stacked. 

Reduce the width by 

several millimeters. 
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Sheet Preview 

 

Shows an expanded image of the fold catalog. 

Note: The pagination that is displayed in the 

preview simulates the conditions of left stitching with 

a folded edge at the top. 

Save OK Saves the newly created or edited fold catalog. 

 Cancel Exits Fold Catalog Editor without saving the newly 

created fold catalog or the fold catalog being 

edited. 

 

Creating a fold catalog 

The fold catalog is determined based on the postpress processing that is performed after printing. We recommend that 

you check the postpress specification and folding method prior to creating a fold catalog. 

This section describes the procedure for creating the fold catalog we generally recommend for use. 

 
 

1. Check the specifications of the postpress machines (folders/stackers and inline processing machine) 

prior to creating a fold catalog. 

 

2. Use a sample sheet and process it in the postpress machine. If you cannot use the machine, simulate 

by folding the sample sheet manually. 

 

3. Return the processed sheet to the condition when it was printed. (Unfold the folded sheet.) 

 

 

4. Start up Fold Catalog Editor and make settings for Basic Setting and Fold Setting while checking the 

process order of the unfolded sheet. Check the process order in the Step Display window. 

Adjust the page size as necessary. 

 

5. Save the fold catalog file. 

 

 

Operation 
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Register Mark/Simple Accessory Editor 

Register Mark/Simple Accessory Editor is a tool to create register marks and simple accessories that can be arranged 

into the layout of an imposition scheme. 

You can create and edit register marks or simple accessories according to the workflow with this tool. 

 

Functions of Register Mark/Simple Accessory Editor 

• You can create two types of objects, register marks and simple accessories. 

• Various objects such as straight lines, rectangles, and circles can be created according to requirements. 

• You can easily create precise objects using a function in which the object snaps to a grid. It is also possible to 

change the spacing of the grid. 

• You can freely position the register marks and simple accessories you created into imposition schemes created in 

TotalFlow Simply Prepress. 

 

Layout of the Register Mark/Simple Accessory Editor window 

Register Mark/Simple Accessory Editor has two windows. They are the main Register Mark Editor/Simple Accessory 

Editor window, where you create register marks and simple accessory objects, and a Coordinate Input window, 

where you set the start point and end point for an object. This section describes the layout of each of these windows. 

 

Main window 

You can create and edit register marks and simple accessory objects in the main window. 

 

Layout of the main window 

[For creating register marks] 

 

 

 

 

Menu bar  

Status bar 

Work window  

Quick access toolbar  
Editor button 
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[For creating simple accessories] 

 

 

Editor button When you click this button, the commands that can be used to exit the editor are 

displayed. 

Quick access toolbar When you click any button on the toolbar, its corresponding command is executed. 

Menu bar Shows the menu commands. 

When you click a menu command, it is executed. 

Status bar Shows basic information about the command that is selected in a toolbar or 

highlighted in a menu, as well as the display magnification in the work window, 

and coordinates of the cursor position. 

Work window You can create or edit register marks or simple accessory objects. 
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Editor button 

 Saves the settings, and exits the Register Mark/Simple Accessory Editor tool. 

 Exits the Register Mark/Simple Accessory Editor tool. 

 If any setting item has been modified, the following confirmation window is 

displayed. 

 

 Yes Saves the settings, and exits the tool. 

 No Discards the settings, and exits the tool. 

 Cancel Returns you to the Color Bar Setting window. 

 

Quick access toolbar 

 

 

 Changes the cursor to the Selection cursor. 

 Changes the cursor to the Zoom In cursor. 

 Changes the cursor to the Zoom Out cursor. 

 Changes the window to the full view. 

 Changes the position of the last specified point. 

 Measures the distance between 2 specified points. 

 

 

  



Register Mark/Simple Accessory Editor 

153 

Menu bar 

● Edit tab - Setting category 

[Setting]  

 

• For creating register marks 

 

 

• For creating simple accessories 

 

 

Settings Layout Sheet Size 

 

Allows you to set the layout sheet size for the object file. Enter 

values in the Width and Height fields. 

After a sheet size change, if the object extends outside the layout 

sheet, the object is automatically moved so that it fits within the 

layout sheet. If the object size is larger than the layout sheet size, 

the object size is automatically reduced so that it can fit within the 

layout sheet. 

 Units 

 

Allows you to select the units used when creating the object file. If 

you select “point”, you can enter a value in the text entry field. This 
allows you to set the size of one point as a fraction of an inch. 
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 Register Mark Type 

 

Allows you to select the type of register mark to create. This tab is 

only available when you create register marks. 

 Font 

 

Allows you to select the font type. This tab is only available when 

you create simple accessories. 

 

 You must select TrueType Font for the font type. 

 

 

[Spot Color Setting]  

Allows you to add spot colors for lines and fills. This command is displayed only when you create simple accessories. 

 

 

Add Allows you to add spot colors. 

When you click the Add button, the Add Spot Color window is displayed. 

 

 Name Allows you to enter a name for the new spot color. 

Important 
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 Spot Color 

Preview 

Shows a preview of the spot color you specified in Imitation 

Color. 

 Imitation Color Allows you to enter dot percentages for each of the CMYK 

separations for the simulation of the new spot color. 

Edit When you click this button with a spot color selected in the list, the Add Spot Color 

window is displayed. The contents of this window are the same as the contents of 

the window that appears when you click the Add button. 

Delete When you click this button with a spot color selected in the list, the selected spot 

color is deleted from the list. 

 

[Setup Grid Reference]  

When you place a cursor in a position and click on it, the position is saved as the grid reference point (origin of the 

grid generation). 

 

[Setup Grid Width]  

Allows you to set the horizontal and vertical spacing between the points on the grid. When you set the grid spacing, a 

grid is displayed with equal spacing in the X and Y directions. 

 

 

Width Allows you to set the horizontal grid spacing. 

The unit specified in the Units tab in the Settings window is displayed. 

Height Allows you to set the vertical grid spacing. 

The unit specified in the Units tab in the Settings window is displayed. 

 

[Horizontal guidelines]  

When you place the cursor at a desired position and click on the position, a horizontal guideline that passes through 

the clicked point is drawn. You can create as many horizontal guidelines as you need. To exit the horizontal guideline 

creation mode, select the Select Cursor command from the Support menu. 

 

 If you place the cursor over a created guideline and click on it again, the guideline is deleted. 

 

[Vertical guidelines]  

When you place the cursor at a desired position and click on the position, a vertical guideline that passes through the 

clicked point is drawn. You can create as many vertical guidelines as you need. To exit the vertical guideline creation 

mode, select the Select Cursor command in the Support menu. 

 

 If you place the cursor over a created guideline and click on it again, the guideline is deleted. 

 

  

Note 

Note 
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● Edit tab - Object category 

[Line]  

When you click on the start point of the line with the cursor and then click on the end point, a straight line is drawn. To 

exit the line drawing mode, select the Select Cursor command in the Support menu. 

 

[Continuous Line]  

When you click on a series of points without releasing the mouse, a continuous line that connects those points is drawn. 

To exit the continuous line drawing mode, select the Select Cursor command in the Support menu. 

 

 

 If you select the Close Continuous Line command, the last point will be connected to the start point 

and a polygon object will be created. 

 

[Rectangle]  

When you click on the start point with the cursor and then click on an opposite corner point, a rectangle is drawn. To 

exit the rectangle drawing mode, select the Select Cursor command in the Support menu. 

 

[Circle]  

When you click on the center point with the cursor and then click on a radius point, a circle is drawn. To exit the circle 

drawing mode, select the Select Cursor command in the Support menu. 

 

  

Note 

Start point Clicked points 
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[Text]  

When you click on a position with the cursor, the lower left point for the text start position is specified. 

You can enter the text by specifying it in the Text Setting window and then click the Set button. 

This command is only available when you create simple accessories. 

 

 

Font Allows you to select a font from the pulldown list. 

Size Allows you to select a font size from the pulldown list. You can also change the unit 

for the font using the pulldown list on the right. 

Text Allows you to enter the text string. 

Set When you click this button, the Text Setting window closes and the text string you 

entered is displayed in the work window. 

Text Color When you click this button, the Text Color Setting window is displayed. 

 

 Text Color Allows you to set the color for the entered text. 

If you select All, the color is set to 100% for each of the Y, M, 

C, and K separations. 

If you select YMCK, entry fields become available for each of 

the separation colors. Set the color by entering densities for 

each of the separation colors. 

If you select Spot Color, the pulldown list becomes available 

and you can select a spot color from the list as well as a 

density. 

 

 If you select Spot Color, you cannot set a color other than the specified spot color. 

 

  

Important 



6. Imposition Parts 

158 

● Edit tab - Edit category 

[Copy]  

Copies the selected object. 

 

[Paste]  

Pastes the copied object onto the layout sheet. 

 

 You cannot paste an object outside the frame of the layout sheet. 

 

 If you display a grid, the object will be pasted at the grid point closest to the position that is clicked. 

 

[Move]  

Moves the selected object. 

 

 You cannot paste an object outside the frame of the layout sheet. 

 

[Delete]  

Deletes the selected object. 

 

[Select All]  

Selects all the displayed objects. 

 

[Close Continuous Line]  

Allows you to make an open object into a closed object. 

 

 

 

 

 You can make fill color settings for objects that have been closed. 

 

[Object]  

Allows you to set object line weights and fill colors for the selected object. 

This command is only available when you create register marks. 

 

 

  

Important 

Note 

Important 

Note 

Before After 
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[Line]  

Allows you to set the line weight and line color for the selected object. 

This command is only available when you create simple accessories. 

 

 

Line Width Allows you to set the line weight for the selected object. 

Line Color Allows you to set the line color for the selected object. 

If you select All, the line color is set to 100% for each of the Y, M, C, and K 

separations. If you select YMCK, entry fields become available for each of the 

separation colors. Set the line color by entering densities for each of the separation 

colors. If you select Spot Color, the pulldown list becomes available and you can 

select a spot color from the list as well as a density. 

 

[Fill]  

 

 

Fill Color Allows you to set the color to fill the selected object. 

If you select Off, the object is not filled. If you select All, the fill color is set to 100% 

for each of the Y, M, C, and K separations. If you select YMCK, entry fields become 

available for each of the separation colors. Set the fill color by entering densities for 

each of the separation colors. If you select Spot Color, the pulldown list becomes 

available and you can select a spot color from the list as well as a density. 
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[Text Attribute]  

Allows you to select a font and size for the selected text. 

This command is only available when you create simple accessories. 

 

 

Font Allows you to select a font from the pulldown list. 

Size Allows you to select a font size from the pulldown list. You can also change the unit 

for the font using the pulldown list on the right. 

Text Shows the text string in the font you selected. Enter the text string that you want to use 

for your simple accessory. 

Set When you click this button, the Text Setting window closes and the text string you 

entered is displayed in the work window. 

Text Color When you click this button, the Text Color Setting window is displayed. 

For more information, see “[11] Text Color” for details of the text color. 

 

 

 If you select Spot Color, you cannot set a color other than the specified spot color. 

 

  

Important 
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[Text Color]  

Allows you to set the color for the relevant text. 

This command is only available when you create simple accessories. 

 

 

Text Color Allows you to set the color for the entered text. 

If you select All, the color is set to 100% for each of the Y, M, C, and K separations. 

If you select YMCK, entry fields become available for each of the separation colors. 

Set the color by entering densities for each of the separation colors. If you select Spot 

Color, the pulldown list becomes available and you can select a spot color from the 

list as well as a density. 
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● Edit tab - Reference Point category 

• For creating register marks 

[Reference Point]  

Allows you to specify the reference point when the register mark is arranged in the signature. 

The clicked point is set as the reference point, and it is displayed in red. To exit the reference point setup mode, select 

the Select Cursor command in the Support menu. 

 

 

 

 

 If you select the Save command from the File menu without setting a reference point, the 

confirmation window shown below is displayed. 

 

 

 When the imposition scheme is created, the reference point for the register mark is positioned at the 

insertion point for the register mark of the signature. 

 

[Horiz. Bleed Ref. Pt.]  

Allows you to specify the horizontal bleed reference point so that the distance between it and the reference point is the 

same as the horizontal bleed width. This command is only available when you create register marks. 

 

The horizontal bleed reference point is set for a corner mark. 

The clicked point is set as the horizontal bleed reference point, and it is displayed in yellow. To exit the horizontal 

bleed point setup mode, select the Select Cursor command in the Support menu. 

 

  

Important 

Note 

[Corner mark] [Center mark] 

[Spread mark] [Cross mark] 

Reference point 
Reference point 

Reference point Reference point 



Register Mark/Simple Accessory Editor 

163 

Corner mark 

 

 

 If you select the Save command from the File menu without setting a horizontal bleed 

reference point, the confirmation window shown below is displayed. 

 

 

[Vert. Bleed Ref. Pt.]  

Allows you to specify the vertical bleed reference point so that the distance between it and the reference point is the 

same as the vertical bleed width. This command is only available when you create register marks. 

 

The vertical bleed reference point is set for a corner mark, center mark, or spread mark. 

The clicked point is set as the vertical bleed reference point, and it is displayed in yellow. To exit the vertical bleed 

point setup mode, select the Select Cursor command in the Support menu. 

 

Corner mark Center mark 

 

 

Spread mark 

 

 

 If you select the Save command from the File menu without setting a vertical bleed 

reference point, the confirmation window shown below is displayed. 

 

 

  

Important 

Important 
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Horizontal bleed point 

Vertical bleed point 
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[Right Bleed Size Ref. Pt.]  

Allows you to specify the right bleed size reference point so that the distance between it and the reference point is the 

same as the right bleed width. This command is only available when you create register marks. 

 

The right bleed size reference point is set for a spread mark. 

The clicked point is set as the right bleed size reference point, and it is displayed in yellow. To exit the right bleed 

width point setup mode, select the Select Cursor command in the Support menu. 

 

Spread mark 

 

 

 If you select the Save command from the File menu without setting a right bleed size 

reference point, the confirmation window shown below is displayed. 

 

 

[Left Bleed Size Ref. Pt.]  

Allows you to specify the left bleed size reference point so that the distance between it and the reference point is the 

same as the left bleed width. This command is only available when you create register marks. 

The left bleed size reference point is set for a spread mark. 

The clicked point is set as the left bleed size reference point, and it is displayed in yellow. To exit the left bleed width 

point setup mode, select the Select Cursor command in the Support menu. 

 

 

 If you select the Save command from the File menu without setting a left bleed size 

reference point, the confirmation window shown below is displayed. 

 

 

  

Important 
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Right bleed width point 

Left bleed width point 
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● For creating simple accessories 

[Reference Point]  

Allows you to specify the reference point for simple accessory objects. 

The clicked point is set as the reference point, and it is displayed in red. To exit the reference point setup mode, select 

the Select Cursor command in the Support menu. 

 

 If you select the Save command from the File menu without setting a reference point, the 

confirmation window shown below is displayed. 

 

 

● Edit tab - Simulation category 

[Simulation]  

Allows you to view the resultant state after the conversion processing for the register mark data. This command is only 

available when you create register marks. 

 

 

Vert. Bleed Size Allows you to set the distance between the reference point and the vertical bleed 

point (parametric reference point). This can be set for all register mark objects. 

Horiz. Bleed Size Allows you to set the distance between the reference point and the horizontal bleed 

point (parametric reference point). This can only be set for corner marks. 

Bleed Size Allows you to set the distance between the right bleed width point (parametric 

reference point) and the left bleed width point (parametric reference point). This 

can only be set for spread marks. 

Rotation Allows you to set an amount of rotation for register mark objects. You can select 0, 

90, 180, and 270. 

Display MinMax Rectangle When you select this check box, the smallest possible rectangular frame is 

displayed around the register mark object. 

Simulate Simulates the register mark object according to the settings you made. 

 

  

Important 
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● Support tab - Support category 

[Select Cursor]  

Changes the cursor (e.g., position specification cursor and zoom in/out cursor) to the Selection cursor. 

 

[Zoom In]  

Enlarges the object as you click in the work window. 

You can also drag the mouse over an area to enlarge it. 

 

[Zoom Out]  

Reduces the object as you click in the work window. 

 

[Display All]  

Changes the window to the full view. 

 

[Change Last Point Input]  

Changes the position of the last specified point. If you change the last point input, the changed point will become the 

reference point for the relative coordinate field in the Coordinate Input window. 

 

[Distance]  

Measures the straight line distance between any two specified points as well as the distance in the X and Y directions 

between the two points. 

 

 

Distance Shows the straight line distance between the two specified points. Up to four 

decimal places are displayed for the value. 

Horizontal Shows the distance in the X direction between the two specified points. Up to four 

decimal places are displayed for the value. 

Vertical Shows the distance in the Y direction between the two specified points. Up to four 

decimal places are displayed for the value. 

 

 The values for the horizontal and vertical distances are shown as positive values 

regardless of the direction from the start point to the end point. 

 

  

Important 
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● View tab - View category 

[Ruler] 

Switches between show and hide of the ruler. 

 

 If you want to change the ruler origin, you can click the cursor at the point where the horizontal and 

vertical rulers intersect and then drag the ruler origin to the desired location. 

 

 

[Guidelines] 

Switches between show and hide of the horizontal and vertical guidelines. 

 

[Grid] 

Switches between show and hide of the grid. 

If you draw objects or set reference points when a grid is displayed, the relevant object snaps to the nearest point on 

the grid. In addition, you can change the grid reference point and spacing. 

 

[Coordinate Input Window] 

Switches between show and hide of the Coordinate Input Window. 

In the Coordinate Input Window, you can specify a position by entering coordinate values. Select Abs. Coord. or Rel. 

Coord., enter the coordinate values, and click the Apply button to specify the position. 

To display the Coordinate Input Window after it has been closed, select Coordinate Input Window in the menu bar. 

 

 

Abs. Coord. When this is selected, the coordinates for the layout point are specified using the 

lower left of the work window as the reference point. This option can be used for 

setting the coordinates for all points other than the Distance command in the 

Support menu. 

Rel. Coord. When this is selected, the coordinates for the layout point are specified using the 

last specified point as the reference point. 

X Allows you to enter the X coordinate. 

Y Allows you to enter the Y coordinate. 

Apply When you click this button, the layout point is positioned at the coordinates that 

were entered. 

 

  

Note 
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● Help tab -Help category 

[Help]  

Displays the manual. 

 

[About Reg. Mark/Simple Acc. Editor]  

Displays the version information. 

 

Basic operations 

Creating a register mark 

This section describes the workflow from creating a new register mark to saving it, using a corner mark as an example. 

 
 

1. Select Register Mark from the left pane of the Accessories Manager window, and select the Custom list 

area. 

 

 

2. Click the  button. 

The New window is displayed. 

 

 

Operation 
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3. Enter a file name, and click the Create button. 

The Register Mark Editor window is displayed. 

 

 

● Setting the Layout Sheet Size, Units, and Register Mark Type 

 
 

1. Select the Setting command in the Edit tab. 

The Settings window is displayed. 

 

2. Make settings for Layout Sheet Size, Units, and Register Mark Type. 

In this example, make the following settings. 

Layout Sheet Size: Width 60 mm x Height 60 mm 

Units: mm 

Register Mark Type: Corner mark 

 

3. Click the OK button. 

 

Operation 
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● Drawing an object 

 

 When you create a corner mark, use the lower left as the reference point, and when you 

create a center mark or spread mark, use the bottom as the reference point. If you use a 

wrong reference point, it will not be possible to orient the register mark properly when 

you position it in an imposition scheme. 

 
 

1. Select the Line command in the Edit tab. 

 

2. Draw the lines that compose the corner mark. 

Specify a start point and end point for a line on the layout sheet. 

Repeat this operation to draw the lines as follows. 

 

 

● Setting the reference point 

 
 

1. Select the Reference Point command in the Edit tab. 

Click the mouse pointer on the position you want to set as the object reference point. 

 

2. Select the Vert. Bleed Ref. Pt. command in the Edit tab. 

Click the mouse pointer on the position you want to set as the vertical bleed reference point of the object. 

 

  

Important 
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Operation 
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3. Select the Horiz. Bleed Ref. Pt. command in the Edit tab. 

Click the mouse pointer on the position you want to set as the horizontal bleed reference point of the object. 

 

 

 

 

● Simulating the register mark 

 
 

1. Select the Simulation command in the Edit tab. 

The Register Mark Data Simulation window is displayed. 

 

2. Enter values for the horizontal bleed and the vertical bleed, and select the rotation angle. 

In this example, make the following settings. 

Vert. Bleed Size: 3 mm 

Horiz. Bleed Size: 3 mm 

Rotation: 90 

 

3. Click the Simulate button. 

The register mark object that is associated with the bleed width moves and rotates 90 degrees with respect to the 

reference point. 

 

4. Close the simulation window. 

 

● Saving the register mark 

 
 

1. Select the Save command via the Editor button. 

The register mark file is saved. 

 

Reference point 

Vertical bleed reference point 

Horizontal bleed reference 

Operation 

Operation 
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Creating simple accessories 

This section describes the workflow from creating a new simple accessory to saving it. 

 
 

1. Select Simple Accessory from the left pane of the Accessories Manager window, and select the Custom 

list area. 

 

 

2. Click the  button. 

The New window is displayed. 

 

 

Operation 
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3. Enter a file name, and click the Create button. 

The Simple Accessory Editor window is displayed. 

 

 

● Setting the Layout Sheet Size, Units, and Font 

 
 

1. Select the Setting command in the Edit tab. 

The Settings window is displayed. 

 

 

2. Make settings for Layout Sheet Size, Units, and Font. 

In this example, make the following settings. 

Layout Sheet Size: Width 40 mm x Height 10 mm 

Units: mm 

Font: TureType Font 

 

3. Click the OK button. 

 

  

Operation 
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● Drawing an object 

 
 

1. Select the Rectangle command in the Edit tab. 

 

2. Draw the rectangles that compose the simple accessory. 

Specify a start point and an opposite corner point for a rectangle on the layout sheet using the mouse pointer, 

and a rectangle will be drawn based on these two points. 

Repeat this operation to draw the rectangles as follows. 

 

 

 

 

Operation 
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● Line setting 

 
 

1. Select the Select All command in the Edit tab. 

 

2. Select the Line command in the Edit tab. 

The Line Settings window is displayed. 

 

 

3. Set the line weight and the line color. 

Enter 0.2 in the Line Weight field and select the All radio button under Line Color. 

 

4. Click the OK button. 

 

 

 

Line color: All 

Line weight: 0.2 mm 

Operation 
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● Color settings 

 
 

1. Select the object for which you want to set a fill color. 

 

2. Select the Fill command in the Edit tab. 

The Fill Settings window is displayed. 

 

 

3. Set the fill color for the selected rectangle object. 

In this example, the selected rectangle object is to be filled with yellow. After selecting the YMCK radio button, 

enter 100 in the Y field and 0 in the M, C, and K fields. 

 

4. Click the OK button. 

The selected rectangle object is filled with yellow. 

 

 

Operation 
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5. Set the fill colors for the other three rectangle objects. 

Fill the other three rectangle objects with magenta, cyan, and black respectively, using the procedure in steps 1 to 

4. 

 

 

 

● Setting the reference point 

 
 

1. Select the Reference Point command in the Edit tab. 

Click the mouse pointer on the position you want to set as the simple accessory reference point. 

 

 

● Saving a simple accessory 

 
 

1. Select the Save command via the Editor button. 

The simple accessory file is saved. 

 

Reference point 

Operation 

Operation 
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Macro characters for simple accessories 

You can set the macro characters for simple accessories. The macro that has been set will be expanded when the 

relevant accessory is output. 

The following describes the macro characters that can be set. 

 

Macro Description 

%B or %b The order number is output. 

%O or %o When the accessory is arranged based on the signature: 

The signature number is output. 

When the accessory is arranged based on the sheet, or signature layout area: 

The sheet number is output. 

%F or %f When the accessory is arranged based on the signature: 

The front and back of the signature are output. 

When the accessory is arranged based on the sheet, or signature layout area: 

The front and back of the sheet, or signature layout area are output. 

%+01 to %+10 An arbitrary character string is output. 

 

 The following macro characters represent the character strings that are expanded in the Job 

Property window of the TotalFlow Simply Prepress Client. 

%+01 to %+10 

 

 

 

Note 



Spine Mark Editor 

179 

Spine Mark Editor 

Spine Mark Editor is a tool to create spine marks that can be arranged into the layout of an imposition scheme. 

You can create and edit spine marks according to the workflow with this tool. 

 

Functions of Spine Mark Editor 

• Since the setup for start points, colors, repeat marks, and other settings are displayed on screen in real time, you can 

create spine marks while checking how they will appear on the signature. 

• You can simulate how the spine marks you create will appear on the signature. 

 

Layout of the Spine Mark Editor windows 

Spine Mark Editor has two windows, the main Spine Mark Editor window, where you create spine marks, and the 

Simulation window, where you can simulate how the signatures will look. 

 

Main window 

You can create and edit spine mark objects in the main window. 

 

Layout of the main window 

 

Editor button 

Menu bar 

Window selection tabs 

Work window 

Object information area 

Status bar 
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Editor button When you click this button, commands are displayed. 

Menu bar Shows the menu commands. 

When you click a menu command, it is executed. 

Window selection tabs When you click a tab, the corresponding setup window is displayed. 

Status bar Shows the coordinates of the cursor in the object information area. 

Work window Allows you to create or edit spine mark objects. 

Object information area Shows a spine mark object based on the information set in the tab windows when 

the Set check box has been selected. The information displayed differs depending 

on which tab is selected. 

 

Editor button 

 Saves the settings, and exits the Spine Mark Editor tool. 

 Exits the Spine Mark Editor tool. 

When a set item has been modified, the following message boxes are displayed. 

 

 Yes Saves the settings, and exits the tool. 

 No Discards the settings, and exits the tool. 

 Cancel Returns you to the Color Bar Setting window. 
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Menu bar 

Menu tab 

● Setting  

Allows you to make settings for the origin position, unit, size, font, and size of the repeat marks to be used before you 

create a spine mark. 

 

 

Origin Allows you to set the origin position for spine mark objects. This origin becomes the 

reference for positioning spine mark objects. When you enter a value for the Offset 

field, the origin is set at the position shifted by the amount you entered in the X 

direction (left-right direction) from the selected reference point. If you enter positive 

numbers, the origin is offset to the right, and if you enter negative numbers, the 

origin is offset to the left. 

Unit Allows you to select the units used when creating the spine mark file. If you select 

“point”, you can enter a value in the text entry field. This allows you to set the size 
of one point as a fraction of an inch. 
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Size Allows you to set the size of the spine mark object you are creating. You can enter 

values in the Width and Height fields. If you click the Page button, the Height 

Setting window is displayed. 

 

 Page Size Allows you to set a page size. The page size you select here 

becomes the height of the spine mark object. If you select 

Custom, you can enter your own height value. 

 Standard Dir. Allows you to select the orientation of the height for the spine 

mark object. If you select Vertical, the height of the page size 

you selected becomes the height of the spine mark object. If you 

select Horizontal, the width of the page size you selected 

becomes the height of the spine mark object. 

Fold No. Setting Setting Use 

Macro 

When you select this check box, the macro formula entry field 

becomes active. Enter a macro formula for the signature number. 

Font Allows you to set the type, font, size, unit, and disposition of the text used in the 

spine mark object. Make settings for each of these items using their respective 

pulldown list. 

TrueType Font must always be selected for Type. 

Font lists the TrueType fonts installed on the machine on which TotalFlow Simply 

Prepress is installed. 

Rep. Mark Size Allows you to select the repeat mark size as specified or the same as the font size. If 

you select Size Settings, you can enter values for the Width and Height fields for 

the selected mark. 

Note that when Circle or Star is specified, you can only enter a value in Width. 

(The value entered for Width is also applied for Height.) 

Comment Allows you to enter comments for the spine mark you are creating. You can enter 

up to 60 single-byte characters. 

 

 The only variables that you can enter are n and N. In addition, you can only use one variable in 

each macro formula. Specify the formula using the four rules of arithmetic. 

The symbols that express the four rules of arithmetic, + (Add), - (Subtract), * (Multiply), and / 

(Divide), are the only symbols that can be used. You can enter the macro formula using up to 127 

single-byte characters. 

For example, if the signature number is 4 and you set the macro formula to 2*n-1, the last signature 

number output is 7 (2 times 4 minus 1). 

 

 If you set a height value in the Height field that is lower than the value entered in the 

Height Setting window, the confirmation window shown below may be displayed. 

 

 

  

Note 

Important 
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● Simulation  

Allows you to simulate the spine mark in the open file on the signature. 

For more information about the Simulation window, see “Simulation window”. 
 

Help tab 

About Spine Mark Editor Displays the version information. 

 

Work window 

The Spine Mark Editor work window contains three setup tab windows, Collation Marks, Backbone ID, and 

Orientation Marks. You can switch between these windows by selecting a tab. 

 

Collation Marks window 

 

 

Set This check box allows you to set whether or not to set collation marks. It is On when 

there is a check in the box and it is Off when there is no check in the box. The 

default setting is On. If you clear this check box, all of the fields in the Collation 

Marks window become inactive and you cannot set collation marks in the spine 

mark object you are creating. 
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Collation mark size You can specify the size of the collation marks. Enter the start position of the 

collation marks in the Start Pos. field. In the Width and Height fields, set the width 

and height for the collation marks. In the Offset field, set the amount that the second 

and following collation marks shift from the previous mark. 

 

[Collation marks created in a descending order by entering a positive value in 

Offset] 

 

 

[Collation marks created in an ascending order by entering a negative value in 

Offset] 

 

Mark Style You can set the style for the collation marks. If you select Fill Marks, the collation 

marks are filled with the specified color. If you select Only KeyLine, the collation 

marks are displayed using only the lines with the specified width. 

When you select the Set Center Line check box, centerlines with the specified line 

weight and length can be set for the collation marks. 

 

[When Only KeyLine is selected with Set Center Line deselected] 

 

 

[When Only KeyLine is selected with Set Center Line selected] 

 

 

Width 

Offset Height 

Offset 

Width 

Height 
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[When Fill Marks is selected with Set Center Line selected] 

 

Mark Color You can set a color for the collation mark. If you select All Seps. 100%, all the 

separations for that collation mark will be output at 100%. If you select Sep. 

Settings, the CMYK check boxes become active and you can specify dot 

percentages for each of the CMYK separations. 

 

Cutout Text You can set whether or not to have cutout text in your collation mark. If you select 

Yes, the Type field becomes active. This allows you to select the type of numerals 

you want in your cutout text. If you select No, cutouts are not displayed. 

 

[When Yes is selected] 

 

 

[When No is selected] 
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Repeat Settings You can set the method for positioning repeated collation marks. If you select Set 

by Range, the Range field becomes active. If there are more collation marks than fit 

within the specified range, they are positioned according to the pattern selected in 

Repeat Pattern. If you select Set by No. of Folds, the No. of Folds field becomes 

active. If there are more collation marks than fit within the specified signature range, 

they are positioned according to the pattern selected in Repeat Pattern. 

 

[When Range is set to 50 mm] 

 

 

[When Set by No. of Folds is set to 4] 

 

Repeat Pattern You can select a pattern for positioning spine marks. If you select , the collation 

marks will be positioned using a stepped pattern. If you select , the collation 

marks will be positioned using a mountain pattern. 

 

[When Set by No. of Folds is set to 5 and the repeat pattern is ] 

 

 

[When a negative value is entered in Offset and the repeat pattern is ] 

 

 

4 signatures 4 signatures 
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[When Set by No. of Folds is set to 5 and the repeat pattern is ] 

 

 

[When a negative value is entered in Offset and the repeat pattern is ] 

 

Repeat Marks You can set whether or not to have repeat marks. If you select No, repeat marks are 

not displayed. If you select Yes, the Type, Start Pos., Reset Rep. No., Gap, and 

Direction fields become active. If you enter a number into the Reset Rep. No. field, 

repeat marks are placed within the range of the specified number of signatures. 

Select a type of object from the pulldown list, enter values for the start position, the 

reset repeat number, and the gap, and then select a direction. The way repeat 

marks are placed depends on the repeat pattern. 

 

[When Repeat Marks is set to No] 
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 [When the repeat pattern is  and circular repeat marks are set with a start 

position of 200 mm and a reset repeat number of 4] 

 

 

[When the repeat pattern is  and circular repeat marks are set with a start 

position of 200 mm and a reset repeat number of 4] 
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 [When the repeat pattern is  and circular repeat marks are set with a start 

point of 200 mm, a reset repeat number of 4, a gap of 2.5 mm, and an upward 

direction] 

 

 

 • The value entered in Gap specifies the interval between repeat marks as shown below. 

 

• Direction specifies whether to put repeat marks in an upward direction or a downward direction 

with reference to the start position. 

 [When Down is selected] [When Up is selected] 

        

 

 

Note 

Gap 
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Backbone ID window 

 

 

Set This check box allows you to set whether or not to set a backbone ID. It is On when 

the check box is selected and Off when it is not selected. The default setting is On. 

If you turn this setting Off, all of the fields in the Backbone ID window become 

inactive and you cannot set a backbone ID in the spine mark object you are 

creating. 

Text Allows you to enter text for the backbone ID. The text is entered in the font you 

selected in the Setting window, which is accessed by selecting Setting from the File 

menu. 

Start Pos. Allows you to set the start position for the backbone ID. For example, if you enter 

10 mm, the backbone ID is positioned 10 mm from the top of the spine mark 

object. 
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Fold Numbers You can set whether or not to display the signature numbers. If you select No, no 

signature numbers are displayed. If you select Yes, the signature number display 

setup fields become active. Enter the start position for the signature numbers in the 

Start Pos field. In the Fold Start No. field, enter a signature start number. Select the 

type of numerals to be displayed in the Num. Type field. In the Prefix and Suffix 

fields, enter the text to precede and follow the signature number. 

For example, if you enter 70 mm as the start position, 1 as the number of the 

signature from which to start, No. as the prefix, A as the suffix, and Arabic Num. as 

the type of numerals, the signature numbers appear as shown below. 

 

Text Color You can set a color for the backbone ID text. If you select All Seps. 100%, all the 

separations for that text will be output at 100%. If you select Sep. Settings, the 

CMYK check boxes become active and you can specify dot percentages for each 

of the CMYK separations. 

Reflect the “Fold Start No.” in 
“Collation Marks” and 
“Orientation Marks”. 

When you select this check box, the positions of the collation marks and orientation 

marks change in accordance with each signature number in the backbone ID. 

 

Arabic Num. 

Start Pos. 

70mm 

Prefix 

Suffix 
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Orientation Marks window 

 

 

Set This check box allows you to set whether or not to set orientation marks. It is On 

when the check box is selected and Off when it is not selected. If you turn this 

setting Off, all of the fields in the Orientation Marks window become inactive and 

you cannot set orientation marks in the spine mark object you are creating. 

Orientation mark shape You can set the shape of the orientation marks. Enter the start position for the first 

orientation marks in the Start Pos. field. In the Width and Height fields, set the width 

and height for the orientation marks. In the Offset field, set the amount that the 

second and following orientation marks are shifted up or down on the spine. A 

positive value moves the mark down the spine and a negative value moves the 

mark up the spine. 

 

Mark Color You can set a color for the orientation marks. If you select All Seps. 100%, all the 

separations for the orientation marks will be output at 100%. If you select “Sep. 
Settings”, the CMYK check boxes become active and you can specify dot 

percentages for each of the CMYK separations. 

Width 

Offset 

Height 
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Repeat Settings You can set the method for positioning repeated orientation marks. If you select No, 

the orientation marks are all placed in the same position on the fold. If you select 

Set by Range, the Range field becomes active. If there are more orientation marks 

than fit within the specified range, they are positioned according to the pattern 

selected in Repeat Pattern. If you select Set by No. of Folds, the No. of Folds field 

becomes active. If there are more orientation marks than fit within the specified 

signature range, they are positioned according to the pattern selected in Repeat 

Pattern. 

 

[When Repeat Settings is set to No] 

 

 

[When Range is set to 40 mm] 
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 [When Set by No. of Folds is set to 5] 

 

 

 

Repeat Pattern You can select a pattern for positioning spine marks. If you select , the collation 

marks will be positioned using a stepped pattern. If you select , the collation 

marks will be positioned using a mountain pattern. 

 

[When the repeat pattern is ] 

 

 

[When the repeat pattern is ] 

 

 

Simulation window 

The Simulation window simulates how the open spine mark object will look on the signatures. 

 

5 signatures 
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Layout of the Simulation window 

If you select the Simulation command of the main tab, the Simulation window is displayed. 

 

 

Toolbar You can make condition settings for simulation. The toolbar shows button icons for 

the menu commands, such as the zoom-in and zoom-out commands for the 

Simulation window. 

Simulation display area Shows a simulation of how the signatures will look. 

 

Toolbar 

 Allows you to set the total number of signatures. 

 Allows you to select right or left stitching. 

 Runs the simulation under the conditions that have been set. 

 Enlarges the display in the simulation display area. 

 Reduces the display in the simulation display area. 

 Fits the entire simulated object into the simulation display area. 

 If you set a macro of “%j” or “%J” for outputting the job name on the spine mark, 
enter a job name for the simulation. 

 

Toolbar 

Simulation display area 
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Basic operations 

Creating a spine mark 

This section describes the workflow from creating a new spine mark to saving it. 

 
 

1. Select Collation Mark/Jog Side Mark from the left pane of the Accessories Manager window, and 

select the Custom list area. 

 

 

2. Click the  button. 

The New window is displayed. 

 

3. Enter a file name, and click the Create button. 

A new Spine Mark Editor window is displayed. 

 

Setting up basic data 

 
 

1. Select the Setting command of the Main category. 

The Setting window is displayed. 

 

2. Set the origin for the spine mark. 

In this example, select Top Center and set 0 mm as the offset. 

 

3. Set the units to be used when making the spine mark. 

In this example, select mm. 

 

Operation 

Operation 
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4. Set the width and height of the spine mark. 

In this example, enter 10 mm in the Width field and 297 mm in the Height field. 

 

If you want to specify a macro for the signature number, select the Use Macro check box. 

Enter the macro formula for the signature number macro in the macro formula entry field shown below. 

 

 

5. Set the font you want to use, with its size, unit, and writing disposition. 

In this example, select True Type for Type, Arial for Font, 10 for Size, point for Unit, and Horizontal Writing for 

Disposition. 

 

6. Set the size for the repeat marks. 

In this example, enter 7 mm. 

 

7. Enter comments. 

Enter comments for the spine mark you are creating. 

 

8. Click the OK button. 
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● Setting the collation marks 

 

 
 

1. Click the Collation Marks tab, and select the Set check box. 

 

2. Make settings for the start position, width, height, and offset for the collation marks. 

In this example, enter 90 mm for Start Pos., 5 mm for Width, 10 mm for Height, and 5 mm for Offset. 

 

3. Set the style for the collation marks. 

In this example, select Fill Marks, select the Set Center Line check box, and use default settings for other items. 

 

4. Set the color of the object. 

Set the color for the marks. In this example, select All Seps. 100%. 

 

5. Make settings for cutout text. 

In this example, select Arabic Num. 

 

6. Set the repeat range. 

In this example, select Set by No. of Folds. If you select Set by No. of Folds, the No. of Folds field becomes active. 

Enter 10 in the field. 

 

7. Set the repeat pattern. 

In this example, select . 

 

8. Make settings for repeat marks. 

In this example, select Yes. When you select Yes, the Type, Start Pos., Reset Rep. No., Gap, and Direction fields 

become active. Select Circle for Type, enter 200 mm for Start Pos., 5 for Reset Repeat No., and 2.5 mm for Gap, 

and then select Down for Direction. 

 

Operation 
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9. Check the collation mark data settings you created. 

 

● Setting the backbone ID 

Click the Backbone ID tab, and select the Set check box. 

 

 
 

1. Enter the text string and start position. 

In this example, enter SCREEN NEWS MONTHLY in the Text field and 10 mm in the Start Pos. field. 

 

2. Make settings for displaying signature numbers. 

In this example, select Yes. If you select Yes, the Start Pos., Fold Start No., Num. Type, Prefix, and Suffix fields 

become active. Enter 70 mm for Start Pos., 1 for Fold Start No., No. for Prefix, and A for Suffix. Select Arabic 

Num. for Num. Types. 

 

3. Set the color of the text. 

In this example, select All Seps. 100%. 

 

4. Select the Reflect the “Fold Start No.” in “Collation Marks” and “Orientation Marks.” check box as 
necessary. 

 

5. Check the backbone ID data settings you created. 

 

 The font used for the text is the font you selected in the Setting window, which is accessed by 

selecting the Setting command from the File menu. 

You can use a carriage return to enter a two-line character string. In addition, if you enter a “%J” or 
a “%j” symbol within the text string, these symbols are linked to job names during output. For 

example, if you use the backbone ID of Mark_%J for the job called SCREEN, Mark_SCREEN is 

shown as the backbone ID. 

  

Note 

Operation 
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● Setting the orientation marks 

 

 
 

1. Click the Orientation Marks tab. 

 

2. Make settings for the start position, width, height, and offset for the orientation marks. 

In this example, enter 287 mm for Start Pos., 5 mm for Width, 10 mm for Height, and -5 mm for Offset. 

 

3. Set the color of the object. 

In this example, select “All Seps. 100%”. 
 

4. Set the repeat range. 

In this example, select Set by No. of Folds. If you select Set by No. of Folds, the No. of Folds field becomes active. 

Enter 2 in the field. 

 

5. Set the repeat pattern. 

In this example, select . 

 

6. Check the orientation mark data settings for the orientation marks you created. 

 

● Simulating the spine mark 

 
 

1. Select the Simulation command of the Main category. 

The Simulation window is displayed. 

 

2. Set the simulation conditions. 

In this example, enter 15 in the Total No. of Folds field and select Left Stitching as the type of stitching. 

 

Operation 

Operation 
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3. Perform the simulation. 

 

 

 You can also create a spine mark while the Simulation window is displayed. 

 

● Saving the spine mark 

 
 

1. Select the Save command of the Editor button. 

The spine mark file is saved. 

 

 

Note 

Operation 
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Information Editor 

Information Editor is a tool to create information arranged into the layout of an imposition scheme. 

You can create and edit the information according to the workflow with this tool. 

 

Functions of Information Editor 

• You can create a new information file or customize an existing information file. 

• When you create an imposition scheme in TotalFlow Simply Prepress, it is possible to place the new information file 

in it. 

 

Main window 

You can create and edit information objects in the main window. 

 

Layout of the main window 

 

 

 

 

Menu bar When you click any menu on the menu bar, a list of commands is displayed. 

Toolbar Shows button icons for each of the menu commands. When you click one of these 

buttons, the corresponding command is executed. 

Commands When you click a command name, the selected command is executed. 

Information Strings Allows you to enter the text strings that are set for the information files. 

Specify the information that varies with the output conditions using the macro 

characters. 

Macro Character Shows the macro characters that can be used in information files. When you 

double-click an item in this list, the corresponding macro character is inserted at the 

position of the cursor in the Information Strings area. 

 

Commands 

Toolbar 

Menu bar 

Information Strings 

Macro Character 
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Menus 

● File menu 

Save Saves the settings, and exits the tool. 

Simulation Allows you to simulate the output state of the created information file. 

 

  Displays the Simulation Properties window. 

You can enter the simulation conditions. 

  Displays the information file size and the X and Y positions for starting 

text printing. 

To hide the X and Y positions, click this button again. 

  Enlarges the view in the Simulation window each time you click this 

button. 

You can also drag the mouse to enlarge a specific area. 

  Reduces the view in the Simulation window each time you click this 

button. 

  Displays the full view in the Simulation window. 

Close Exits the Information Editor tool. 

If any setting item has been modified, the following confirmation window is 

displayed. 

 

 Yes Saves the settings, and exits the tool. 

 No Discards the settings, and exits the tool. 

 Cancel Returns you to the Information Editor window. 
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 The Simulation window displays a simulation based on the conditions entered in the 

Simulation Properties window. 

Note that the actual output may differ from the display in the Simulation window in some 

cases. 

 

[Simulation Properties window] 

 

 

Job Name Allows you to enter the job name. 

Fold Allows you to enter the signature number (figure). For a front (top) signature, select 

Top; for a back (bottom) signature, select Bottom. 

Hot Folder Allows you to enter the name of the hot folder. The character string of From JOB 

will be output. 

Offset Control Select this check box if you want to check the output state for text when offset 

control has been used. 

Exposure Control Select this check box if you want to check the output state for text when exposure 

control has been used. 

Important 
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Settings 

The Settings window allows you to make settings such as the size and the parameters for the texts. 

 

 

Whole Allows you to make basic settings for the information file, such as the size (width 

and height) and unit. 

Size Allows you to set the size for the information file. Enter the desired values in the 

Width and Height fields. 

Text Start Pos. Allows you to enter the X and Y positions for starting text printing. 

Text start position 

 

 

Background Color Allows you to specify whether or not a background color should be applied in the 

information area. 

Select this check box to enable the background color settings. 

Clicking the Settings button displays the Background Settings window. 
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 All Select this if you want to apply background colors with the 

same percentage to all separations, including spot color 

separations. 

 Process Color Select this if you want to specify different densities for each 

process color separation. 

No background color is applied in spot color separations. 

Unit Allows you to specify the unit to be used in the information file being created. 

Comments Allows you to enter any desired comments (memoranda). 

 

[Style] 

The Style tab is used to make settings related to the output font. 

 

 

Font Allows you to select the font type. 

Size Allows you to select the font size. You can select only Point for the unit. 

Attr. Allows you to select Bold or Italic. 

Color Settings Click this button to make text color settings. The Text Color Settings window is 

displayed. 

 

 All Select this if you want to use the same density for the text in 

all separations, including spot color separations. 

 Process Color Select this if you want to specify different densities for each 

process color separation. 

No text is output for spot color separations. 
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Char. Pitch Allows you to set the distance between characters. 

Line Pitch Allows you to set the distance between lines. 

 

 If you select All, the information text is also output in spot color separations. 

If you select Process Color, only the plate name and plate number are output for separations whose 

check boxes have been left unchecked. 

If you select a check box for a separation and specify 0 percent, all the text is output using 0% 

density. 

 

[Fold] 

The Fold tab is used to make settings related to the signature number (figure) style and the signature text strings. 

 

 

Style Allows you to select the style for the signature numbers. You can select Arabic 

numerals only. 

Top String Allows you to set the text string output on the top (front) of a signature. 

Bottom String Allows you to set the text string output on the bottom (back) of a signature. 

 

Example: If you set Style to Arabic Num. and Top String to front, “front 1”, “front 2”, (and so on) will be output. 
 

Note 
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[Date] 

The Date tab is used to make settings related to the date and time. 

 

 

Style Allows you to select the language to be used for date and time. 

Select a language from among the following options. 

C, English, Japanese, German, French, and Italian. 

Customize When you select this check box, you can select a specific date and time format 

using the macros. Double-clicking an item in the Macro list inserts the macro 

character string at the position of the cursor in the text field below the Customize 

check box. 

Example: 

When English has been selected for the date and time style in the Date tab. 

 

 

 If you select C, the format used in C (the C programming language) is used for output. 

To output the date and time as information, the %T macro must be specified in the information text 

line in the main window. 

 

 If Customize is deselected, %#c (date and time) is used automatically. 

 

  

Note 

Important 
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Tool bar 

The toolbar displays buttons that correspond to the various commands in Information Editor. When you click a button 

in the toolbar, the command associated with that button is executed. If you place the mouse pointer over a button, the 

name of the associated command is displayed. 

 

 Allows you to make settings such as the size and the character. 

 Simulates the output state of the created information file. 

 

Basic operations 

Creating information 

This section describes the workflow from creating new information to saving it. 

 
 

1. Select Information Mark from the left pane of the Accessories Manager window, and then select the 

Custom list area. 

 

 

2. Click the  button. 

The New window is displayed. 

 

 

Operation 
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3. Enter a file name, and click the Create button. 

The Settings window is displayed. 

 

 

● Whole settings 

 
 

1. Set the size. 

In this example, set Width to 90, and Height to 30. 

 

2. Set the position where text printing should start. 

In this example, set X to 5, and Y to 20. 

 

3. Set the unit. 

In this example, select mm. 

 

4. Set any comments desired. 

Enter any comments (memoranda) in this area. 

 

● Style settings 

 
 

1. Click the Style tab. 

 

2. Set the font and font size. 

In this example, set Font to Arial, and Size to 12 Point. 

 

3. Set the text attributes. 

To output the text in bold, select the Bold check box. 

To output the text in italics, select the Italic check box. 

 

4. Click the Color Settings button to make text color settings. 

In this example, select All and set the density to 100%. 

 

5. Set the character and line pitches (the distances between individual characters and individual lines). 

In this example, set Char. Pitch to 0 mm and Line Pitch to 1 mm. 

 

  

Operation 

Operation 
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● Setting the signature 

 
 

1. Click the Fold tab. 

 

2. Set the style for the signature numbers 

In this example, set Style to Arabic Num. 

 

3. Set the signature text string. 

In this example, set Top String to front and Bottom String to back. 

 

● Setting the time and date 

 
 

1. Click the Date tab. 

 

2. Select a date and time style. 

In this example, select English. 

 

3. Set the exact format. 

In this example, the desired format is “Date & Time”, so select the Customize check box and enter %#c in the text 
box. 

 

 If there are no macros corresponding to the information text string, you can skip the settings in the 

Fold and Date tabs. 

 

● Exiting the settings process 

 
 

1. Click the OK button to close the “Settings” window. 
 

  

Note 

Operation 

Operation 

Operation 
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● Entering the information text string 

 
 

1. In the Information Editor window, enter the text string you wish to output. 

You can set the text in combination with macro strings, as shown below. 

 

 

 

● Using the simulation function 

 
 

1. Select the Simulation command from the File menu. 

The Simulation window is displayed, allowing you to simulate the output state of text. 

 

 

2. Click the  icon. 

The Simulation Properties window is displayed. 

 

Operation 

Operation 
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3. Enter the desired text in the text boxes. 

 

 

To simulate the output state of the job name, enter text in the Job Name field. 

Enter any text in other fields. 

 

4. Click the OK button in the Simulation Properties window. 

The results of the simulation are displayed in the Simulation window. 

 

 

● Saving the information 

 
 

1. Select the Save command from the File menu. 

The information file is saved. 

 

Operation 
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Imposition Configuration 

In the Imposition Configuration window, you can set the default insertion layer and positioning order for accessories. 

 

Layout of the Imposition Configuration window 

 

 

 Moves the accessory selected in the list below the signature layer into the list above 

the signature layer. 

 Moves the accessory selected in the list above the signature layer into the list below 

the signature layer. 

 Moves the selected accessory to the top in the list to which it belongs. 

 Moves the selected accessory up one position higher in the list. 

 Moves the selected accessory down one position lower in the list. 

 Moves the selected accessory to the bottom in the list to which it belongs. 

 

 • The upper and lower layers are located above and below the signature layer, and each contains 

3 layers that use Plate, Sheet, Fold Layout Area, and Fold as the positioning references for layout. 

• The order of the positioning references is fixed as follows. 

Upper layer: Sheet -> Fold Layout Area -> Fold 

Lower layer: Fold -> Fold Layout Area -> Sheet 

 

Note 
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Basic operations 

Imposition configuration 

This section describes the settings for the default insertion layer and positioning order for accessories. 

 
 

1. Make the imposition configuration settings using the window menu of the TotalFlow Simply Prepress 

Client. 

 

 

 

Operation 
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● Changing layers 

Follow the steps below to move a barcode that uses Plate as the positioning reference from the lower layer to the 

upper layer. 

 
 

1. Select a barcode that uses Plate as the positioning reference in the lower layer list, and click the  

button. 

The selected barcode moves into the upper layer list. 

 

 

 

Operation 
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● Changing the positioning order 

Follow the steps below to change the position of a color bar that uses Fold Layout Area (Sheet) as the positioning 

reference. 

 
 

1. Select a color bar that uses Fold Layout Area (Sheet) as the positioning reference in the lower layer list, 

and  click the button. 

The selected color bar moves to the position above the barcode. 

 

 

● Saving settings 

 
 

1.  Click the OK button. 

This saves the default insertion layer and positioning order settings you made. 

 

Operation 

Operation 
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7. Ticket Editing 

This chapter describes how to manage the tickets and the various processes that can be set for the tickets. 

 

 

Managing tickets 

In TotalFlow Simply Prepress, you can save the tickets to be used repeatedly as system shared tickets. The system 

shared tickets can be accessed and utilized during ticket import in the Action Plan window, as well as when tickets are 

issued manually. 

 

The ticket management window can be displayed from the Window menu of the main window. This window allows 

you to create new tickets, edit and delete existing tickets, and perform other management operations such as 

changing names. 

 

 

 Allows you to add a ticket. Clicking this icon opens the window for editing a new ticket. 

 Allows you to edit a ticket. Clicking this icon opens the window for editing the selected ticket. 

 Allows you to copy a ticket. Clicking this icon copies the selected ticket. 

 Allows you to delete a ticket. Clicking this icon deletes the selected ticket. 

 

In the ticket edit window, you can add a process to the ticket by dragging an icon from the process list in the left of the 

window and dropping it in the Workflow area. Each processing can be set in the setting area in the lower right of the 

window. 
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Action Plan settings and tickets 

Some of the setting items for the file output and recorder output processing are the same as the output settings in the 

Action Plan. As the settings in the Action Plan are used for these items, if you open the Ticket/Edit window via the 

output setting in the Action Plan, you cannot edit these setting items. Note, however, that this is not applied if the output 

processing is set in the input ticket. 
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Input  

The input function allows you to make settings for processing performed during input, such as origin offset, or spot 

color loading. 

 

Basic Setting 

This window allows you to set the PDF origin and the Offset origin. 

 

 

Use importing file information Check this checkbox to switch to high-speed processing mode using importing file 

information. Note that if you select high-speed processing mode, the options you 

can set become PDF Origin, Offset Origin, Plate (with restrictions), and 

thumbnails. Plate must be set to Other Spot colors. Spot colors cannot be 

converted to simulated CMYK colors. 

PDF Origin This setting allows you to load all of the box origins specified in the drop-down 

list when PDF data is imported. 

 MediaBox : Loads the PDF data using the media size. 

 BleedBox : Loads the PDF data using the bleed size. 

 TrimBox : Loads the PDF data using the trim size. 

Offset Origin This setting allows you to set the amount of offset from the origin of the finished 

page in the signature template file to the origin of the finished page file to be 

input, in the X and Y fields using a number up to 5 decimal places. 

Output Resolution This setting allows you to enter the final output recorder resolution, from 72 dpi to 

4,000 dpi using a number up to three decimal places. If you selected SPM for 

recorder output, enter that output resolution. 

Plate Double-click a plate to display the Plate Name Registration dialog box (you 

cannot edit the plate in this dialog box). Click Add to add a plate name. The 

Select Plate dialog box is displayed. See Note below for more information. 

Gray conversion This setting allows you to perform grayscale conversion during input processing. 

To perform grayscale conversion for all spot color separations, deselect Other 

Spot colors and One Arbitrary Spot Color from the plate for use. 



Input 

221 

Select Plate dialog box 

 

 

Add Select a plate to add from the Plate Name list (more than one plate can be 

selected), and click Add to add the plate to the Plate Name list in the Basic Setting 

frame. You can repeat these steps to add more plates. 

Add Spot Color Allows you to display the Plate Name Registration dialog box and set the simulated 

color values to register a new plate. 

Detail Allows you to display the Plate Name Registration dialog box and check the 

simulated color values. 

Delete Select the plate to delete from the Plate Name list and click Delete. A confirmation 

message is displayed. Click OK to delete the selected plate. 

Close Allows you to close the Select Plate dialog box. 

 

 Spot Color Filter 

The Spot Color Filter frame allows you to change a spot color’s plate name by modifying the following settings. 

 

 

Original Color Name This allows you to display the name of the spot color plate. To add a plate name, 

click Add to display the Original Color Name dialog box. For details, refer to the 

Note below. 

Adjusted Color Name Click Adjusted Color Name to display the plate names registered in the Plate field 

in Basic Setting. Select an adjusted plate name. 

Adjust PANTONE Color Name Check this to change a “CVC” or “CV” character string added to a plate name to 

“C”. 
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Original Color Name 

 

 

Add Select a plate to add from the Plate Name list (more than one plate can be 

selected), and click this to add the plate to the Original Color Name list in the Spot 

Color Filter frame. If you added process color plates in the Original Color Name 

list, the plates you can select for Adjusted Color Name are only spot color plates. 

You can repeat these steps to add more plates. 

Add Spot Color Allows you to display the Plate Name Registration dialog box and set the simulated 

color values to register a new plate name. 

Detail Allows you to display the Plate Name Registration dialog box and check the 

simulated color values. 

Delete Select the plate to delete from the Plate Name list and click Delete. A confirmation 

message is displayed. Click OK to delete the selected plate name. 

Close Allows you to close the Original Color Name dialog box. 

 

Overprint 

Overprint allows you to select how to load overprint settings specified in DTP applications. 

 

 

Import DTP Overprint information Select this to load overprint settings. 

 Use Process Color 

Settings 

: Select this to load overprint settings specified for 

process colors. 

 Use Spot Color Settings : Select this to load overprint settings specified for spot 

colors. 

 Use White Color 

Settings 

: Select this to load overprint settings specified for 

white. 

Automatic Overprint for Bk 100 Specifies what is to be overprinted automatically during input. 

 None : Select this if you do not want the system to 

automatically apply overprinting. 
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 Tint&Text : Select this if you want the system to automatically 

overprint K = 100% tints and K = 100% text in the file 

to be imported. 

 Text : Select this if you want the system to automatically 

overprint K = 100% text in the file to be imported. 

 

 Import DTP Overprint Information 

• If Illustrator 9.x or 10.x transparency effects were set, be sure to turn on all of the 

options. When all of the options are selected, set None for Automatic Overprint for Bk 

100. 

 

Action 

The Action frame allows you to make settings for font embedding and bilinear downsampling of images. 

 

 

Embed Font Check this to embed fonts used in the PDF file to be output. 

Delete Blank Pages Check this to delete blank pages within the PDF file to be output. 

Delete Custom Transfer 

Function 

Check this to delete custom transfer functions from the PDF file to be output. You can 

check the Text & Illustration checkbox and the Image checkbox. 

Delete Custom Halftone 

Function 

Check this to delete custom halftone functions from images in the PDF file to be 

output. You can check the Text & Illustration checkbox and the Image checkbox. 

Delete Custom BG/UCR 

Functions 

Check this to delete custom BG/UCR functions from the PDF file to be output. You 

can check the Text & Illustration checkbox and the Image checkbox. 

Add Thumbnails Check this to add thumbnails to the PDF file to be output. 

Correct Hairline Check this to correct hairlines, and then set a lower limit for the line point size in the 

Adjustment field. If you want lines that are the same weight or lower than the point 

size entered in the field, click the Delete radio button. If you want to correct those 

lines, enter a line weight in the Adjustment Width entry field. 

Important 
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Bilinear downsampling of 

image 

Check this to convert the resolution of images included in the PDF file to be output 

to a specified resolution. You can make separate settings in the Color, Gray and 

1bit fields. 

 

PitStop 

Set the PitStop operations. You can set the PitStop profile, PitStop action, and Certified PDF authentication. 

 

Description of a PitStop Profile 

A PitStop profile is a preflight settings file for a PDF file created by or used with Enfocus PitStop Professional. 

With Polished Input, this preflight settings file can be used to execute preflight processing. 

 

 

Use Preflight Check this to perform preflight using a PitStop profile. 

PitStop Profile Allows you to select a PitStop profile from the dropdown list. 

Execute PitStop Action To run a PitStop action for the input PDF file, select this check box, press the Add 

button, and then add an action to be run. 

Certified PDF Authentication Check this to authenticate Certified PDF. Click the Setting button to display the 

Certified PDF Authentication dialog box. You can change the conditions applied to 

the profile displayed in the list by clicking one of the radio buttons under 

Conditions. 
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Standard Included PitStop Profiles 

Preflight Name Description 

DS_PDFX-1a_Fixed With this file, the profile has been tested for problems and the problems have been 

corrected in accordance with PDF/X-1a. If a problem that cannot be corrected is 

detected in the PitStop profile, an error is displayed. 

DS_PDFX-3_Fixed With this file, the profile has been tested for problems and the problems have been 

corrected in accordance with PDF/X-3. If a problem that cannot be corrected is 

detected in the PitStop profile, an error is displayed. 

DS_PDFX-4_Fixed With this file, the profile has been tested for problems and the problems have been 

corrected in accordance with PDF/X-4. If a problem that cannot be corrected is 

detected in the PitStop profile, an error is displayed. 

Standard This is a PitStop profile that is set when creating a new profile. The profile is tested 

for problems, and all problems are displayed as warning messages. 

Generic_PrePress This is a PitStop profile for testing generic prepress and printing files. An error 

occurs if an RGB color inappropriate for prepress or printing or a color for which 

there is no embedded profile is used. 

Note: These colors are automatically converted to CMYK by the initial color 

conversion settings, so an error does not occur. Use this with a setting that 

does not perform color conversion. 

 

 ● How to add a PitStop preflight profile 

You can use preflight profiles created in PitStop Professional by registering them in TotalFlow 

Simply Prepress. 

Add a PitStop preflight profile to the "PreflightProfiles" in "PrefInput" shared folder, and then restart 

the TotalFlow Simply Prepress service. The preflight profile will be available for selection on the 

TotalFlow Simply Prepress Client. 

 

Standard included PitStop action files 

Action Name Description 

Sample Allows you to add a “Confidential” stamped to every page in the PDF file being 
processed. 

Check NotEmbedded Font When you select this option, fonts that are not embedded are displayed in purple. 

Image 

toJPEG(MaximumQuality) 

Color and gray images in the PDF file are converted to JPEG-compressed images. 

_AdjustTrimBoxV1 The TrimBox value is set again by recognizing the trim mark in the PDF file. 

 

 ● How to add a PitStop action file 

You can use action files created using PitStop Professional. Add the action file to “ActionFiles” in 
the “PrefInput” shared folder, and then restart the TotalFlow Simply Prepress service. 

● Bilinear downsampling is a way of reducing the resolution of an image using an algorithm called 

"Bilinear" (averaging).Pixels are lost when you lower the resolution, so this allows you to reduce 

the amount of data. However, because the number of pixels is reduced, the quality of the original 

image deteriorates. 

 

  

Note 

Note 
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 About the _AdjustTrimBoxV1 action that adjusts the TrimBox value again 

The _AdjustTrimBoxV1 action recognizes the trim mark in the PDF file. This action runs when the trim mark satisfies the 

following conditions. 

 

Trim mark length Less than 14 mm (40 pt) 

Trim mark color The color spaces are within the following range. 

CMYK CMYK (All): 100% 

CMYK CMY: 0%, K: 100% 

Separation Black 

Gray: 100% 

Registration (All): 100% 

Trim mark position The trim mark (corner mark) is a line attribute. 

The vertical position error of the horizontal register mark is less than 2.7 

point (approx. 1 mm). 

The horizontal position error of the vertical register mark is less than 2.7 

point (approx. 1 mm). 

Trim mark shape Recognizable corner marks are as shown below. 
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Certified PDF Authentication Dialog Box 

 

 

Profile Displays a list of the preflight profiles referenced during certified PDF 

authentication. 

This list contains the same preflight profiles listed under the “Preflight” tab. 

Conditions This setting sets the authentication conditions for the selected preflight profile. 

• The certified PDF profile must be equivalent to this profile: Authentication is 

successful only if the preflight settings included in the certified PDF are exactly the 

same as the settings of the preflight profile specified here. 

• The certified PDF profile settings must be stricter than the settings in this profile: In 

addition to checking whether all of the option settings are equivalent, other 

settings are checked and the data is certified after a stricter check. 

• This profile is not used in the certified PDF authentication: The corresponding 

preflight profile is not referenced for authentication conditions. 
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 Certified PDF Authentication 

When “Certified PDF Authentication” is checked, only a certified PDF can be input. Authentication is executed only for 
the input certified PDF. A certified PDF includes the PitStop preflight profile used when the preflight was run. That 

profile and the profile listed here are checked according to the specified condition, and when they match, the 

authentication is successful and the processing is continued. If they do not match, the processing ends in an error. If 

multiple profiles are listed, authentication is successful and the processing is continued as long as any one of the 

profiles matches under the specified condition. 

 

Input File Type Certified PDF Status Processing 

PDF - Program ends in an error. 

Certified PDF Preflight profile that is not compatible 

with the criteria is used 

Program ends in an error. 

Certified PDF Preflight profile that is not compatible 

with the criteria is used 

Processing continues as certified. 

 

 Refer to the conditions described in the Certified PDF Authentication dialog box to check 

compatibility. 

 

 • PitStop Professional must be purchased separately in order to make corrections to a 

PitStop profile or create a new profile. 

• Verifying Preflight Results 

PDF Output Tab The preflight report file output to the folder shown as the error 

report output destination. 

The preflight report file output to the folder shown as the normal 

report output destination. 

Progress Display Results are included in the Input processing report (Optimization) 

or the Input processing report Preflight error (Optimization) items 

in the items referenced from the event list in the processing/End 

viewer list in the Progress window. Please see the information 

about testing and corrections under Preflight for additional details 

about events. 
 

• If Fix is set for all of the Preflight options, they are fixed regardless of the Error and 

Information choices. 

 

 ● Conditions for Outputting in PDF/X-1a Format 

Setting “DS_PDFX-1a_Fixed” for the PitStop profile makes it possible to generate PDF files compliant 
with the PDF/X-1a standard. However, the data is not fixed in a way that affects the way the 

reproduction appears to the eye. If you want to fix the data in a way that changes the way it 

appears to the eye, change the action settings or color conversion settings as necessary. The 

following options are available. 

• Custom Transfer and Custom Halftone functions must not be used. 

In the Action tab, make the necessary settings for deleting these functions. These settings are not 

made when a new file is created, so please make the settings when necessary. 

• Only CMYK, gray or spot colors can be used. 

In the Color Conversion tab, convert the image to a color type that can be used. This setting is 

preset when a new file is created, so the file can be used without further modification. 

 

Note 

Important 

Note 
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Error Check 

 

 

Ignore Font Error No error is activated and the processing is continued even if no fonts are 

embedded. 

Treat as error when output 

intent does not match following 

profile 

An error is activated and the processing is not continued if the output intent set in 

the input data is not the same as the one specified below. 

Treat as error when PDF with 

following color space is 

detected 

An error is activated and the processing is not continued if the PDF includes an 

object that corresponds to the color setting specified below. 

Treat as error when following 

files are input 

An error is activated and the processing is not continued if the format of the input 

file is one of the formats checked below 

  

PDF Output 

The PDF Output frame allows you to make settings for PDF output. 

 

 

Output File Name Allows you to specify a name for the file to be output. You can directly enter the file 

name or select a combination of the macros from the pull-down list. You can also use 

the macros when you directly enter the file name. For more information, see “Output 
File Name Macros”. 

Output PDF Check this to output the PDF to the folder specified in Output Path. You can click the 

Browse button to select a folder from the Output Path Setting dialog box or create a 

new path. 

Output Error Report 

(Include Output PDF) 

Check this to output a preflight report on errors as well as the PDF to the folder 

specified in Output Path if an error occurs. If an output PDF is being output, “Output 
PDF” must also be checked. 
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Output Normal Report Check this to output a normal report as well as the PDF to the folder specified in 

Output Path. You can click the Browse button to select a folder from the Output Path 

Setting dialog box or create a new path. If you click the Same as PDF button, the 

same output path that is set in Output Path is set as the output path for the normal 

report. Check this to output a normal preflight report as well as the PDF to the folder 

specified in Output Path. 

Report Type Shows the type of report to be output. 

 Preflight PDF Report ： Outputs only a Preflight report containing PitStop 

errors. 

 Event Text Report ： Outputs a report containing the content of the event 

log. 

 Both Reports ： Outputs both a Preflight PDF report and an event 

text report at the same time. 

 

 The event log that appears in the event text report is the same as the [Results] report in the Event 

Details dialog box. 

 

 ● Output file macros 

- %n%N:Base file name (name of the import file without the extension) 

 

- %p,%P: Page number. 

If there is more than one page, this is always “PAGE1”. 
 

- %t, %T: Output time 

Example: September 30th at 8:11:00 becomes “Sep30_20h11m0s”. 
 

- %l%L: Date and time of output (short form) 

Example: September 30th at 8:11.00 pm: “0930201100” 

 

- %c%C: Sequential numbering 

 

You can use this with the macros described above. 

 

  

Note 

Note 
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Other 

The Other frame allows you to make blank plate auto detection settings. 

 

 

Blank Plate Auto Detection Select this setting if you want for the system to automatically delete and eliminate 

unnecessary plates on import files from output. This is only enabled when the import 

file is a composite PS file or a PDF file. 

Rotate Allows you to specify the rotation angle of the input file when pages are assigned. 

Treat as Generic PDF Outline 

PDF Outline 

PDF-Advance/OutlinePDF 

Select this check box to treat the input Outline PDF-Advance/OutlinePDF files as 

general PDF files and run various input processing functions. Normally leave this 

check box unselected because the prepress processing of these PDF files has 

already been completed. This check box should be used only when a PDF file 

needs to be modified. 

Make the PDF best for the 

cache of RIP. 

Caches the parts to be reused so that the PDF is optimal for RIP processing. If this 

check box is selected, the input processing is a little slower, but the performance of 

the RIP processing improves. If this check box is not selected, the input processing is 

fast, but the RIP processing may be slow. 

 

 • TP-X is a QuarkXPress extension that imports document information that was specified in 

QuarkXPress into TotalFlow Simply Prepress. If you install TP-X in advance, you can match page 

origins automatically and pass document information to TotalFlow Simply Prepress. TP-X 

automatically activates this function when a file is imported into TotalFlow Simply Prepress. It is also 

possible to use the spot color specification function to separate colors used in QuarkXPress into 

process colors. 

• When the Outline PDF-Advance/OutlinePDF check box is selected, even if Outline PDF is selected 

as an error under Treat as error when following files are input in the Error Check frame, the Outline 

PDF files are not treated as error but are treated as general PDF files. 

• The Make the PDF best for the cache of RIP function is enabled only when data is output from the 

Truepress Jet series printers. It is disabled for other output processing, such as DotTIFF output and 

recorder output. 

 

 

Note 
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Auto-trap  

The Auto-trap function allows you to make settings for trapping. 

 

Basic Setting 

The Basic Setting frame allows you to set the trap width and trapping rules for spot colors and objects. 

 

 

Trap Width Allows you to set trap widths. 

 Basic : Allows you to enter a trap width for basic objects. 

 Black : Allows you to enter a trap width for black objects 

(tints, text, strokes). The black objects for which this 

setting is made are objects whose K separation value 

is higher than the value set in Black Threshold Values 

for Black & Kickback in the Details dialog box, as 

well as other separations with a value lower than 5%. 

Setting the trap widths for Basic and Images to 0 mm 

and setting only the black width allows you to add 

traps to black objects alone. 

The setting range is 0.0mm to 100.0mm. 

(You can set up to one decimal place.) 

 Images : Allows you to enter a trap width for images. 
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 Kickback : Allows you to enter a value to set the trap width for 

objects with kickbacks (pullback width). Kickbacks 

are created when there are color objects including a 

K separation with a value of 95% or higher, as well 

as other separations with a value of 5% or higher. 

However, objects that include only a K separation 

with a value of 95% or higher, where all of the 

separations are 100% are excluded. 

You can modify the threshold value for the K 

separation to be kicked back with Black Threshold 

Values for Black & Kickback in the Details dialog box. 

 Text : Text that is smaller in point size than the value entered 

in the Text < field is trapped using the trap width set in 

the Trap field. 

 Trap : Allows you to enter the trap width for text that is 

smaller in point size than the value entered in the Text 

< field 

Outline Tint Allows you to set up white outlines around text. 

 None : Select this if you do not want white outlines around 

text. 

 Text : Select this if you want white outlines around all text. 

 Text (K 100) : Select this if you want white outlines around all K = 

100% black text only. 

 Width : Allows you to enter the width of the white outline. This 

is only active when you are placing white outlines 

around objects. 

 For Images : Check this to place white outlines around text that 

overlaps images. 

Rules for Spot Colors Allows you to set up the trapping rules for the spot colors you are using. This rule 

is applied if the object consists of one spot color. If Auto-trap rules have not been 

set for spot colors, all of the rules are applied to the process colors. 

 Color Name : Shows the name of the spot color. 

 Rules : Allows you to select a trapping rule for the specified 

spot color from the drop-down list. 

 Width : Allows you to enter a trap width for the spot color. 

 Add : Click this to display the Color Name list. Select the 

spot color you want to trap (you can select more than 

one) and click Add to add the spot color to the Color 

Name list under Rules for Spot Colors. 

 Delete : Select a spot color displayed in the list and click 

Delete to remove the selected spot color from the list. 

Object Rules Allows you to set rules for trapping between images and text and between 

images and tints (stroked objects). 
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 Text to image : Allows you to select a trapping rule from the 

pulldown list. When you check the Include gradation 

in images checkbox, the trapping conditions applied 

to images and text are also applied to gradients and 

text. 

 Tint to image : Allows you to select a trapping rule from the 

pulldown list. When you check the Include gradation 

in images checkbox, the trapping conditions applied 

to images and tints are also applied to gradients and 

tints. 

 Upper image to lower 

image 

: You can select None, Spread, Choke, Center, or 

Auto from the pulldown list as the direction of the 

traps between images and images. 

 Include gradation in 

images 

: Check this checkbox to apply the selected rule to 

gradients and images (patterns). 

 

Varnish separations (about the Transparent option in Rules for Spot Colors) 

This trapping option is available so that it is possible to leave the varnish separation untrapped while trapping the 

objects below the varnish separation. If you do not select the Transparent option, the objects below the spot color 

separation are not trapped. 

 

Object Rules 

If you select Choke or Spread in Objects Rules and the Centerline Luminance Threshold option is turned on so that the 

objects over the images are trapped from the centerline, the object trapping rule will change to Centerline. This is to 

prevent jaggies in the trap objects. 

 

Rules for objects that overlap images 

This section describes the image rules for data containing an image (CMYK image) overprinted by text (M100%). 

Example) 

• Data contains image (CMYK image) and text (M100%). 

• Details frame settings: Both Do not trap if there is a shared separation with a screen percent higher than and Include 

images are unchecked. 

 

● When Text to image is set to None 

→ No trap will be generated between the text and the image. 
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● When Text to image is set to Spread 

→ The text spreads onto the image. 

This setting is suitable for data with a bright color text over a dark image. However, if a dark color text is placed on a 

bright image, the trap results will be undesirable. 

        

 

● When Text to image is set to Choke 

→ The image is hidden under the text. 

This setting is suitable for data with a dark color text over a bright image. However, if a bright color text is placed on a 

dark image, the trap results will be undesirable. 

           

 

● When Text to image is set to Center 

→ Trap is generated having the outline for text as the center line (the line is displayed in green in the following 

example). 

This setting should be used when it is difficult to specify a trap direction against the image. 
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● When Text to image is set to Auto 

→ This setting should be used when it is difficult to specify a trap direction against the image. When you select Auto, 

the trap direction is determined automatically according to the computation of the color on the edge of an image. 

In the figure below, the upper text is processed with Choke and the lower text is processed with Spread. 

However, the middle text is processed with both Choke and Spread because the difference of brightness between the 

text and image is slight. 

 

 

As shown below, the processing with Auto chokes “t”, “r”, and “p” in the text and spreads “a”, therefore the resulting 
text does not look consistent. 

If this occurs, the trap direction for “a” must be corrected to Choke. 
After the trapping with Auto, be sure to check the result and correct the trap direction as necessary. 
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Details 

The Details frame allows you to set up trap restrictions and indeterminate trapping rules. 

 

 

Do not trap image masks Check this checkbox to skip trapping with image masks that take a long time to 

process. Normally, we recommend that you leave this checked. Traps are also 

not created for objects, other than image masks, comprised of paths containing 

40,000 or more points. 

Do not trap if there is a shared 

separation with a screen percent 

higher than 

If you check this checkbox, the separations used in the objects to be trapped are 

compared and the objects are not trapped if two objects share one or more 

separations with a value higher than the specified dot percentage. 

 Tint : Allows you to enter a threshold (dot percentage) that 

determines the objects to be trapped. If the shared 

value is higher than the specified dot percentage, the 

two objects are determined as sharing separations 

even if the same separation is used by the two 

objects. 

 Include Images : Check this to apply the threshold that determines the 

objects to be trapped to images as well. Note, 

however, that images and tint objects will not be 

trapped regardless of the threshold setting, even if 

they share a separation. 

Trap Threshold Allows you to set threshold values for each of the CMYK separations to determine 

which objects will not be trapped. See “Trap Thresholds” under Note below for 
more information about setting threshold values. 

Indeterminate Trapping Rules When you check this checkbox, if there is even one separation in the object to be 

trapped with a dot percentage over the threshold, indeterminate trapping is used. 

Set threshold values (dot percentages) for “Text”, “Stroke” and “Tint”. 
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Trap-width/line-width ratio limit If you are trapping stroked objects, enter a trap width threshold value if the 

objects do not have sufficient width with respect to the set trap width. The trap 

width becomes the “Maximum line width x entry value”. This is only active if the 
checkbox is checked. 

Do not trap if the trap width is 

less than 

Check this to prevent trapping if the trap width is less than the specified value. 

Centerline Luminance Threshold Allows you to enter a standard for comparing the brightness ratios of the objects 

during trapping. If the ratio difference is lower than the value entered here, center 

trapping is used. This is only active if the checkbox is checked. 

Trap Color Reduction Trapped colors may appear darker because the colors of the trapped objects are 

merged. Use trap color reduction when it is necessary to control the trap colors. 

Check this checkbox to reduce the dot percentages in the trap colors using the 

values (%) set for each separation. See the Note below for more information. 

Black Threshold Values for Black 

& Kickback 

Allows you to enter a K separation threshold value that defines black. This sets the 

trap width for black objects. If you specify 95%, the trap width for black objects is 

applied to objects with a K separation of 95% or higher. This value is also 

applied to the K threshold value for kickback processing. In other words, 

kickbacks are created for objects that have a K separation of 95% or higher and 

another separation that is 5% or higher. 

The setting range is 0.0% to 100.0%. 

(You can set up to one decimal place.) 

 

Determinate Trapping 

TotalFlow Simply Prepress searches for overlapping objects and traps only those objects that are overlapping. The 

color of the trap object is the maximum blend for tints, stroked objects and text. The drawback to creating very fine 

traps is that processing takes a long time. 

 

Indeterminate Trapping 

TotalFlow Simply Prepress creates simple traps such as chokes and spreads around the objects to be trapped. 

Trapping is very fast. The trap color is an overprint blend. If light colors are given overprint priority, the colors below 

are reduced. As a result, if you use indeterminate trapping, only colors above the threshold value are hidden (colors 

below the threshold value are made 0% and overprinted). 

 

Trap Thresholds 

Trapping is not performed in the following cases. 

- The halftone dot percentage difference for the area between the objects for all separations is less than the trapping 

threshold (i.e. areas with similar colors). 

- The halftone dot percentage for all separations is less than the trapping threshold (i.e. areas with light colors). See 

the following examples. 

Example 1: If the trapping threshold is set to 10%, the objects are not trapped because the Object 2 dot percentages 

are lower than the threshold. 

Separation C M Y K 

Tint % for Object 1 55 53 10 0 

Tint % for Object 2 8 5 0 0 
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Example 2: If the trapping threshold is set to 10%, the objects are not trapped because the differences between the tint 

percentages are lower than the threshold. 

Separation C M Y K 

Tint % for Object 1 55 53 10 0 

Tint % for Object 2 48 50 8 0 

Tint % Difference 7 3 2 0 

 

Trap Reduction 

If the object to be trapped is a tint, text or stroked object and you are using determinate trapping, the hidden objects 

(lighter colors) are reduced and the trap is created with the maximum color blend. For example, if the reduction value 

for all separations is 40% (the coefficient is 100% - 40%), the reduction is made as shown below. 

Separation C M Y K 

Color 1 (Light Color: Hidden Objects) 0 20 50 0 

Color 1 x Coefficient (60%) 0 12 30 0 

Color 2 (Dark Color) 60 0 20 50 

Trap Color 60 12 30 50 

 

Options 

The Options frame allows you to set kickback and spot color rule priorities as well as trap intersection shapes. 

 

 

Enable kickbacks on traps 

between white text (tints, strokes) 

and images. 

Check this to create kickbacks for separations other than the K separation within 

images if there are objects on top of the images for which the C, M, Y, K and spot 

color separations are all 0%. 

Black Threshold Value for Image 

Kickback 

Allows you to enter a threshold value for the K separation for image kickbacks 

(the K separation pixels are left and the other separations are reduced). 

The setting range is 0.0% to 100.0%. 

(You can set up to one decimal place.) 
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Pixel Threshold Values for Image 

Kickback 

Allows you to enter a percentage of pixels for areas where kickbacks will be 

created that is the same or greater than the value specified in Black Threshold 

Value for Image Kickback. If this percentage is the same or greater than the value 

specified in Pixels Threshold Value for Image Kickback, kickbacks are created. 

The setting range is 0.0% to 100.0%. 

(You can set up to one decimal place.) 

Kickback and Spot Color Rule 

Priorities 

Allows you to select a priority order for kickback and spot color trapping rules. 

 Give priority to kickback rule. Check this to use kickback rule. 

 Give priority to spot color rule when 

spot color objects overlap kickback 

objects. 

Check this when spot color objects are 

placed over kickback objects and when 

generating traps using the spot color 

rule. 

 Give priority to spot color rule. Check this when trapping spot color 

objects by using the spot color rule. 

Trap Intersection Shape Allows you to select from Round, Beveled and Mitered for corner processing 

when trapping intersecting areas of objects such as lines. See Note below for 

more information. 

 

Kickback and Spot Color Rule Priorities 

 

 

 

 

 

 

Spot color objects 

Kickback object 

Original status 

Kickback rules are 

applied. 

Kickback rules 

are applied. 
Spot color rules 

are applied 

Kickback rules are 

applied. 

Give priority to kickback 

rules is selected 

Give priority to spot color rule 

when spot color objects 

overlap kickback objects is 

selected 

Give priority to spot color rule 

is selected 
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The differences between Round, Beveled and Mitered trap shapes are illustrated below. 

 

 

 

If you select Mitered, you must set a limit for how far the pointed angle extends out when the object is trapped. If the 

length of the mitered area is longer than the “trap width (line weight) x limit value” the corner will be cut off. The lower 
the limit, the less the angle is extended out. If you set “1” as the Miter Limit, the trap will be the same shape as if you 
had selected Beveled. 

Limit value＝ 
Miter length 

Trap width 

 

 

 

 

 

 

 

 

Round Beveled Mitered 

Within the miter length Over the miter length 

Trap width Trap width 

Miter length 

Miter length 

Point of the angle is not cut off. Trap shape is beveled. 
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Speed and Quality 

The Speed and Quality frame allows you to set speed and quality rules for trapping. 

 

 

Trap refers to overlaps of upper 

objects 

Check this checkbox to reduce the processing that creates unnecessary traps. 

However, the trapping process may become long depending on the data, due to 

the amount of required computation processing. 

Prevent jaggies in the trap objects Check this checkbox to correct trap objects along the edges when there are many 

background objects intersecting on the diagonal so they look smooth. 

Image Trap Composition Allows you to set how to create composites for traps between images and 

colored objects. See the following for more information. 

 MAX : Traps using the higher density color between 

the objects. This produces better results than 

Overprint, but trapping takes longer. 

 Overprint : Makes traps between images and colored 

objects by overprinting the colored objects. 

Image Trap Resolution Creates trap objects for images using images. This option sets the resolution of the 

images for the trap objects. If the resolution is high, the size of the PDF file after 

trapping may become very large. If the trap width for the image is small enough, 

72 dpi is sufficient. 

 Apply the resolution of the 

object 

: Creates the trap object using the same 

resolution as the image that is being trapped. 

 Assign Resolution : Creates the trap object using the resolution 

specified in the textbox. 

The input range is 40 dpi to 1000 dpi. 

Trap mode for Transparency Allows you to set a trapping mode for transparent objects. 
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Create traps on objects affected 

by Drop Shadow. (Mode 1) 

Check this checkbox to take drop shadows (blurs, shadows) into account when 

trapping. Areas set with other transparency effects are not trapped. 

Create traps on all transparent 

objects. (Mode 2) 

Traps all objects for which transparency effects are set (the trap width is the value 

set in Basic). Note that depending on the data, this may not be desirable from a 

design standpoint, so you must check the results. The trapping time also becomes 

longer. See the following settings for more information. 

The number of sample points : Allows you to specify the number of points 

used to calculate the color on the edge of a 

transparent object. You can set a value 

between 1 to 100 points. 

Resolution for getting the color : Allows you to specify the resolution used to 

calculate the color on the edge of a 

transparent object. The higher the resolution, 

the better the quality, but the trapping time 

becomes longer. You can set a value between 

72 to 2400 dpi. 

The maximum number of 

relationship objects 

: If the total number of objects that are located 

on top of transparent objects as well as 

surrounded by transparent objects exceeds 

the value set here, those transparent objects 

are not trapped. 

The input range is 0 to 9999. 

Settings for getting relationship 

objects 

Allows you to set the resolution and the choke / spread width for related objects. 

Resolution Allows you to specify the resolution for calculating the related objects for 

trapping. You can set a value between 72 to 2400 dpi. However, if some small 

text and objects are not trapped, we recommend changing the resolution to a 

finer value (400 dpi or higher). 

Locate Trap Object / Choke & 

Spread Width 

Use this if objects are not trapped because there are tiny gaps between the 

objects. It chokes or spreads the objects according to the value you enter and 

locates the trap objects. You can set a value between -0.01 and 0.01 mm, using 

up to five decimal places. 

 

Trap refer to overlaps of upper objects 

Processing is performed as shown below when the Trap refers to overlaps of upper objects option is turned on. As 

shown in Figure A, if multiple objects, including knocked-out objects, overlap each other, there are times when 

unwanted trap objects are generated (Figure B). Check this checkbox to prevent unwanted trap objects from being 

generated. 

 

 

Figure A Figure B 

Unwanted trap objects 

Trapping results: M separation Three overlapping objects 
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Maximum blend and overprint blend for images and color objects 

[Result of maximum blend] 

An image and color object are blended with MAX selected and the blended image is trapped. Blending is performed 

based on the higher density color between the image and color object. This produces better results than Overprint. 

 

 

[Result of overprint blend] 

When objects are blended with Overprint selected, a color object overprints an image and the blended image is 

trapped. 

As shown in the figure below, the area in which the image and color object overlap may appear lighter, because the 

image color is covered by the color of the overprint color object. 

 

 

  

Blended area (MAX) 

Blended area (MAX) 
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Image trap resolution rules 

● When the Apply the resolution of the object radio button is turned on 

 

Result with Apply the resolution of the object selected (maximum blend) 

 

● When resolution is entered for Assign Resolution 

 

Result with Assign Resolution set to 72 dpi (maximum blend), trap width: 3 mm 

 

When images with different resolutions are trapped, a lower resolution is used. 
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About locating trap objects 

Trap objects are computed and located by picking out the parts of objects in the page file that are abutting. If there is 

even a tiny space between neighboring objects, there is no abutting area so no trap object is located. When you want 

to trap these types of objects, the Locate Trap Object option temporarily spreads abutting objects before locating trap 

objects so they will abut and their trap objects can be located. 

 

 

 

 

There are two ways to locate trap objects. You can enter either a positive or a negative number into the Locate Trap 

Object option field. 

This is described using the example of abutting objects shown below. 

In this example, A is the foreground trap object and B is the background trap object. 

 

 

No trap object can be 

located because the 

objects are not 

abutting. 

A trap object can be located 

because the objects abut 

once they have been spread. 

When the Locate Trap Object checkbox is 

not checked. 

When the Locate Trap Object checkbox is 

checked. (Input value) 
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If you enter a positive number into the Locate Trap Object option field, object A is spread only by the value entered in 

order to locate the trap object, which is the hatched area in the figure below. 

The dotted line in the figure above shows how object A was spread. 

The trap direction is A over B. 

 

 

In contrast, if you enter a negative number into the Locate Trap Object option field, object B is spread only by the 

value entered and the trap object is located as the object in the hatched area in the figure below. 

 

The dotted lines in the figure above show how background object B was spread. 

The trap direction is A over B. 

 

 

The dotted lines in the figure above show how background object B was spread. 

The trap direction is A over B. 
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Output Folder Name Macros 

When you output a file, you can use combined macros for specifying the output folder name. Using macros allows 

you to include variable information for each job or processing in the file name without changing the ticket. 

 

The following macros can be used for output folders. These macros are common to each output processing, and a 

macro can be used in combination with another one. 

 

%j, %J Job name and section name 

Allows you to set whether or not to include the section name for the system setting. 

%b, %B Job ID (order code) 

 



Output File Name Macros 

249 

Output File Name Macros 

For each file output, a macro can be included in the instructions regarding the output file name. By using the macros, 

the information variable for each job and processing can be included in the file name without changing the ticket. 

 

The macros available for output file names are shown below. These macros are common for all output processes and 

you can combine them for use. 

 

%n, %N Input file name (excluding extensions) 

For signature output, the name of the file placed lowest is used (excluding 

accessories). 

%j, %J Job name and section name 

Allows you to set whether or not to include the section name for the system setting. 

%o, %O Signature number 

Example: 

First signature: “FOLD1” 

25th signature: “FOLD25” 

If there are multiple signatures, these are replaced by “FOLDn”. 

%f, %F Front is replaced by “FRONT” and Back is replaced by “BACK”. 

%p, %P Page number 

Example: 

First page: “PAGE1” 

142nd page: “PAGE142” 

For fold output, the lowest page number will be assigned. 

%p+, %P+ Folio marks 

These will be replaced by the folio marks that have been set for each page. 

%t, %T Output time 

Example: September 30th at 8:11:00 becomes “Sep30_20h11m0s”. 

%l, %L Output time (short form) 

Example: September 30th at 8:11:00 becomes “0930201100”. 

%c, %C Consecutive numbers 

A serial number is added to the computation execution time, so the format becomes 

“MonthDay - Serial Number”. 
Example, if the date is September 30th and this is the fifth computation within the 

job being processed, the number becomes 

“0930-0005”. 

%w, %W JDF-JOB/PJTF input file name (excluding extensions) 

%b, %B Job ID (order code) 

 

 For %p and %P macros, the expansion result varies depending on the processing in which the 

macro is used. 

- For file registration (input processing): PDF page numbers 

- For page proof: Page numbers with respect to the entire job 

- For output workflow: Page numbers in the section 

The output workflow indicates all workflows that are set in the section. 

- For JDF-JOBin: In accordance with the workflow used for creating the JDF-JOB 

When JDF-JOB output has been set in the page proof workflow, the macros are expanded to the 

page numbers with respect to the entire job. However, when JDF-JOB output has been set in the 

output workflow, the macros are expanded to the page numbers in the section. 

 

Note 
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OutlinePDF-Advance  

OutlinePDF-Advance is a plug-in that converts imported files to OutlinePDF-Advance files. 

 

Basic Setting 

The Basic Setting frame allows you to make settings such as the output file name and compression mode. 

 

 

File Name Allows you to specify a name for the file to be output. You can directly enter the file 

name or select a combination of the macros from the pull-down list. You can also 

use the macros when you directly enter the file name. For more information, see 

“Output File Name Macros”. 

Output Path Allows you to specify the path where the output file is saved. Enter the path directly, 

or click Browse to select a folder from the Output Path List dialog box. You can add 

a new folder by clicking the New button to display the Add New Folder dialog 

box. 

Image Compression Type Allows you to set the compression mode when compressing images. 

You can select Keep Compression Type, JPEG or ZIP. If you select Keep 

Compression Type, the PDF file is created using the same image compression mode 

that was used in the input PDF. 

It is also possible to use macros. For more information, see “Output Folder Name 
Macros”. 

JPEG Allows you to set the image compression quality if you select JPEG as the image 

compression mode. The higher the image quality, the lower the amount of 

compression, and the lower the image quality, the higher the amount of 

compression. 

Preview Allows you to specify whether or not to attach a preview file to the output PDF. To 

attach a preview file, check this checkbox and specify a resolution in Preview 

Image Resolution. 
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Finish 

The Finish frame allows you to make output area and register mark settings. 

 

 

Output Area Allows you to select the output area of the imposition. 

 Film Imposition : Outputs an area that includes the finished area and 

the prepress margins. Make these settings in the Basic 

Setting tab in the Edit Template dialog box. 

 Plate Imposition : Outputs the entire plate area. Make these settings in 

the Plate Setting tab in the Edit Template dialog box. 

 Divided Imposition : Divides output. Make these settings using Divide of 

Fold Catalog Editor. 

Division Type Half (Upper & Lower) : Divides the output area into two sections (upper and 

lower) using the dividing line specified in the fold 

catalog. 

 Half (Left & Right) : Divides the output area into two sections (left and 

right) using the dividing line specified in the fold 

catalog. 

 Quarter : Divides the output area into four sections using the 

dividing lines specified in the fold catalog. 

Split Output Evenly divides the specified output area in TotalFlow Simply Prepress for output. 

 None : Outputs without tiling. 

 Tile horizontally (top & 

bottom) 

: Divides the output into top and bottom tiles for output. 

 Tile vertically (left & 

right) 

: Divides the output into left and right tiles for output. 

 Tile horizontally and 

vertically 

: Divides the output into top, bottom, left and right tiles 

for output. 

Overlap Allows you to enter an overlap width for tiling output, while placing the dividing 

line at the center of this width. 
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Print frames See the “About Print frames” note under “DotTIFF-Finish” for more information. 

 Paper Size : Check this to output a paper area frame. You can set 

this when Plate Imposition is selected in Output Area. 

 Imposed Layout : Check this to output frames around the imposition 

area and the object bleed area. 

 Page Layout : Check this to output frames around the page area 

and the object bleed area. 

Rotate Allows you to set the angle of rotation for the film or plate area selected in the 

Output Area field. It is rotated counterclockwise by the degree set here. 

Scale Allows you to enter a scaling percentage in the horizontal direction (H) and the 

vertical direction (V). 

 

 The divide positions (upper, lower, left, and right) for divided output are based on the 

state of a fold catalog being positioned on a flat. Note that when the fold catalog is 

positioned after being rotated 90 or 270 degrees, the upper and lower positions become 

the left or right positions and the left and right positions become the upper or lower 

positions. 

 

 File names for divided output 

If “ABC” is entered as the output file name and the signature is set to be divided into four sections, 

the following file names appear on the front side output. 

- “ABC_00.pdf” (Bottom left) 
- “ABC_01.pdf” (Top left) 
- “ABC_10.pdf” (Bottom right) 
- “ABC_11.pdf” (Top right) 

 

Color Management 

 

 

Embed ICC profile Check this checkbox if you want to embed an output intent profile for file output. 

 

Output options 

The finish frame allows you to make bleed settings. 

 

 

Stroke Outline If you output a PDF file, line segments are converted to outlines for output. 

 

Important 

Note 
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Option 

 

 

Binding Check this so that the OutlinePDF-Advance files are merged and converted to a 

multi-page PDF file. This function is used when POD connection is performed. 

File Name Allows you to specify a name for the file to be output. You can directly enter the file 

name or select a combination of the macros from the pull-down list. You can also 

use the macros when you directly enter the file name. For more information, see 

“Output File Name Macros”. 

Output Path Allows you to specify the path where the output multi-page PDF file is saved. Enter 

the path directly or click the Browse button to select the save folder from the Output 

Path Setting dialog box. Click the New button to add a new folder in the Add New 

Folder dialog box. 

Output individual files Check this to output the OutlinePDF-Advance files before they are bound. The files 

are output according to the File Name and Output Path settings that have been 

made in the Basic Settings menu. 

 

 ● Points to note about the Binding function (for all operations) 

• The maximum size of a multi-page PDF file is 2 G Byte. With the default setting, the file 

is divided when its size exceeds approximately 1.3 G Byte. 

• If an output error in a single-page OutlinePDF-Advance file occurs, the files cannot be 

merged. 

• Tickets cannot be saved with the Biding checkbox checked under the following 

conditions. 

- When Divided Imposition is selected for Output Area in the Finish frame 

- When Half (Upper&Lower), Half (Left&Right) or Quarter is selected for Split output in 

the Finish frame 

● Points to note about the Binding function (for OutlinePDF-Advance) 

• A multi-page PDF file is output as a OutlinePDF-Advance file. 

 

 

 

Important 
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8. POD Link 

Direct output commands can be sent to RICOH production printers. This chapter describes preparation and operations. 

With TotalFlow Simply Prepress, communication is performed in Connectivity mode using TotalFlow Print Server R61/R61A and 

JDF/JMF, but when PDF RIP Enhanced by SCREEN Type S is used, communication is performed in Native connection mode which 

maximizes image quality performance. 

 

 

Preparation 

To send an output command, a printer must be registered to TotalFlow Simply Prepress. Use the PrinterAdminTool on 

the TotalFlow Simply Prepress server to register a printer. 

 

 Advance settings may be required on the printer side. Perform necessary settings in 

accordance with the printer’s specifications. 

• Network connection settings and JDF interface settings 

• Device information settings in accordance with printer options 

• Paper settings, etc. 

 

Register 

 
 

1. Stop the TotalFlow Simply Prepress server service in advance. 

2. From the Windows Start menu, select Maintenance Tool - PrinterAdmin Tool. 

 

 

Register Allows you to register a new printer. 

Modify IP Allows you to change the IP address of a registered printer. 

Enter a new IP address in the dialog box displayed. 

 

Update printers that have the same IP address: When multiple printers having the 

same IP address have been registered, selecting this check box changes the IP 

address of all printers at the same time. 

Delete Deletes a registered printer. 

Update Updates information of registered printers. Use this button when the printer 

configuration is changed. Select relevant printers from the list and then click this 

button. 

Important 

Operation 



Preparation 

255 

Properties Displays the information of a registered printer. 

Close Close the PrinterAdminTool. 

3. After starting up the tool, click the Register button. 

When the window to register a new printer is displayed, enter the IP address of the printer to be connected and 

then click the Search button. 

 

 

4. The printer search window is displayed. Then, a list of printers that can be registered is displayed. 

Select a printer to register from the printer list, and then click the Register button. 

 

 

 If a search fails, the following message will be displayed. Check the entered IP address, 

and also check that the printer and TotalFlow Simply Prepress are both connected to the 

network. 

 

 

5. When the printer name entry window is displayed, enter any printer name and then click the OK 

button. 

 

 

6. The registration is completed when the following window is displayed. Click the OK button. 

 

 

7. This completes the registration of the printer. Close the PrinterAdminTool and start the TotalFlow 

Simply Prepress service. 

 

Important 
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 The ICC profiles need to be registered to TotalFlow Print Server R61/61A to use 

Connectivity mode. 

 

(1) Copy the following profiles from the designated folder on the server.  

Folder path:  

\\{TotalFlow Simply Prepress server host name}\PrefColorICC 

Profiles:  

AdobeCMYK.icm 

DS_EURO2 Std 175SQR.icm 

DS_JapanColor2001type1 V1.icc 

DS_JapanColor2001type1 V2.icc 

DS_JapanColor2001type2 V1.icc 

DS_JapanColor2001type2 V2.icc 

DS_JapanColor2001type3 V1.icc 

DS_JapanColor2001type3 V2.icc 

DS_JapanColor2001type4 V1.icc 

DS_JapanColor2001type4 V2.icc 

DS_JAPANnew HiMK 175SQ.icm 

DS_JMPA Color V1.icc 

DS_SWOP2 Std 175SQR.icm 

(2) Delete any " " (null character) that is included in each file name.  

(3) Install the files of (2) above as the CMYK input profiles of TotalFlow Print Server 

R61/61A. 

 

 If the printer was registered in Native connection mode, it is indicated as "(Type-S)" in 

"System/model:" of the properties. 

 

 The following peripherals are supported with TotalFlow Simply Prepress. 

 

[RICOH Pro C9100/9110] 

Vacuum Feed LCIT RT5100 

Vacuum Feed Banner Sheet Tray Type S3 

Multi Bypass Tray BY5010 

Multi Bypass Banner Sheet Tray Type S3 

High Capacity Stacker SK5030 

Cover Interposer Tray CI5030 

Finisher SR5050 

Booklet Finisher SR5060 

Punch Unit PU5020 

Trimmer Unit TR5040 

 

[RICOH Pro C7100S/7110S/7110] 

LCIT RT5090 

Multi Bypass Tray BY5010 

Multi Bypass Banner Sheet Tray Type S3 

Vacuum Feed LCIT RT5100 

Vacuum Feed LCIT RT5100 

High Capacity Stacker SK5030 

Cover Interposer Tray CI5030 

Finisher SR5050 

Booklet Finisher SR5060 

Punch Unit PU5020 

 

Important 

Note 

Note 
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Workflow setting procedure in the Action Plan window 

The following describes the procedure for performing an output operation using a registered printer. This procedure 

must be performed on the TotalFlow Simply Prepress Client. 

 
 

1. Open the Action Plan window and click the  button. 

 

 

2. When the New Output Workflow window is displayed, select a printer to be used and then click the 

New button. 

 

 

Operation 



8. POD Link 

258 

3. When the window to create a new workflow is displayed, perform the necessary settings. 

After this, click the Save button. 

For more information about the settings, see “POD workflow setting window” in this chapter. 

 

 

4. Select or create an imposition scheme. 

Click the imposition scheme icon to perform the imposition scheme settings. For more information, see “Job” in 

Chapter 4. 
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POD workflow setting window 

Window layout 

The POD workflow setting window consists of the Printing Conditions window, Print Processing Ticket window, and 

buttons 

 

 

Printer Information Update Retrieves the information for the selected printer. Items listed below are then 

updated. 

• Paper 

• ICC profile for front side, ICC profile for back side 

• Halftone screening 

Save Saves the workflow settings. 

Cancel Closes the window without applying the changed settings. 

Printing Conditions Allows you to set the printer’s printing conditions and color settings. 

Printing Processing Ticket Allows you to set the OutlinePDF-Advance output parameters and the printer’s 
detailed parameters. 

This window contains the OutlinePDF-Advance and POD tabs. 
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Printing conditions  

Set the printer’s printing conditions and color settings. 

 

 

Printer Name Shows the selected printer name. 

Printer Model Shows the model name of the selected printer. 

Copies Allows you to enter the number of copies to print. 

The copies of a job are 

interlocked with. 

Select this check box to use the number of copies specified in Basic Setting for the 

job. 

Printing side Allows you to select the print side of the sheet. 

 Both sides (2 sided) : Prints on both sides of the sheet. 

 Front side(1 sided) : Prints only on the front side of the sheet. 

 Back side(1 sided) : Prints only on the back side of the sheet. 

Paper Allows you to select the name of the paper to be used. The paper names are 

displayed using the following format. 

Format: Tray name [paper name, paper size, feed direction] 

Operation of print JOB Allows you to set the operation of the print job registered to the printer. 

 Print : Starts printing. 

 After sample print, 

suspend 

: Prints one copy only, and then stops printing 

temporarily. 

 Suspend : Stops printing temporarily. 

Store of Print job Allows you to set whether or not to save a print job after printing is completed. 

 Off : The job is deleted after it is printed. 

 Store indefinitely : The job is not deleted but saved after it is printed. 
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 Store for : The job is saved for a specified period (date and 

time). 

Color Allows you to select the output color conversion. Select either Color or Gray. 

ICC profile for front side Allows you to select an ICC profile to be used for color conversion of the front 

side. 

 Make the back side the 

same 

When this check box is not selected, you can select a 

separate ICC profile for color conversion of the back 

side. 

 

 

Rendering intent Allows you to select a rendering intent from the pulldown list. In general, each 

rendering intent is defined as follows. 

 Default : Converts colors with the intent specified in the 

document. If no intent is specified, conversion is made 

using relative matching. 

 Perceptual : Converts colors as close as possible to their original 

colors without changing the lightness (L value) so that 

the visual perception of each color is maintained. If the 

color space for the output device is narrow, colors 

must be reproduced within the narrow color space, 

therefore all colors are replaced. Although this color 

matching method requires all colors to be replaced, it 

rarely causes tone jumps. For this reason, this method 

is suitable for the conversion of photo images that 

include many out-of-gamut colors. 

 Saturation : Converts colors as close as possible to their original 

colors using enhanced lightness (L value) to maintain 

saturation of colors rather than to reproduce the colors 

accurately. This method is suitable for the conversion 

of data that requires bright color tones. It is typically 

used for charts and tables for business use. 

 RelativeColorimetric : Use this option to maintain a relative color gamut of 

each color. The input profile color gamut and the 

output profile color gamut are compared and then the 

color conversion is performed according to the 

resulting difference ratios. When the colors are outside 

the color gamut of the output profile, these colors are 

converted to the possible proximate colors in the 

output profile. 

 AbsoluteColorimetric : Leaves the colors in the output profile color gamut 

unchanged. An out-of-gamut color is converted to a 

color that has the same color tone and is located on 

the outmost border of the color space. This method is 

useful when colors must be reproduced accurately. 

However, when the output profile color gamut is 

narrower than the input profile color gamut, the colors 

that are located outside the color gamut and have the 

same color tones are displayed as the same color. 
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Quality Priority Select this to perform processing with priority given to the accuracy of output 

color conversion. Note, however, the processing time is longer. 

Conversion option Select an option from the pulldown list. The options include Keep paper color, 

Keep primary color, Keep black 100% after conversion, and Keep pure black 

color. You can select multiple options. The selected option icon will be displayed 

in the window. 

For more information, see "Chapter 11 Color Management Parameter List." 

 

 Only Keep black 100% after conversion can be selected for Conversion option in the Connectivity 

mode. 

 

OutlinePDF-Advance (output processing ticket) 

Basic Setting 

The Basic Setting frame allows you to make settings such as the output file name and compression mode. 

 

 

File Name Allows you to specify a name for the file to be output. You can directly enter the file 

name or select a combination of the macros from the pull-down list. You can also 

use the macros when you directly enter the file name. For more information, see 

“Output File Name Macros”. 

Output Path Allows you to specify the path where the output file is saved. Enter the path directly, 

or click Browse to select a folder from the Output Path List dialog box. You can add 

a new folder by clicking the New button to display the Add New Folder dialog 

box. 

Image Compression Type Allows you to set the compression mode when compressing images. 

You can select Keep Compression Type, JPEG or ZIP. If you select Keep 

Compression Type, the PDF file is created using the same image compression mode 

that was used in the input PDF. 

It is also possible to use macros. For more information, see “Output Folder Name 
Macros”. 

JPEG Allows you to set the image compression quality if you select JPEG as the image 

compression mode. The higher the image quality, the lower the amount of 

compression, and the lower the image quality, the higher the amount of 

compression. 

Preview Allows you to specify whether or not to attach a preview file to the output PDF. To 

attach a preview file, check this checkbox and specify a resolution in Preview 

Image Resolution. 

  

Note 
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Finish 

The Finish frame allows you to make output area and register mark settings. 

 

 

Output Area Allows you to select the output area of the imposition. 

 Fold Layout : Outputs an area that includes the finished area and 

the prepress margins. Make these settings in the Basic 

Setting tab in the Edit Template dialog box. 

 Media : Outputs the entire media area. 

 Divided Imposition : Divides output. Make these settings using Divide of 

Fold Catalog Editor. 

Division Type Half (Upper & Lower) : Divides the output area into two sections (upper and 

lower) using the dividing line specified in the fold 

catalog. 

 Half (Left & Right) : Divides the output area into two sections (left and 

right) using the dividing line specified in the fold 

catalog. 

 Quarter : Divides the output area into four sections using the 

dividing lines specified in the fold catalog. 

Split Output Evenly divides the specified output area in TotalFlow Simply Prepress for output. 

 None : Outputs without tiling. 

 Tile horizontally (top & 

bottom) 

: Divides the output into top and bottom tiles for output. 

 Tile vertically (left & 

right) 

: Divides the output into left and right tiles for output. 

 Tile horizontally and 

vertically 

: Divides the output into top, bottom, left and right tiles 

for output. 

Overlap Allows you to enter an overlap width for tiling output, while placing the dividing 

line at the center of this width. 
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Print frames See the “About Print frames” note under “DotTIFF-Finish” for more information. 

 Paper Size : Check this to output a paper area frame. You can set 

this when Media is selected in Output Area. 

 Imposed Layout : Check this to output frames around the imposition 

area and the object bleed area. 

 Page Layout : Check this to output frames around the page area 

and the object bleed area. 

Rotate Allows you to set the angle of rotation for the film or plate area selected in the 

Output Area field. It is rotated counterclockwise by the degree set here. 

Scale Allows you to enter a scaling percentage in the horizontal direction (H) and the 

vertical direction (V). 

 

 The divide positions (upper, lower, left, and right) for divided output are based on the 

state of a fold catalog being positioned on a flat. Note that when the fold catalog is 

positioned after being rotated 90 or 270 degrees, the upper and lower positions become 

the left or right positions and the left and right positions become the upper or lower 

positions. 

 

 File names for divided output 

If “ABC” is entered as the output file name and the signature is set to be divided into four sections, 
the following file names appear on the front side output. 

- “ABC_00.pdf” (Bottom left) 
- “ABC_01.pdf” (Top left) 
- “ABC_10.pdf” (Bottom right) 
- “ABC_11.pdf” (Top right) 

 

Output options 

The finish frame allows you to make bleed settings. 

 

 

Stroke Outline If you output a PDF file, line segments are converted to outlines for output. 

 

Option 

 

 

Binding Check this so that the OutlinePDF-Advance files are merged and converted to a 

multi-page PDF file. This function is used when POD connection is performed. 

Important 

Note 
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File Name Allows you to specify a name for the file to be output. You can directly enter the file 

name or select a combination of the macros from the pull-down list. You can also 

use the macros when you directly enter the file name. For more information, see 

“Output File Name Macros”. 

Output Path Allows you to specify the path where the output multi-page PDF file is saved. Enter 

the path directly or click the Browse button to select the save folder from the Output 

Path Setting dialog box. Click the New button to add a new folder in the Add New 

Folder dialog box. 

Output individual files Check this to output the OutlinePDF-Advance files before they are bound. The files 

are output according to the File Name and Output Path settings that have been 

made in the Basic Settings menu. 

 

 ● Points to note about the Binding function (for all operations) 

• The maximum size of a multi-page PDF file is 2 GByte. With the default setting, the file is 

divided when its size exceeds approximately 1.3 GByte. 

• If an output error in a single-page OutlinePDF-Advance file occurs, the files cannot be 

merged. 

• Tickets cannot be saved with the Biding checkbox checked under the following 

conditions. 

- When Divided Imposition is selected for Output Area in the Finish frame 

- When Half (Upper&Lower), Half (Left&Right) or Quarter is selected for Split output in 

the Finish frame 

● Points to note about the Binding function (for OutlinePDF-Advance) 

• A multi-page PDF file is output as a OutlinePDF-Advance file. 

 

POD (output processing ticket) 

Configure the settings on the printer side. Some items may not be displayed depending on the model used and 

configuration of peripherals. See the manual for the model used. 

 

Printer Information 

 

 

Printer Name Shows the selected printer name. 

Printer Model Shows the model name of the selected printer. 

 

  

Important 
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Finishing 

 

 

Binding edge Allows you to specify the binding position. Select Left, Right, or Top. 

Staple/Bind Allows you to perform the staple setting. Select Off, 1-staple, slant, 1-staple, 

horizontal, 1-staple, vertical, 2-staple, or 2-staple at center. 

Position Allows you to select a staple position. This setting item is displayed when 1-staple 

is selected. The selectable position varies depending on the binding position. 

 

When the binding position is on the left or right: Top, Bottom 

When the binding position is on the top: Left, Right 

Adding cover sheet Allows you to select whether or not to add a cover. This setting item is displayed 

when 2-staple at center is selected. When this check box is selected, Paper 

becomes selectable. The book block will be wrapped in the selected paper. 

 

Trim Allows you to specify the cutting method. This setting item is displayed when 

2-staple at center is selected. 

 

 Off : Cutting is not performed. 

 Fore edge by 

amount 

: Allows you to specify the cutting distance from the front 

edge side. The edge side is the opposite side to the 

binding side. In the front edge side field, enter any value 

up to the maximum value processable on the device. 

Fold type Allows you to specify the folding method. Selectability of folding method 

depends on staple setting. 

When a staple setting is Off, select either Off or Half fold. Also, the Fold sheets 

together check box becomes selectable. 

When the staple setting is 2-staple at center, the method is fixed to Half fold. 

Output tray Allows you to specify a paper discharge tray. When Half fold is selected for Fold 

type, the setting is fixed to Trimmer tray. 

Punch Allows you to set for punching holes. 
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 Off : Punched holes will not be created. 

 2 Holes : The printer will make two punched holes. 

Collate Allows you to specify a sorting method during paper discharge. Select Not sort, 

Sort/Shift sort, Collate, or Stack. 

Eject output Allows you to specify the paper discharge order and front/back side setting. 

Select Face-up, Face-down, Face-up, reverse order, or Face-down, reverse 

order. 

 

Printing Quality 

 

 

Halftone screening Allows you to select a screening setting. Select one of the screening sets created 

on the printer. 

BlackOverPrint Select this if you want the system to automatically overprint K = 100% tints and K 

= 100% text in the file to be imported. 

DTP Overprint Information Select this check box to load overprints. 

Automatic Overprint 

Configuration 

Specifies what is to be overprinted automatically during output. 

 None : Select this if you do not want the system to 

automatically apply overprinting. 

 Tint & Text : Select this if you want the system to automatically 

overprint K = 100% tints and K = 100% text in the file 

to be imported. 

 Text : Select this if you want the system to automatically 

overprint K = 100% text in the file to be imported. 

Color Synthesis Overprint 

Simulation 

Select this check box to render overprints even after performing an ICC 

conversion or after converting spot colors to simulated colors. 

Line Width Adjustment When On is selected, the thickness of the stroke is adjusted so that it is even. 

Use maximum density Allows you to specify whether or not to apply the maximum density to either 

CMYK or black only. 

 Off : The calibrated values specified in the printer will be 

used. 

 For K only : 100% black (K) will be printed at the maximum 

density, regardless of the printer calibration. 
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 CMYK : 100% colors (C, M, Y, K) will be printed at the 

maximum densities, regardless of the printer 

calibration. 

Edge enhancement Allows you to specify whether or not to enhance the text and line art edges by 

removing jagged lines. When On is selected, the edges will be enhanced during 

printing. 

Thinning/Outline enhancement Allows you to specify whether or not to enhance thin lines in text and line art. 

When On is selected, thin lines will be enhanced. 

 

 When Automatic Overprint Configuration is used for a job for which Use Target ICC has 

been selected in Section Setting, select the Color Synthesis Overprint Simulation check 

box. 

 

 The following items can be set on RICOH Pro C9110/C9100 only. 

• Edge enhancement 

• Thinning/Outline enhancement 

BlackOverPrint can be set in Connectivity mode only. 

 

Output Option 

 

 

Banner Page Allows you to specify the contents and printing position of the banner page. Enter 

the contents to be printed in the text area. 

 Off : The banner page is not output. 

 Before and after job : The banner page is printed before and after the job. 

 Before job : The banner page is printed before the job. 

Insert job separator sheet When this check box is selected, job separator sheets will be inserted. 

 Paper : Allows you to select the paper used for separator 

sheets. 

Insert copy separator sheet When this check box is selected, copy separator sheets will be inserted. 

Important 

Note 
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 Paper : Allows you to select the paper used for separator 

sheets. 

 Separator Amount : A separator sheet is inserted between copies at 

specified intervals. 

Insert slip sheet When this check box is selected, slip sheets will be inserted. 

 Paper : Allows you to select the paper used for slip sheets. 

 Printing : When this check box is selected, a copy of the 

previous page will be inserted. 

 

Toner 

 

 

Toner/Ink Limit Allows you to specify a limit for the amount of toner used. Select Low, Medium, 

or High. 

 

Fifth Station 

 The following setting item can be set with RICOH Pro C7100S/7110S/7110 only when the 

Special color Expansion Kit S3 option is installed. 

• Fifth Station 

 

 

Special effect toner Shows the toner types that are set for the Fifth Station.  

Processing Target Plate Allows you to select a plate name to be output to the special toner. You can select 

a plate name from those registered to the system. 

Print priority Allows you to prioritize either image quality or speed. 

 Quality : Image quality is prioritized. 

 Speed : Speed is prioritized. 

Fuser setting Set the fuser. Select from [Standard] and [High quality]. This option can be 

specified when clear toner is set for the Fifth Station. 

 

  

Note 



8. POD Link 

270 

Frames 

If the frame is drawn using solid lines 
 

Paper frame, page frame Imposition frame 

 

 

 

 

 

 

A4-4Up Left bound/4 signature/Saddle stitched (with creep settings) 
 

Page frame    Imposition frame 

 

 

 

 

  

Paper frame  

(including gripper margin) 

Page frame 

Page + bleed frame 

Imposition frame 

Imposition + bleed frame 

*Page frames are drawn around each page. 

Gutter Page frame 

Amount of creep 
Page + bleed frame 

Gutter 

Amount of creep 

Page frame 

Page + bleed frame 
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If the frame is drawn using dotted lines 

 
Paper frame, page frame Imposition frame 

 

 

 

 

 

 Specify the type of line (solid line or dotted line) and the length and interval for the dotted lines in 

the System Setup Tool. 

 

 

Note 

Paper frame  

(including gripper margin) 

Page frame 

Page + bleed frame 

Imposition frame 

Imposition + bleed frame 

*Page frames are drawn around each page. 
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9. Main Window 

This chapter describes the settings that are displayed when you select the Progress button. 

 

 

Display of the progress menu 

The progress status for processing of a job is listed. 

 

 

Toolbar 

If you select the Progress button from the shortcut area, icon buttons for job operation are displayed in the toolbar. 

 

 Allows you to cancel the processing of the selected job. 

 Releases the pause state of the selected process job. 

 Allows you to move the selected job to the top of the list. 

 Allows you to move the selected job one position up in the list. 

 Allows you to move the selected job to the bottom of the list. 

 Allows you to move the selected job one position down in the list. 

 Click this button after selecting a job to change the priority of the selected job. 

 Displays the online manual. 

 Click this button to display the task/event list. 

 Filters the displayed list. 

Enter a search string in the entry field, and then click . 

 Shows the search dialog box. 

 

Toolbar 

Processing/Processed job 

list area 

Task/Event list area 
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 • The task/event list is displayed when you double-click the button on the processing/processed 

job list area. 

• The task/event list closes when you double-click the button again while the task/event list is 

displayed. 

 

Processing/Processed 

The progress display is divided based on whether a job is being processed or has been processed. Click the 

Processing tab or finished tab to switch the display. 

 

 

Process Job ID Shows the job ID issued by the TotalFlow Simply Prepress system. 

Process Target Shows the file to be processed. 

Job Name Shows the job name. 

Status Shows the job status. 

Workflow Shows the ticket workflow. The job being processed is displayed on the blue 

background. 

Comments Shows the information that is entered in Comment. 

Date Shows the date and time when the processing starts. 

Finish Date Shows the date and time when the processing ends. This item is displayed only 

when the Finished tab is selected. 

Priority Shows the job priority. 

Publisher Shows the name of the user who executed the job. 

Host Shows the name of the processing host. 

 

 

  

Note 
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Task 

The Task window shows a progress status for each stage of processing. 

 

 

Process Shows the process icon. 

Progress Shows a progress bar for each process. 

Processing: Indicated by a blue progress bar. 

Error: Indicated by a red progress bar. 

Finished: Indicated by a gray progress bar. 

Status Shows the job status. 

Date Shows the date and time when the processing starts. 

Finish Date Shows the date and time when the processing ends. 

Host Shows the name of the host used for task processing. 

Task ID Shows the task ID issued by the system. 

 

Event 

The Event window displays various events that occurred in the selected job. 

 

 

Level Shows the importance of the event that occurred. 

 : Fatal error 

 : Error 

 : Query 

 : Warning 

 : Information 

Host Shows the host where the event that occurred. 

Occur Date Shows the date and time that the event occurred. 

Message Shows the overview and code of the event. 

Task ID Shows the task ID issued by the TotalFlow Simply Prepress system. 
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Layout 

The Layout window shows a progress status for each page in a process job. 

 

 

Page Shows the page number. 

Sig. No. Shows the signature number and the side (front or back). 

File Shows the file name. 

Progress Shows the progress of each processing. The job being processed is displayed on 

the blue background. 

 Releases the pause state of the selected page/signature. 

 

Event Detail window 

When you select an event in the event list area and double-click it, the Event Detail window is displayed. 

 

 

Level Shows the importance of the event that occurred. 

 : Fatal error 

 : Error 

 : Query 

 : Warning 

 : Information 

Occur Date Shows the date and time that the event occurred. 

Host Shows the host where the event that occurred. 

Code Shows the event code. 
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Generation source Shows the name of the job in which the event occurred. 

Category Shows the event category. 

ID Shows the ID of the job in which the event occurred. 

Error description Shows the source and description of the event. 

Detail Shows the details of the event. 

Report Shows a report. 

 

Close Click this to close the Event Detail window. 
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Log 

The Log menu allows you to specify search criteria to check the processing history and error processing for a 

particular period of time. 

When you click the Log button in the main menu, the Log, Log Total, Event, and Operation Log tabs are displayed. 

Click on a tab to display its window. Click one of the tabs to display its window. 

 

 

Search Criteria Setup area This is the area where you can set the criteria for a log search. 

Search Results Display area Shows the search results. 

 

Search criteria 

setup area 

Search results 

display area 
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Log 

The Log tab allows you to check the processing history for a particular period of time. Specify the criteria in the search 

criteria setup area and Click the Search button to display the search results in the search results display area. 

 

 

Process Job ID Shows the job ID issued by the TotalFlow Simply Prepress system. 

Process Target Shows the file to be processed. 

Job Name Shows the job name. 

Status Shows the job status. 

Workflow Shows the ticket workflow. 

Comments Shows the information that is entered in Comment. 

Date Shows the date and time when the processing starts. 

Finish Date Shows the date and time when the processing ends. 

Priority Shows the job priority. 

Publisher Shows the name of the user who executed the job. 

Host Shows the name of the processing host. 

Ticket Name Shows the ticket name. 
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Log Total 

Specify the criteria in the search criteria setup area and click the Search button to display the tabulated logs in the 

search results display area. The default settings appear as shown below, but you can set your own tabulation items as 

desired. 

 

 

Date Allows you to select “Past” or “Period”. 
• Past: Allows you to select the time period for the search using preset options. 

• Period: If you specify the search period using date and time, you can select the 

day, month and year from the drop-down lists. 

Filter • Job Name: Allows you to enter a job name by which to filter. 

• Ticket Name: Allows you to enter a ticket name by which to filter. 

• Process Target: Allows you to enter the character string to be processed. 

Search Click this button to display a list of tabulated devices on the specified date. 

Customize Items Click this button to set the tabulation items in the tabulation item setting window. 

CSV Output Outputs the searched tabulated logs using a CSV file. 
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Event 

The Event tab allows you to display logs containing only the errors that occurred during ticket processing. 

Specify the criteria in the search criteria setup area and click the Search button to display the search results in the 

search results display area. You can change the display order by clicking on the name of an item. In addition, if you 

double-click a selected error, you can check detailed information in the Event Details dialog box. 

 

 

Level Shows the importance of the event that occurred. 

 : Fatal error 

 : Error 

 : Query 

 : Operation request 

 : Warning 

 : Information 

 : Report 

Message Shows the event message. 

Occur Date Shows the date and time that the event occurred. 

Job Name Shows the job name where the event that occurred. 

Host Shows the host where the event that occurred. 

ID Shows the ID of the event. 
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Operation Log 

 

 

Search Condition • Target: Allows you to select the search target from the pull-down list. 

• Name: Allows you to select the job you want to search from the pull-down list. 

• Past: Allows you to select the time period for the search using preset options. 

• Period: If you specify the search period using date and time, you can select the 

day, month and year from the drop-down lists. 

Filter • User Name: Allows you to enter a user name by which to filter. 

• Detail: Allows you to enter the detailed character string by which to filter. 
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System window 

Select Version in the list area to display the version information for that server in the information display area. 

 

 

Licensing Information 

Select License in the list area to display information about the licenses installed in TotalFlow Simply Prepress. 

 

 

Information 

display area 
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 Host Status 

Click the Host Status tab to display the TotalFlow Simply Prepress Server, status of the execution server being 

connected, and usage condition of the disk in the information area. 

 

 

Host status Shows a list of the hosts that comprise the system. Click the triangle mark on the head of 

the host name to display the usage condition of the disk of the host. 

An icon that shows the host status is displayed on the left of the host name. The descriptions 

of the icons are shown below. 

 : TotalFlow Simply Prepress Server. 

 : Execution server that is in normal operation. 

 : Execution server for which service has been stopped. 

 : Execution server that cannot be connected or has not started up. 

Disk Usages Shows the capacity of the local disk, system disk (System), and work disk (Work). The 

capacity of the disk drive installed on the TotalFlow Simply Prepress is displayed on the 

system disk, and the capacity of the disk drive assigned to the TotalFlow Simply Prepress is 

displayed on the work disk. 

 Bar Shows a bar chart of the usage ratio of the disk capacity. The usage ratio 

is displayed in the bar using a numerical value. 

When the disk capacity is normal, the bar is displayed in blue. 

The bar is displayed in yellow if a disk with a total capacity of 16 GB or 

more is being used and the free space of the disk has decreased to 6 GB 

or less. 

The bar is displayed in red if a disk with a total capacity of 16 GB or 

more is being used, and the free space of the disk has decreased to 2 GB 

or less. It is also shown in red if a disk with a total capacity of 16 GB or 

less is being used and the usage ratio reaches 80% or more. 

 Space Shows the size of the free space and total capacity as numerical values 

(unit: GB). 
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10. MIS Link Function 

This section describes the window display for JDF linking of an MIS with TotalFlow Simply Prepress. 

 

 

Displaying a message list and updating a job 

When a job is created using a JDF file from the MIS, you can display the Received JDF window from the JobList 

window. 

 

 Settings for MIS linking 

To link the TotalFlow Simply Prepress system with an MIS using a JDF file, the registration 

of a URL is required (http://[IP address of TotalFlow Simply Prepress]:50067/jdf), so that 

the TotalFlow Simply Prepress system can receive a JDF file sent from an MIS. 

For more information, please contact the supplier of the MIS that you are using. 

 

This window shows a list of messages (JMF) sent from the MIS to a job. 

In addition, when a job creation command message or a job update command message is resent to a job, you can 

update the job based on a JDF file linked to that command. 

 

There are two types of command messages. One allows operators to update a job and the other prompts operators to 

process a job after they have confirmed the detailed information of the received message. 

When a message is received, the  and  icons are displayed in the Information area of the job list. 

• : Indicates the receipt of a message(s) that enables a job update. 

• : Indicates the receipt of a message(s) only for confirmation. 

 

 Operators can only confirm messages that prompt to process a job after they have confirmed the 

detailed information of the received messages. 

 

Select a job in the job list and click the  icon to show the following window. 

The received messages are listed in Received JMF List. Select a message in the information area to show the detailed 

information. When Available is displayed for Job Update, the Update button becomes active and you can update a 

job using a JDF file linked to that message. 

 

Important 

Note 

Currently used JDF 
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Messages to be displayed and their types 

 

Message Message type Description Job update 

Command SubmitQueueEntry Create a job. Available 

Command AbortQueueEntry Forcibly delete the job. Not Available 

Command RemoveQueueEntry Delete the job. Not Available 

Command HoldQueueEntry Suspend the job. Not Available 

Command SuspendQueueEntry Stop the executed job. Not Available 

Command ResumeQueueEntry Resume the suspended or stopped job. Not Available 

Query Status Send the job progress. Not Available 

Query Resource Send the resource status. Not Available 
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Status notification to the MIS 

Status notifications of jobs and output plates created in TotalFlow Simply Prepress are determined depending on the 

JMF and JDF received from the MIS. When an instruction for status notification is issued for a job, the notification can 

be returned to the MIS either automatically or manually. 

While the status notification is returned to the MIS automatically following the TotalFlow Simply Prepress operation, 

you can also issue a notification manually from the Audit Record window. 

 
 

1. Display the TotalFlow Simply Prepress Client window. 

 

2. Select Report from the menu in the Job Detail window. 

 

3. Select the Status tab. 

 

4. Set the job status and the resource status to be notified. 

For a job status, select the target process and select the status (InProgress or Completed). 

For a resource status, select the check box of the resource that was output. 

 

5. Click the Execute button for notification. 

 

 

Operation 
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JDF Connect Setting Tool 

MIS 

Set Imposition 

JDF 

Application of accessory preset Imposition information 

Condition setting table 

Automatic accessory preset setting 

When the JDF file issued by the MIS includes the imposition scheme and imposition layout, TotalFlow Simply Prepress 

creates the imposition scheme and imposition layout in accordance with the JDF file. However, the imposition layout 

described in the JDF only includes the information of sheet size and layout position of each page. The information 

related to the register marks and accessory of each mark is not included in the JDF. Using TotalFlow Simply Prepress, 

the accessory preset can be selected from the JDF imposition conditions and the accessory can be provided 

automatically. 

 

The conditions in which the accessory preset is automatically selected from the JDF imposition conditions are the 

following combinations. 

 • Binding method (saddle stitching/perfect binding) 

 • Plate present/not present 

 • Device ID (type of printer) Note: This needs to match the ID managed by the MIS. 

 • Color used for signature (front/back) 

 

Registering a combination of the conditions above using JDF Connect Setting Tool in advance applies the accessory 

preset that meets the conditions. 

 

 

Binding method Colors DeviceID 
Accessory 

Preset 

Perfect binding CMYK Dev01 AAA01-Set 

Perfect binding K Dev01 AAA02-Set 

Saddle stitching CMYK Dev02 BBB01-Set 

Saddle stitching CMYK Dev02 BBB02-Set 

－－  －－ Default 
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JDF Connect Setting Tool 

This is the tool that performs the settings for the MIS linking. To use the MIS link function, make the settings using this 

tool first. 

 

Starting and exiting the JDF Connect Setting Tool 

 

Start-up 

Select Maintenance Tool from the Windows Start menu. Double click JDF Connect Setting Tool from among the tool 

shortcuts. 

 

Exit 

Click the Close button in the bottom right of the dialog box. If you have not saved any of the changes you made, a 

message is displayed asking you whether to save them or not. If the message appears, follow the instructions. 

 

Layout and basic operations in the dialog box 

Job setting 

Perform the basic settings from the MIS for job registration. 

 

 

 In the main window, clicking a listed item on the left switches the parameter setting window on the 

right according to the clicked item. 

 

 

 

 

Note 
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Default Job Template 
Allows you to select the job template to be used for registering a job from 

the MIS. 

Keyword 1 
Allows you to set keyword 1 to be specified when registering a job from 

the MIS. 

Keyword 2 
Allows you to set keyword 2 to be specified when registering a job from 

the MIS. 

Comments 
Allows you to set a comment to be specified when registering a job from 

the MIS. 

Processing of RemoveQueueEntry 

command from MIS 

Allows you to set the behavior when the MIS sends the job deletion 

command. 

Auto progress notification to MIS Allows you to set whether or not to send the job progress to the MIS. 

Total Binding Type Setting 
Allows you to set a binding type between sections when registering a job 

from the MIS. 

Auto assign pages (pages attribute) 
Allows you to set a range for automatic page assignment when 

registering a job from the MIS. 

 

Accessory 

Set the conditions for automatic accessory presetting. 

 

 

Printing Style Allows you to select a printing style for which the condition is set. 

Priority List Shows the condition table for assigning the accessory preset. 

Name: Name used to identify conditions. 

Accessory Preset: Name of accessory preset specified when the conditions are met. 

 Raises the selected priority order by one level. 

 Lowers the selected priority order by one level. 

Matching Parameters from JDF Shows the parameters specified for the conditions in the read-only display. 

Add Used to add a new condition. 
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Edit Used to edit a condition. 

Delete Used to delete a condition. 

 

 The default conditions cannot be deleted. The conditions that have a lower priority than the 

default conditions are disabled. 

 

 

Add/Edit 

 

 

Name Allows you to set a condition name. 

Accessory Preset Allows you to select an accessory preset to be set automatically when the 

conditions are met. 

Device ID Allows you to set a device ID as a condition. 

Binding Type Allows you to set a binding method as a condition. 

 

 

Important 
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11. Color Management Parameter List 

Color management parameters 

On a TotalFlow Simply Prepress Client, various settings related to job color conversion policies are handled in batch in 

the Input Color Setting window. 

This section describes the settings in the Input Color Setting window, as well as the default settings for the ICC profiles 

and the recipe files for the input color space, the intermediate target color space, and the output color space. 

 

Options for ICC color conversion 

Following options are available for ICC color conversion at Input Color Settings and Output Color Settings. 

 

ICC Conversion Option Content 

Keep pure black color Colors with CMY=0% are converted using only K. The output K value is 

calculated according to printing conditions. This option is also available for 

grayscale and RGB data with identical RGB values. 

Keep black 100% after 

conversion 
Colors with CMY=0% and K=100% are left untouched. 

Keep primary color Primary colors (with C, M or Y only data) will not contain other colors after 

conversion. 

Keep paper color White values (CMYK=0, RGB=255, etc) will be output as white (CMYK=0). 

Without this option, some ICC profiles or selected intent may result to values other 

than 0%. 

Keep black plate K data is left untouched. Unlike Keep black, CMY values will not affect the output. 

This option will ignore maximum ink amount. 

 

Input color space 

This section describes the default ICC profiles that can be selected in the Input color space pulldown list. 

The default ICC profiles that can be selected differ depending on whether you are working with the RGB, CMYK, or 

Gray input color space. 

 

Profiles for the RGB input color space 

The default ICC profiles for RGB that can be selected in the Input color space pulldown list are shown below. 

Profiles for the RGB input color space 

 

 

 

  

Profiles for the RGB input color space 
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File Name GUI Display (internal name) Contents 

DS sRGB for WinCRT.icm DS sRGB for WinCRT 

g=2.2 65K 

For standard Windows monitors 

DS std_RGB for MacCRT.icm DS std_RGB for MacCRT 

g=1.8 65K 

For standard Macintosh monitors 

sRGB Color Space Profile.icm sRGB IEC61966-2.1 sRGB Profile 

 

Profiles for the CMYK input color space 

The default ICC profiles for CMYK that can be selected in the Input color space pulldown list are shown below. 

 

 

 

 

File Name GUI Display (internal name) Contents 

AdobeCMYK.icm Adobe CMYK CMYK profile from Adobe 

DS_JapanColor2001 

type1 V1.icc *1 

DS_JapanColor2001 

type1-Art V1 

Profile created from the measured color values 

for Type 1 paper (art paper) included in the 

Japan Color 2001 Reference Kit. (Output 

conditions: Round dots, 175 lpi, Screen angles: 

C=112.5º, M=52.5º, Y=97.5º, K=-7.5º)  

DS_JapanColor2001type1 

V2.icc 

DS_JapanColor2001 

type1-Art V2 

Profile with the same conditions as V1. 

Using the black point correction, shadow areas 

are expressed darker than VI. 

DS_JapanColor2001 

type2 V1.icc *1 

DS_JapanColor2001 

type2-MatCoated V1 

Profile created from the measured color values 

for Type 2 paper (matte coated paper) 

included in the Japan Color 2001 Reference 

Kit. 

(Output conditions: Round dots, 175 lpi, 

Screen angles: C=112.5º, M=52.5º, Y=97.5º, 

K=-7.5º) 

DS_JapanColor2001type2 

V2.icc 

DS_JapanColor2001 

type2-MatCoated V2 

Profile with the same conditions as V1. 

Using the black point correction, shadow areas 

are expressed darker than VI. 

DS_JapanColor2001 

type3 V1.icc *1 

DS_JapanColor2001 

type3-Coated V1 

Profile created from the measured color values 

for Type 3 paper (coated paper) included in 

the Japan Color 2001 Reference Kit. (Output 

conditions: Round dots, 175 lpi, Screen angles: 

C=112.5º, M=52.5º, Y=97.5º, K=-7.5º) 

DS_JapanColor2001type3 

V2.icc 

DS_JapanColor2001 

type3-Coated V2 

Profile with the same conditions as V1. 

Using the black point correction, shadow areas 

are expressed darker than VI. 

Profiles for the CMYK input color space 
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DS_JapanColor2001 

type4 V1.icc *1 

DS_JapanColor2001 

type4-Uncoated V1 

Profile created from the measured color values 

for Type 4 paper (high quality paper) included 

in the Japan Color 2001 Reference Kit. 

(Output conditions: Round dots, 175 lpi, 

Screen angles: C=112.5º, M=52.5º, Y=97.5º, 

K=-7.5º) 

DS_JapanColor2001type4 

V2.icc 

DS_JapanColor2001 

type4-Uncoated V2 

Profile with the same conditions as V1. 

Using the black point correction, shadow areas 

are expressed darker than VI. 

DS_JMPA Color V1.icc *2 DS_JMPA Color V1 Profile compliant with JMPA Color, which was 

established as the color reproduction reference 

for magazine advertising production by the 

JMPA (Japan Magazine Publishers 

Association). 

(Output conditions: DDCP output) 

DS_JAPANnew HiMK 

175SQ.icm 

DS_JAPANnew HiMK 175 SQ Hi-Mckinley paper (quality coated paper from 

Gojo Paper) using TOKA inks and square dots 

at 175 lpi 

DS_SWOP2 Std 175SQR.icm DS_SWOP2 Std 175 SQR Art paper using SWOP compliant inks and 

square dots at 175 lpi 

DS_EURO2 Std 175SQR.icm DS_EURO2 Std 175 SQR Art paper using EUROscale compliant inks and 

square dots at 175 lpi 

 

*1 Profile distributed by the JSPST (The Japan Society for Printing Science and Technology) that was created from 

digitally measured color values included in the Japan Color 2001 Reference Kit for offset sheetfed printing. 

*2 Profile that is compliant with the JMPA color standard that was established as a color reproduction reference for 

magazine advertising production by the JMPA. It was created from the independently measured color values in 

the DDCP output color chart included with the JMPA vendor kit. 
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Profiles for the Gray input color space 

The default ICC profiles for Gray that can be selected in the Input color space pulldown list are shown below. 

 

 

 

 

File Name GUI Display (internal name) Contents 

AdobeGray20.icm Adobe Gray . 20% Dot Gain Gray profile from Adobe 

DS std_gray for CMYK.icm DS std_gray for CMYK For CMYK images 

DS std_gray for RGB.icm DS std_gray for RGB For RGB images 

DS_KlinearGray for Adobe 

CMYK.icm 

DS K-linear Gray for Adobe 

CMYK 

For CMYK images. When you set 

AdobeCMYK.icm as the profile selection for 

preconversion, you can save the linearity of the 

K separation during conversion. Note that you 

cannot save the linearity of the K separation 

when you combine this with any other profile 

except the AdobeCMYK.icm profile. 

DS_Gray_gamma_1_8.icc Gray Gamma=1.8 Gamma 1.8 profile 

DS_Gray_gamma_2_2.icc Gray Gamma=2.2 Gamma 2.2 profile 

 

  

Profiles for the Gray input color space 
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Recipe Conversion 

When using a Colorgenius DC recipe file to convert an RGB image to a CMYK image, recipe conversion options are 

used. When a recipe file is set, quality is optimized for the images allocated to the PDF file. 

 

 • Recipe conversion optimize RGB images within PDF files and convert them to CMYK. 

It is also possible to return CMYK images that were created using low quality RGB to CMYK 

conversion to RGB data and convert them to CMYK appropriate for the printing conditions. 

Since the quality of these CMYK images may vary, we recommend using Colorgenius LE to check 

the images as you work if you run recipe conversion on these types of CMYK images. 

• For normal PDF (PDF that was not optimized in Colorgenius LE), use the same recipe file for all of 

the RGB and CMYK images within the PDF files for CMYK conversion. If you link to Colorgenius 

LE, you can set recipe files (assign recipes) for the individual images as you view them in Simple 

Preview to convert them to CMYK that uses recipes that are appropriate for the images. See 

“Linking with Colorgenius LE” below for more information. 
• The recipe files that can be used in both input color setting in TotalFlow Simply Prepress and 

Colorgenius LE are limited to those created in Colorgenius DC2 and later. 

• The each elements in PDF are performed color conversion as follows according to the each 

settings. 

• If you use PDF optimized in Colorgenius LE 

Images to which a recipe is assigned: 

Color conversion is executed using the recipe specified in Colorgenius. 

Images to which no recipe is assigned: 

Color conversion is executed as follows depending on the selected option for the 

conversion method of the input color space: color conversion is passed (colors are 

identified as the same color) when the Recipe/Pass option is selected, the ICC 

conversion is executed when the Recipe/ICC Conversion option is selected, and the 

input color space is converted to the output color space using the device link profile 

when the Recipe/Device Link option is selected. 

 

 

• If you use PDF not optimized in Colorgenius LE 

Image: Default recipe processing 

• Images to be processed using recipe conversion are once converted to an internal RGB color 

space before the processing. The conversion to the internal RGB color space is executed using an 

ICC profile and input colors are converted using profiles as follows. 

 

• For PDFs optimized in Colorgenius LE 

ICC profiles are always embedded in images to which recipes were assigned using 

Colorgenius LE, so those profiles are used 

• For normal PDF (PDF not optimized in Colorgenius LE) 

When an ICC profile is embedded in the image: The embedded ICC profile is used. 

When an ICC profile is embedded in the image: The profile specified in the input color settings 

is used. 

 

Note 
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 • Applying default recipe files to PDF data including images with embedded recipes if 

there is even one image with a recipe embedded, the default recipe file is not used) 

• For PDF files with which a recipe has been assigned using Colorgenius LE, the Default 

Recipe File is ignored, and the information assigned with Colorgenius LE and the 

settings in the Environment Setup window are used. 

• For example, when a large size image such as 2,300 mm x 1,500 mm that is 

excessively larger than the paper size is included, if the temporary file size exceeds 2 

GB during the recipe conversion processing, the “An internal error has occurred!” 

error is issued. In this case, edit the PDF to crop the image according to the paper size. 

• If the number of pixels in the vertical or horizontal direction of the image included in the 

PDF is either 15 pixels or less or 30,000 pixels or more, the recipe conversion is not 

executed. 

Note: For the points to note other than those described above, refer to the reference 

manual and the manual for points to note of Colorgenius LE/AC. 

 

  

Important 
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Relationship between the Colorgenius peripheral devices and recipe files 

This product supports Colorgenius LE of SCREEN Graphic and Precision Solutions Co., Ltd. 

 

Colorgenius LE can be downloaded for free from SCREEN MT Store. 

http://www.screen-mt.com/newmt/support/index.html 

 

 • Linking with Colorgenius LE  

Colorgenius LE is a special plug-in for Adobe Acrobat. You must have recipe files created in 

Colorgenius DC to use it. Colorgenius LE allows you to assign appropriate recipe files to RGB 

digital camera images included in PDF files and generate PDF files with embedded recipe files. 

PDF files with embedded recipes generated in Colorgenius LE are loaded into PolishedInput, the 

optimal conversion (RGB to CMYK or CMYK to CMYK) based on the recipe files assigned to 

each image is run, and the PDF file for printing is created. 

• Colorgenius DC 

Colorgenius DC is CMYK image creation software that performs color correction and density 

correction on RGB images created using a digital camera or poor quality CMYK images 

converted using simple conversion from RGB to generate optimal image data for printing. 

• Recipe File  

A recipe file is a file created in Colorgenius DC. It includes keywords for subjects and finishing 

specifications as well as quality definition data and is used for RGB to CMYK conversion or 

CMYK to CMYK conversion. 

 

Note: For more information, see references such as the Colorgenius LE manual. 

 

Note 
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Default recipe files 

This section describes the default recipe files that can be selected in the Default Recipe File pulldown list. 

 

 

The default recipe file configuration is shown below. 

V4 □□○○.cnt 

□□… Recipe file name 

There are four types of conversion recipes. 

V4PC ○○.cnt 

This is an RGB→CMYK recipe for conversion to CMYK. 

V4SC ○○.cnt 

This is an RGB→RGB recipe for multicolor conversion. 

V4PR ○○.cnt 

This is a CMYK→CMYK recipe for CMYK readjustment and conversion to CMYK. 

V4SR ○○.cnt 

This is a CMYK→RGB recipe for CMYK readjustment and multicolor conversion. 

○○… Recipe number, differentiates recipes for AI bypass 

Assigns unique numbers as recipe numbers such as 01, 02. 

In addition, it adds “p” before the number, as in p01 and p02 to differentiate recipes for AI bypass. 

… Recipe data 

Recipes for individual purposes come as defaults with the software. For more information, see below.  

 

Standard Sets standard values for the highlight and shadow points and corrects any color cast that 

may be present in the image. This is a setup that does not significantly change the tone or 

brightness of the original. 

Portrait This is a setup for portraits that corrects for slight color casts, makes the midtones somewhat 

brighter, reduces the black separation and sharpness in the skin tones, and softens the 

overall image more than the Standard setup. 

Machine This is a setup that significantly increases the sharpness and makes borders better defined 

so that jaggy edges are not obvious. 

Food This is a setup that in addition to the Standard setup, removes muddiness from the reds and 

greens and makes food products look fresh. 

Scenery Many scenery photos have color casts, and this setup significantly reduces them. It also 

uses color correction functions to enhance colors in the sky and in greenery. 
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White Chinaware This is a setup that adjusts the highlight point setup so that the white in the china appears 

whiter and increases the sharpness so that the surfaces appear smooth. 

Jewel This is a setup that in addition to the Standard setup, uses sharpness correction to give 

jewelry a three-dimensional feel and enhances the shininess of the highlights. 

NightScene This is a setup that reduces highlight and shadow point correction, maintains the feeling of 

the original, and slightly brightens highlight areas, such as lights, while preserving the 

darkness of the image. 

Standard This is a setup that increases the sharpness more than the Standard setup. This is suitable 

for processing RGB images with no sharpening. 

Standard 

Keep Light 

This is a setup that adjusts the highlight and shadow points, minimizes the correction of 

color casts, maintains the feeling of the original, preserves the general tonality of the 

original, and somewhat brightens the image. 

Standard Keep This is a setup that adjusts the highlight and shadow points, minimizes the correction of 

color casts, maintains the feeling of the original, and preserves the general tonality and 

brightness of the original. 

Standard Light Sets the highlight and shadow points to standard values, and corrects any color cast 

present in the image. This setup preserves the general tonality of the original and 

somewhat brightens the image. 

Portrait Sharp This is a setup that increases the sharpness more than the Portrait setup. This is suitable for 

processing RGB images with no sharpening. 

Light Portrait This is a setup that changes the tone correction in the Portrait setup, producing bright, clean 

skin tones. 

Dark Portrait This is a setup that brightens the midtones more than the Portrait setup, producing clean 

skin tones. 

Machine Sharp This is a setup that increases the sharpness more than the Machines setup. This is suitable 

for processing RGB images with no sharpening. 

Food Sharp This is a setup that increases the sharpness more than the Food setup. This is suitable for 

processing RGB images with no sharpening. 

Scenery Sharp This is a setup that increases the sharpness more than the Scenery setup. This is suitable for 

processing RGB images with no sharpening. 

White China Sharp This is a setup that increases the sharpness more than the White Chinaware setup. This is 

suitable for processing RGB images with no sharpening. 

Jewel Sharp This is a setup that increases the sharpness more than the Jewels setup. This is suitable for 

processing RGB images with no sharpening. 

NightScene Sharp This is a setup that increases the sharpness more than the Night Scene setup. This is suitable 

for processing RGB images with no sharpening. 
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Image conversion settings 

This section describes the option settings in the Select Image Conversion Recipe window. 

 

 

Modify the image resolution 

according to the output 

resolution 

Setting that optimizes the quality of image files laid out in PDF files. Select this check 

box when importing PDF files to run image conversion according to the settings in 

Quality Level, Correct the Sharpness parameter automatically when enlarging the 

image, and Output Resolution. 

Quality Level • Standard: 

Effective for images enlarged up to about 300%. Uses Bicubic interpolation, 

which is generally considered good quality. The quality when enlarging images 

is better than Bilinear or Nearest Neighbor. In addition, sharpening appropriate 

for the amount of enlargement is applied after enlargement. 

• High: 

Effective for images enlarged to about 330% or more. It applies Dainippon 

Screen’s unique algorithms (sharpness interpolation), which makes it possible to 
maintain quality levels even for areas enlarged 330% or more. 

Correct the Sharpness 

parameter automatically when 

enlarging the image 

Select this check box to automatically apply the optimal sharpness correction to 

images laid out in sizes that exceed their original resolution using TotalFlow Simply 

Prepress. 

Output Resolution Sets the resolution for the image after the RGB to CMYK conversion or CMYK to 

CMYK conversion. 

 

 • For PDF files with which a recipe has been assigned using Colorgenius LE, Modify the 

image resolution according to the output resolution settings is ignored, and the 

information assigned with Colorgenius LE and the settings in the Environment Setup 

window are used. 

 

 • Enlargement Ratio 

The enlargement/reduction percentage is shown as a ratio of the input PDF image resolution to 

the Output Resolution set here. (Example: If the PDF image resolution is 100 dpi and the output 

resolution is set to 350 dpi, the ratio is a 350% enlargement, so Quality Level(High) should be 

selected.) This ratio may not match the enlargement/reduction ratio shown in the TotalFlow 

Simply Prepress. This value is the resolution of the image embedded in the PDF file. 

 

Important 

Note 
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Device link profiles 

This section describes default device link profiles that can be selected when running device link conversion. 

The default device link profiles that can be selected differ depending on whether you are converting RGB, CMYK or 

Gray, and whether you are using color conversion settings during output. 

 

Device link profiles for RGB 

This section describes the default device link profiles that can be selected using the Device Link profile pulldown list for 

RGB. 

 

 

The default device link profiles that you can select below. 

 

File Name GUI Display (internal name) Contents 

linkRGB2CMYK.icc ps RGB2CMYK Device link profile for testing the following 

conversions without generating a black 

separation. 

C:=1.0-R/ M:=1.0-G Y:=1.0-B K:=0.0 

linkRGB2CMYK_il18.icc Illust Mac g＝ 

1.8RGB2CMYK 

Sets the maximum UCR assuming 

Macintosh monitor RGB (for illustration 

data). 

If the UCR is set to the maximum value and 

the amount of gray is the same as the 

amount of RGB, the data is output using 

only the K separation. 

linkRGB2CMYK_il22.icc Illust Win g＝ 

2.2 RGB2CMYK 

Sets the maximum UCR assuming Windows 

monitor RGB (for illustration data). 

If the UCR is set to the maximum value and 

the amount of gray is the same as the 

amount of RGB, the data is output using 

only the K separation. 

linkRGB2CMYK_UCR1_Max.icm 

BG/UCR(1 to 6) 

Test device link profile for replacement of 

the K separation using the selected 

percentage. 

1: Maximum(100%) 

linkRGB2CMYK_UCR2_Heavy.icm 2:Heavy(40%) 

linkRGB2CMYK_UCR3_Medium.icm 3:Medium(34%) 

linkRGB2CMYK_UCR4_Light.icm 4:Light(23%) 

linkRGB2CMYK_UCR5_Light2.icm 5:Light2(22%) 

linkRGB2CMYK_UCR6_Zero.icm 6:Zero(0%) 
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Device link profiles for CMYK 

This section describes the default device link profiles that can be selected using the Device Link profile pulldown list for 

CMYK. 

 

 

The default device link profiles that you can select below. 

 

File Name GUI Display (internal name) Contents 

linkGRAY2CMYK.icc Linear CMYK2CMYK Test device link profile for generating a black 

separation and converting the CMY values to 

0. 

 

 

Device link profiles for Gray 

This section describes the default device link profiles that can be selected using the Device Link profile pulldown list for 

Gray. 

 

 

The default device link profiles that you can select differ depending on whether you are using offset simulation mode 

or wide gamut mode. 

The default device link profiles that you can select during wide gamut mode are shown below. 

 

File Name GUI Display (internal name) Contents 

linkGRAY2CMYK.icc k-only GRAY2CMYK Test device link profile for generating a black 

separation and converting the CMY values to 

0. 
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12. Profile and Recipe Registration 

How to register profiles and recipes 

This section describes how to register new ICC profiles, device link profiles and recipe files to the TotalFlow Simply 

Prepress system. 

 
 

1. Start the TotalFlow Simply Prepress system service manager, and stop the system. 

 

2. The location where the data is copied differs depending on the type of ICC profile, device link profile 

or recipe file. Copy files to the appropriate folder according to the following chart. 

 

Type Save Location Contents 

ICC profile TFSVR\proc\data\preference\color\

icc 

Save ICC profiles to be used with the input and 

intermediate targets here. 

Device link Device link 

(offset simulation) 

TFSVR\proc\data\preference\color\

dlcolor\offsetoutput_target 

Save device link profiles here. It becomes possible 

to select this when you specify Device Link in the 

input color window. 

Recipe conversion 

(offset simulation RGB 

images) 

TFSVR\proc\data\preference\color\

recipe\offsetoutput_forRGBimage 

Save recipes file for RGB image processing in 

offset simulation mode here. The recipes become 

recipe files for RGBgCMYK conversion. 

Recipe conversion 

(offset simulation CMYK 

images) 

TFSVR\proc\data\preference\color\

recipe\offsetoutput_forCMYKimage 

Save recipes file for CMYK image processing in 

offset simulation mode here. The recipes become 

recipe files for CMYKgCMYK conversion. 

Recipe conversion 

(wide gamut RGB 

images) 

TFSVR\proc\data\preference\color\

recipe\directoutput_forRGBimage 

Save recipe files for RGB image processing in 

wide gamut mode here. The recipes become 

recipe files for RGBgRGB conversion. 

Recipe conversion 

(wide gamut CMYK 

images) 

TFSVR\proc\data\preference\color\

recipe\directoutput_forCMYKimage 

Save recipe files for CMYK image processing in 

wide gamut mode here. The recipes become 

recipe files for CMYKgRGB conversion. 

 

 • For the intermediate color profile setting, the conversion of the target profile is specified as the 

offset simulation mode, and the no-conversion is the wide gamut mode. 

Note: The wide gamut mode cannot be used when you print data to offset printing presses and 

monochrome inkjet printers. 

 

3. Start the TotalFlow Simply Prepress system service manager, and restart the system.

Note 

Operation 
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